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changes. 
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Trademarks 
Unigraf, UCD, UCD-500, UCD-500 Gen2, UCD Console and TSI are trademarks of Unigraf Oy. 

DisplayPort™ and the DisplayPort™ logo are trademarks owned by the  

Video Electronics Standards Association (VESA®) in the United States and other countries. 

USB™, USB Type-C™ and USB-C™ are trademarks of USB Implementers Forum Inc. 

Thunderbolt is a trademark of Intel Corporation or its subsidiaries. 

HDCP is a trademark of Digital Content Protection LLC. 

Windows® is a trademark of Microsoft Corporation. 

macOS® is a trademark of Apple Inc. 

Linux® is a trademark of Linus Torvalds. 

All other trademarks are properties of their respective owners. 

Limited Warranty 
Unigraf warrants its hardware products to be free from defects in workmanship and materials, under 

normal use and service, for twelve (12) months from the date of purchase from Unigraf or its 

authorized dealer. 

If the product proves defective within the warranty period, Unigraf will provide repair or replacement 

of the product. Unigraf shall have the whole discretion whether to repair or replace, and replacement 

product may be new or reconditioned. Replacement product shall be of equivalent or better 

specifications, relative to the defective product, but need not to be identical. Any product or part 

repaired by Unigraf pursuant to this warranty shall have a warranty period of not less than 90 days, 

from the date of such repair, irrespective of any earlier expiration of original warranty period. When 

Unigraf provides replacement, then the defective product becomes the property of Unigraf. 

Warranty service may be obtained by contacting Unigraf within the warranty period. Unigraf will 

provide instructions for returning the defective product. 

CE Mark 
UCD-5XX products meet the essential health and safety requirements, are in conformity with and the 

CE marking has been applied according to the relevant EU Directives using the relevant section of 

the corresponding standards and other normative documents. 

  



  About This Manual 

UCD-5XX User Manual • UCD Console 3.8 4 

Table of Contents 

 
Copyright ..................................................................................................2 
Notice ........................................................................................................2 
Edition........................................................................................................2 
Company Information ..............................................................................2 
Trademarks ...............................................................................................3 
Limited Warranty ......................................................................................3 
CE Mark ....................................................................................................3 
Table of Contents .....................................................................................4 

 About This Manual .....................................................................................................7 
Purpose .....................................................................................................7 
Product and Software Version ...............................................................7 
Notes .........................................................................................................7 

 Introduction .................................................................................................................8 
Product Description .................................................................................8 
Safety and Operational Precautions ................................................... 11 

 Installation ................................................................................................................. 12 
Installation Package .............................................................................. 12 
Software Installation ............................................................................. 12 
Firmware Update Procedures ............................................................. 14 
Firmware Downgrading ........................................................................ 18 
License Manager .................................................................................. 19 
UCD Console ......................................................................................... 21 
File .......................................................................................................... 22 
Options ................................................................................................... 22 
Detaching and Cloning Tabs ............................................................... 23 

 Analyzer Operation ................................................................................................. 24 
Functionality Tabs ............................................................................................ 24 

Link Tab ................................................................................................. 24 
HDCP Tab .............................................................................................. 31 
Video Tab ............................................................................................... 32 
Capture Tab ........................................................................................... 36 
Link Analyzer Tab ................................................................................. 37 
Audio Tab ............................................................................................... 41 
EDID/DisplayID Tab .............................................................................. 43 
DPCD Tab .............................................................................................. 45 
SDP Tab ................................................................................................. 46 
DSC Tab ................................................................................................. 48 
Panel Replay Tab .................................................................................. 51 
FEC Tab ................................................................................................. 53 
Source DUT Testing Tab ..................................................................... 54 
Cable Info Tab ....................................................................................... 56 

PDC Tab ............................................................................................................ 57 
Status List .............................................................................................. 58 
Capabilities ............................................................................................ 60 
DP Alt Mode .......................................................................................... 61 
Power Source ........................................................................................ 62 
Power Sink ............................................................................................. 63 
Controls .................................................................................................. 63 
Bottom Panel ......................................................................................... 65 

 Generator Operation ............................................................................................... 66 
Functionality Tabs ............................................................................................ 66 

Link Tab ................................................................................................. 66 
Pattern Generator Tab ......................................................................... 74 
Playback Tab ......................................................................................... 82 
Audio Generator Tab ............................................................................ 93 
HDCP Tab .............................................................................................. 95 
EDID/DisplayID Tab .............................................................................. 97 
DPCD Tab .............................................................................................. 99 



  About This Manual 

UCD-5XX User Manual • UCD Console 3.8 5 

SDP Tab ............................................................................................... 100 
FEC Tab ............................................................................................... 101 
Panel Replay Tab ................................................................................ 103 
ALPM Tab ............................................................................................ 105 
Sink DUT Testing Tab ........................................................................ 106 
Adaptive-Sync Tab ............................................................................. 109 
Cable Info Tab ..................................................................................... 110 

PDC Tab .......................................................................................................... 111 
 Link Timeline Viewer ............................................................................................. 112 

Wave Form and Symbol View Settings ............................................ 114 
FrameView Tab .............................................................................................. 119 

Event Selector View ........................................................................... 121 
Event Details View .............................................................................. 127 
Wave Forms View ............................................................................... 131 
Symbols View ...................................................................................... 139 

Images Tab ..................................................................................................... 143 
Frame Image View ......................................................................................... 145 

 Event Timeline Viewer .......................................................................................... 146 
 Event Log ................................................................................................................ 150 

Selecting Logged Events ................................................................... 151 
Event Transaction List ........................................................................ 153 
Customizing Transaction List ............................................................ 154 
Event Details ........................................................................................ 156 

 EDIDDisplayID Editor ............................................................................................ 161 
EDID Editor Features .......................................................................... 163 
Editing Tips .......................................................................................... 163 

 Packet Editor .......................................................................................................... 165 
 Pattern Editor ......................................................................................................... 166 
 Image Converter .................................................................................................... 168 

Appendix A: Product Specification ........................................................................................ 169 
UCD-500 .............................................................................................. 169 
UCD-500 Gen2 .................................................................................... 169 

Appendix B: Product Features ............................................................................................... 171 
UCD-5XX Product Options ................................................................ 175 

Appendix C: Predefined Timings ........................................................................................... 176 
Appendix D: Predefined Patterns ........................................................................................... 181 
Appendix E: Sink, Source and Repeater Tests .................................................................... 186 

Compliance Tests .......................................................................................... 189 
Running CTS Tests ............................................................................. 192 
Evaluating CTS Test Results ............................................................. 194 
Test Report .......................................................................................... 195 

Audio Test Set ................................................................................................ 196 
CRC Based Video Test Set ........................................................................... 197 
Link Config Tests ........................................................................................... 200 
Pixel Level Video Tests ................................................................................. 201 

Appendix F: VTP Pattern Language ...................................................................................... 203 
General ................................................................................................. 203 
Commands .......................................................................................... 204 
Variables .............................................................................................. 210 

Appendix G: Firmware Recovery ........................................................................................... 212 
Downloading Tools ............................................................................. 212 
Step 1 ................................................................................................... 213 
Step 2 ................................................................................................... 213 

Appendix H: Playlists and Scenarios ..................................................................................... 214 
Playlists ............................................................................................................ 215 
Scenarios ........................................................................................................ 216 

Parameters .......................................................................................... 216 
Example ............................................................................................... 220 



  About This Manual 

UCD-5XX User Manual • UCD Console 3.8 6 

Sample Content in Playback Tab ................................................................. 222 
Playlist: Basic Video & Audio Example ............................................. 223 
Playlist: Frame Rate Example ............................................................ 224 
Playlist: Audio-Video Latency ............................................................ 225 
Playlist: HDR & Metadata Example ................................................... 226 
Playlist: Grayscale ............................................................................... 227 
Playlist: HDR10+ SSTM Example...................................................... 228 
Playlist: PSR1 ...................................................................................... 229 

 



  About This Manual 

UCD-5XX User Manual • UCD Console 3.8 7 

 ABOUT THIS MANUAL 

Purpose 
This guide is a User Manual of UCD-5XX products. UCD-5XX are USB-connected video interface test 

units for use with a computer. 

The purpose of this guide is to 

• Provide an overview of the product and its features. 

• Provide instructions for the user on how to install the software and the drivers. 

• Provide instructions for the user on how to update the FW of the unit. 

• Introduce the HW features of UCD-5XX units. 

• Provide instructions for the user on how to use UCD Console software. 

 

Product and Software Version 
This manual explains features found in UCD Console Software Bundle 3.8. Please consult Unigraf for 

differences or upgrades of previous versions.  

Please consult the Release Notes document in the installation package for details of the SW and FW 

versions and changes to previous releases. 

Note: This version of the User Manual describes features in UCD Console software based on the 

functionality in Microsoft Windows, macOS and Linux operating systems.  

Notes 
On certain sections of the manual, when important information or notification is given, text is formatted 

as follows. Please read these notes carefully. 

Note: This text is an important note 

 

Warning: This is a warning about a direct risk for the functionality of the device 
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 INTRODUCTION 

Product Description 
UCD-5XX products are high speed, USB 3.0 connected video interface test units.  

UCD Console is a common graphical user interface (GUI) for Unigraf UCD-5XX, UCD-4XX and 

UCD-3XX units. The outlook and details of UCD Console will vary depending on the capabilities of 

the connected unit and will reflect the features enabled.  

The software package for UCD-5XX features a high-level Software Development Kit (SDK) called Test 

Software Interface (TSI) for use in automated testing. TSI allows for an easy integration of Production 

and R&D testing routines into an automated test system environment. Please refer to TSI 

documentation found in additional Unigraf manuals for more details. 

Product Features 

• UCD-500: DP 2.1 capable Reference Sink and Reference Source for verifying DP and USB-C 

connected devices with link rates up to 20 Gbps (UHBR20) using USB-C interface and 10 

Gbps (UHBR10) using DP interface. 

• UCD-500 Gen2: DP 2.1 capable Reference Sink and Reference Source for verifying DP and 

USB-C connected devices with link rates up to 20 Gbps (UHBR20) 

• High resolution video up to 8K @60Hz, 16K @60Hz with DSC and audio  

• Generate HDR formats such as Dolby Vision™, HDR10 and HDR10+ 

• 16 GB video frame buffer 

• High speed USB 3.0 host PC interface 

Please refer to Product Specifications in the appendix of this document for details. 

Available Interface Roles 

UCD-500 products can operate in various interface role combinations. The used role is selected when 

UCD Console is launched. 

Selection UCD-500 UCD-500 Gen2 

DisplayPort Sink and Source ● ● 

USB-C DP Alt-Mode Sink and Source ● ● 

DisplayPort Source and USB-C DP Alt-Mode Sink ● ● 

USB-C DP Alt-Mode Source and DisplayPort Sink ● ● 
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Functional Description 

UCD-5XX units consist of a multimedia signal input stage, an internal pattern generator, a control 

stage with on-board frame buffer and a PC interface stage. In the Input Stage the signal is conditioned 

and converted to desired format. The Interface and Control stages are either passing the captured 

data directly to the USB interface or storing it to the frame buffer. The internal pattern generator is 

able to source a signal for testing sink and branch units. The Interface & Control stages are receiving 

instructions from the host PC to configure and control the functionality of the unit. 

UCD-5XX Functional Diagram 

Delivery Content 

Please find below an image of the items included in UCD-5XX unit delivery 

1. UCD-5XX Unit  

2. AC/DC Power Supply (100 to 240 Vac 50/60Hz input, +12 Vdc output)  

3. DisplayPort cable 0.5 meters length 

4. Micro USB cable for FW update  

5. Passive TBT4 cables, 0.5 and 1.0 meters length 

6. USB 3.0 compliant cable for host PC connection 

UCD-500 

Control & 

Interface 
USB 3.0 

Host PC 

Data 

Multiplexer 

Power 

Delivery 

USB-C 

DP Tx 

Data 

Multiplexer 

Power 

Delivery USB-C 

DP Rx 

DP / DP Alt Mode 

Internal 

Pattern Generator 

On-board 

Frame Grabber 

DP Tx 

DP Rx 
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Connections 

The image below indicates the connections in UCD-500 and UCD-500 Gen2 unit and their 

description. 

 

Name Description 

DP in DisplayPort™ 2.1 capable input* 

DP out DisplayPort™ 2.1 capable output* 

USB-C in USB-C PD 3.0 DP Alt-Mode input (20 Gbps) 

USB-C out USB-C PD 3.0 DP Alt-mode output (20 Gbps) 

Power in +12 Vdc Power Supply Input 

Power On/Off Rocker power switch 

USB USB 3.0 connection to the host PC 

JTAG JTAG interface for maintenance purposes (micro USB) 

 

(* In UCD-500 10 Gbps link rate maximum, in UCD-500 Gen2 20 Gbps link rate maximum 

Note Capturing and sourcing high resolution video modes and high frame rates set stringent requirements 

on the video cables and connectors. If in doubt, please contact Unigraf Support. 

 

Warning In order to avoid damage to the unit and the PC, please always attach the power cord (Power In) 

to the unit first, and after that connect the USB cable to the PC. 

  

Power 

On/Off 

Power In 

USB-C 

In 

USB-C 

Out 

DP In 

DP Out 

USB 

JTAG 
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Safety and Operational Precautions 
Please find below the Safety Precautions for using the Unigraf UCD test instrument. Please also 

carefully read the Notes and Warnings within the text of this manual.  

These Precautions and Warnings are provided to enable a safe use of the UCD test equipment. 

Therefore, Unigraf assumes no liability when the user fails to follow the expressed Precautions and 

Warnings. 

• Use only Unigraf provided AC/DC Power Adapter. Please make sure that connectors and 

cabling to the Power Adapter are intact. In case there are any doubts about the condition of 

the Adapter or cabling, stop using it immediately. 

• It is important to ensure that the used AC input voltage is within the specified range (100 to 

240 Vac 50/60 Hz) and the fuses in the AC lines are of the specified type. If in doubt, do not 

connect the device. 

• UCD devices are rated for indoor use only. They are rated for Pollution Degree 2 as defined in 

IEC 61010-1. This classification corresponds to usage in a typical office or home 

environment. Under normal use, only dry, non-conductive pollution occurs. Occasionally, 

temporary conductivity caused by condensation can be expected. Temporary condensation 

occurs only when the product is out of service. 

• When installing the unit, connect the Power Adapter to the UCD device first, after that connect 

the AC plug. Please disconnect the USB cable to the controlling PC and remove cabling to 

DUT while connecting the power input cables. 

• It is forbidden to open the housing of the UCD device without written permission from Unigraf. 

Failure to comply with this rule will void the warranty of the unit. 

• UCD devices are intended for use as Electrical Test Instrument only. Use for other purposes is 

forbidden. 

• Use UCD equipment only in its specified ambient temperature and humidity.  

• In order to ensure that the UCD device and associated SW will operate properly, please 

ensure that the PC used for controlling the UCD device complies with the minimum 

requirement set by Unigraf. 

• Please keep UCD software updated by regularly checking the updates on Unigraf download 

page (https://www.unigraf.fi/downloads/). Please update the device firmware to match the 

installed software. 
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 INSTALLATION 

Installation Package 
The UCD software installation package can be obtained from Unigraf download page at 

https://www.unigraf.fi/downloads/. Please, note that there are separate packages for Windows, 

macOS and Linux. 

The installation package is a bundle between the components needed for UCD Console and for TSI 

SDK. The bundle contains the following items: 

• Drivers (installed during set up)  

• UCD Console software (installed during set up) 

• License Manager (installed during set up) 

• Device configuration utility (installed during set up) 

• Packet Editor (installed during set up) 

• TSI SDK 

• User Manuals including this document. 

In some cases, the firmware of the unit also needs to be updated. If in doubt, please contact Unigraf. 

Note: The software should be installed before connecting the UCD unit to the computer. 

 

Note: System administrator's privileges are required for performing installations. 

Software Installation 

Windows 

Install *.exe file from the package.  

Start installation by running application SoftwareBundle_X.X.XXXX.exe. 

The welcome page is displayed and shows the software package release version. 

The user is also asked if they want to: 

Create a desktop shortcut 

Install the Visual C++ redistributable (needs to be present on Windows) 

Install Unigraf USB drivers 

Confirm by selecting Next dialog button. Select Install to start the installation. 

Select Finish to exit the installation dialog. 

 

macOS 

Install *.pkg file from the package. This is a universal binary for ARM and Intel x86. 

Start installation by running application SoftwareBundle_X.X.XXXX. 

Confirm by selecting Next dialog button. Select Install to start the installation. 

Select Finish to exit the installation dialog. 

Note: If you are downgrading, please remove the Unigraf UCD Tools folder from the Applications 

folder before starting installation. 

Note: If installation fails, remove the Unigraf UCD Tools folder and any possible copies from the 

Applications directory and try again. 

 

https://www.unigraf.fi/downloads/
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Linux 

Linux extract the *.tar.gz file. You will find two install scripts (install-libfuse.sh and install.sh). 

In the Files app select each script in turn, right click and select Properties to open the 

Properties dialog. Toggle the Executable as Program button. 

In the Files app open a terminal window by unselecting any selected files and right clicking and 

selecting Open in Terminal to run the scripts (order is important). 

In the terminal type:  sudo ./install-libfuse.sh 

You will be prompted for your password.   

Type: sudo ./install.sh  

You will be prompted with: 

Please proceed to 'Software & updates' application to tab 'Other Software' and uncheck 

checkboxes or remove 'cdrom' entry from /etc/apt/sources.list file, otherwise you will have 

problems during UCD Console package installation. If you are already done, enter the key 'y'. If 

not, enter  'n'. 

For Ubuntu just enter y. For debian follow instruction. 

You will then be prompted again with: 

Please proceed to 'Software & updates' application to the first tab and set check box 'Officially 

supported (main)'. Otherwise you will have problems during UCD Console package installation. 

If you are already done, enter the key 'y'. If not - 'n' 

For Ubuntu just enter y. For debian follow instruction. 

Answer y for additional prompts. 

The Ucd Tool Installer Setup app should now be running. 

Select Next> 

Select radio button for Install for all users or Install just for me. 

You are asked to Choose Installation Directory. Do NOT choose the default 

(/root/Unigraf/Unigraf UCD Tools at time of writing). Select a directory that is easy to access 

and remember. 

Note the warning: Installing in existing directory. It will be wiped on uninstallation. 

Select Next> Install and Finnish. 

Navigate to the Unigraf UCD Tools directory under the installation directory and double click 

the app you want to run (UCDConsole.AppImage for example). 
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Firmware Update Procedures 
UCD Configuration Utility is used to load an updated firmware to the device. As an option, UCD 

Configuration Utility can be used to select possible operation roles present in the UCD unit. A firmware 

set for the selected operation roles is created and the firmware set is programmed to the device. 

Please contact Unigraf for details. 

Updating from Earlier FW Versions 

UCD Firmware versions prior to 1.8.52 (see Help > About on Consol) do not support the procedure 

described here. Follow the instructions in Appendix G Firmware Recovery Procedure with Quartus 

Prime in this manual. 

Note: Firmware update is a sensitive process. Please do not disconnect the device from the PC and do not 

power it off before the operation is completed unless specially requested. Avoid plugging and 

unplugging other USB devices when the firmware update is in progress. 

To update the firmware or create a new configuration on a UCD-5XX device, perform the following 

steps: 

 Connect the UCD unit to a power supply and connect the USB cable. 

 Open UCD Console SW. Select Tools > Firmware Update. UCD Config will open. 

UCD Config 

The first page of the utility indicates the firmware component versions present in the package. Select 

Enable advanced mode checkbox if you want to customize the installation (possibly to downgrade 

firmware for example). Enable patching (Internet connection is required) check box is not relevant 

for UCD-5XX devices. 

Select Next to proceed. 
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UCD Device Selection 

From the list of connected UCD devices please select the one that you want to update. Click Next. 

 

Review updates 

A new dialog lists: 

 FW components available in the UCD device 

 Current FW version (from) 

 FW to be installed (to) 

 

Note: Selecting individual components for update is only enabled in Advanced Mode. 

Click Start to start the FW update procedure. 

 

 

. 
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Advanced Mode 

Advanced mode allows users to select individual components to update. Click Next to review the 

components and start the update procedure. 

 

Configuration in progress 
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During the installation, you will be prompted to power cycle the device (power off, wait for 10 seconds 

and then power the device on again). Select OK to proceed. 

 

After the update has finished, click Next to see a summary and select Finish to complete. 

Please note that the update proceedure may take several minutes to complete. 

Recovering Failures in FW Update Procedure 

If FW Update procedure fails (e.g., when updating from an earlier FW that does not support the 

procedure described here) refer to Appendix G of this manual for instructions in Firmware Recovery 

Procedure with Quartus Prime.  

Once FW Recovery procedure has been done and a Firmware version supporting UCD Firmware 

Configuration tool has been installed, all future updates can be done using this tool. 
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Firmware Downgrading 
The previously released Unigraf SW Bundle 2.4.XX package does not contain UCD Device Firmware 

(FW). In case UCD device has been installed with the FW delivered with Unigraf 3.X SW Bundle, and 

version downgrade is needed, also UCD Device Firmware has to be rolled back.  

Please follow the procedure below: 

1. Download the latest Console 2 SW Bundle (2.4.XX) from Unigraf download page at 

unigraf.fi/downloads. 

2. Run the application SoftwareBundle_2.4.XX.exe in the package to install the package. Please 

do not launch UCD Console application yet. 

3. Download Console 2: FW Package 2.3.38 from the same download page 

4. Run the application FirmwarePackage_2.3.38.exe to copy UCD device FW in a proper folder 

in your PC 

5. Launch UCD Console 

6. Select Tools > Firmware Update to start UCD Config utility 

7. In UCD Config select Enable advanced mode 

8. Select the device. Click Next. 

9. In UCD Modules select the module titled MFMN500 F.X.X.X/N.X.X.X 

10. Click Next. Click Start to start programming FW to the connected UCD Device 
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License Manager 

Licensing 

The features of UCD Console GUI are divided into groups based on the target use of the device. Most 

basic features can be used by default, and more advanced feature groups are enabled by dedicated 

licenses. When the licenses are present, the related part of the GUI will be shown, or the related 

control will be enabled. 

Unigraf licenses are provided as strings of characters, License Keys. Each License Key enables a 

dedicated function in one device. Each device has its dedicated Seed Number. Each License Key is 

tied to one Seed Number. License Keys can be freely used in any number of PCs. 

License keys are managed with the UCD License Manager. License manager can be found in the 

Tools menu of UCD Console. 

Note: System administrator's privileges are required for accessing the licenses. 

License Manager GUI 

When run, License Manager will list the licensing enabled Unigraf devices. In the list of Devices please 

Select the device in question. The serial number and the seed number of your device are printed on 

a sticker attached to the bottom of the device.  

The Rescan… button will re-detect connected UCD devices. 

Managing Licenses 

Seed Number 

Each license is tied to a hardware unit with the help of the Seed Number. Each unit has a unique 

Seed Number. Seed Number of the selected unit can be found in the top of the dialog. 

Seed Number of the selected device can be copied from dialog link for e.g., ordering Licenses. 

Adding New License Keys 

To add a new license key for a device, please enter the characters from the license sticker to the field 

for new licenses. The License Manager will automatically move the cursor across the edit boxes 

during typing. If the key is given in text format, copy it and paste to the leftmost box. 

Once the license key is fully entered, click Install. The license is authenticated and if it is valid, the 

license will appear in the list of installed licenses. If the key fails to authenticate, an error message is 

displayed. If this happens, please make sure that the key has been typed correctly and that the seed 

number on the license key sticker matches the seed number displayed in UCD License Manager. 
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Click the Search inverted triangle at the upper right to view the Find edit control. Enter a search 

keyword: The license list is updated to show names that contain the keyword. 

Please note that to avoid confusion, some letters will never appear in a license key because they 

resemble numbers: For example, capital 'G' and number '6' are very similar when printed with small 

font. When in doubt, use numbers. 

Also, please note, that characters that cannot be part of valid license key are not accepted as input. 

When appropriate, an automatic conversion is applied while typing: For example, lower case letters 

are converted to upper case automatically. 

Managing Installed Licenses 

The Installed licenses list shows all installed licenses for the selected device. The list shows the name 

of the license and the actual license key characters. 

Import: Install licenses from an INI file for the currently selected device. 

Export: Save installed licenses for the currently selected device into an INI file for 

backup and distribution to other PCs.  

To export license(s), select the license(s) to be exported and then click the 

Export button. Please note that licenses from multiple devices can be 

exported into the same INI file. 

Remove Selected: Uninstall selected licenses. To uninstall a license, click on the license and 

then click the Remove Selected button 
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UCD Console 
UCD Console is graphical user interface (GUI) for UCD family test equipment for desktop use. UCD 

Console provides the user access to all features of the unit. UCD Console also includes powerful 

debugging and analysis tools enabling the user to monitor the status of the display interfaces and 

assist in problem detection.  

In UCD Console the various features of the UCD unit are divided into interface specific screens and 

tabs. Each tab contains data and controls for a specific feature.  

Device Selection 

A shortcut of UCD Console can be found by default under Start Menu.  

Once UCD Console GUI is launched, the dialog provides a list of Unigraf UCD devices connected in 

the PC. Please select the target device by double clicking on the appropriate row. If your device 

cannot be found in the list, please confirm the power and USB connection to the device and click the 

Rescan … button. 

Role Selection 

UCD-5XX features two alternative Sink interfaces (DP and USB-C), and in a similar way two alternative 

Source Interfaces. One Sink role and one Source role can be active at one time. Sink / Source role 

selection is done by selecting one of the four combinations during launch of UCD Console. 

Analyzer and Generator Operation 

Most UCD devices can be used with UCD Console as Analyzer (a Sink device) and as Generator (a 

Source device). The functionalities of the two operation modes can be found in separate tabs. This 

User Manual will explain both roles and all role functionalities. 
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File 

 

Open Device: Select device to open. 

Close Device: Close Device. 

Reset and Close Device: Resets the device to default settings and closes the device. 

Exit: Closes UCD Console. 

 

Options 
Options can be found in Tools > Options. 

Image File Format 

You can save the captured frames either in PPM, BMP, JPG or PNG bitmap file format. In PPM format 

the files are stored with the captured color depth, with other formats the color depth is truncated to 8 

bits per color. 

Audio File Format 

Audio files are stored in WAV format. 

Displays HDCP Compliance 

Information if controlling PC is HDCP compliant, i.e. if preview of HDCP encrypted content can be 

enabled. If the display is non-HDCP compliant or when connected to the PC using RDP (Remote 

Desktop Protocol) then users will be presented with a blue background with a banner stating ‘HDCP 

unauthorized’. HDCP is currently only supported on Windows OS and not supported on MacOS and 

Linux. 

Folders 

Please select the directories in the PC for saving the captured images and audio 



  Installation 

UCD-5XX User Manual • UCD Console 3.8 23 

DSC 

DSC temp folder Folder for DSC Work files. 

DSC test content folder: Folder where DSC source bitmap files, related 

configuration files and DSC conversion tools are stored. 

Keep auto-created DSC content files: By default, the DSC compressed content is deleted after 

use. If selected, the content is not deleted 

Warning: Keeping the automatically created DSC compressed content will shorten the time needed for running 

the DSC compliance tests.  

 Please note, that the space needed for storing the full library can be very large (appr. 400 GBytes). 

Please make sure that the content will be stored in a medium that has the required space available. 

DUT Testing Options 

Configure DUT Testing reports. 

Include time info in Report logs: Include system date and time at the beginning of each 

event line in generated reports. 

Do not show again test sequence 

completed: 

Include system date and time in the beginning of each 

event line in generated reports. 

 

Detaching and Cloning Tabs 
Most of the UCD Console tabs can be detached into a separate window for monitoring and controlling 

separate features simultaneously. To detach a tab Right-click on a tab and select Detach Window. 

To glue the tab back to the main window, click on the red Close button in the top right-hand corner 

of the window or press <Alt> + F4 on the keyboard. 

Tabs can also be cloned (duplicated) in order to e.g., monitor various areas of DisplayPort DPCD 

simultaneously without swapping addresses. To clone a tab Right-click on a tab and select Clone 

Tab or Clone and Detach to the two actions simultaneously. 
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 ANALYZER OPERATION 
When used as an Analyzer, the UCD-5XX device acts as DisplayPort or USB-C DisplayPort Alt Mode 

Sink or Receiver device. 

Analyzer functionality related controls and dialogs can be used by selecting DP RX tab.  

Please note that in UCD-5XX, Generator functionality is available simultaneously with Analyzer. Please 

find the description of Generator functionality later in this manual.  

Functionality Tabs 

UCD Console features are presented in tabs. Some of the tabs are enabled by default, some only 

when an applicable license is included.  

Note: Some of the tabs are enabled by default, some only when an applicable license is included. Please 

refer to section Appendix B Licensing of this document for description of features and licensing. 

Link Tab 
The Link tab contains the following panels: Link Status, Link Training Result, Link Capabilities, VCP 

Table, Stream Info, HDCP Status, HDCP Configuration, Scrambler seed and HPD. 
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Link Status 

Link Status displays the status of the link training and the link parameters negotiated between UCD 

Sink and the Upstream Source. It also lists the status of other link modes. The data is retrieved from 

the DPCD status registers of the UCD Sink. The status is updated automatically.  

Lanes: Indicates the number of lanes used for DisplayPort or DisplayPort Alt Mode. 

CR/SL/EQ: LED indicators for status of Clock Recovery / Symbol Lock / Channel 

Equalization for each of the four lanes 

VS/PE (level): Voltage Swing / Pre-emphasis level 

FFE Preset: TX Feed Forward Equalization (FFE) preset value (only with 128b/132b channel 

coding) 

Error count: Content of DPCD Error Count registers 

ILA: Status LED for Inter-Lane Alignment 

EQ_ILA Status LED for Inter-Lane Alignment on Equalization stage (only with 128b/132b 

channel coding) 

CDS_ILA Status LED for Inter-Lane Alignment on Clock and Data Switch stage (only with 

128b/132b channel coding) 

LT_FAIL Status LED for Link Training failure (only with 128b/132b channel coding) 

Bit rate: Currently enabled link bit rate 

Link mode: Currently enabled channel coding (128b/132b or 8b/10b) 

Framing mode: Currently enabled Framing Mode (Normal or Enhanced) (only with 8b/10b 

channel coding) 

Scrambling: Status of link data scrambling (Enabled or Disabled) 

MST mode: Status of Multi-stream transport (Enabled or Disabled) 

SSC Status: Status of Spread-Spectrum Clock (Enabled or Disabled) 

DSC Status: Status of Display Stream Compression (Enabled or Disabled) 

FEC status: Status of Forward Error Correction function (Enabled or Disabled) 
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Link Training Result 

The result of the previous Link Training and values of some key parameters. 

Lanes: Indicates the number of lanes used for DisplayPort or DisplayPort Alt Mode. 

CR/SL/EQ: LED indicators for status of Clock Recovery / Symbol Lock / Channel 

Equalization for each of the four lanes 

VS/PE (level): Voltage Swing / Pre-emphasis level 

FFE preset: TX Feed Forward Equalization (FFE) preset value (only with 128b/132b channel 

coding) 

ILA: Status LED for Inter-Lane Alignment 

EQ_ILA Status LED for Inter-Lane Alignment on Equalization stage (only with 128b/132b 

channel coding) 

CDS_ILA Status LED for Inter-Lane Alignment on Clock and Data Switch stage (only with 

128b/132b channel coding) 

LT_FAIL Status LED for Link Training failure (only with 128b/132b channel coding) 

Bit rate: Currently enabled link bit rate 

Link mode: Currently enabled channel coding (128b/132b or 8b/10b) 
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Link Capabilities 

The Link capabilities panel allows the user to change the way the Sink capabilities are announced in 

the DPCD capability registers of the UCD Sink. To enable the change, please click Apply. 

Max Lanes: Maximum lane count used 

Max Bitrate, Gbps Maximum link rate used when 8b/10b link coding is selected in LT. 

eDP Bitrate,Gbps Available eDP bitrates. eDP support is limited to eDP 1.5 (i.e. 8b/10b 

link coding) 

DP (128b/132b) Supported 

Bitrates, Gbps 

When checkbox is selected, 128b/132b link coding is supported. 

Link rates used when 128b/132b link coding is selected in LT. 

Please observe the Note about the long HPD pulse below. 

Instead of 10 Gbps, use: For supporting low link rate Source devices, the user can make UCD-

5XX sink PHY use a selectable lower link rate when performing “10 

Gbps” link training in protocol level. 

Link rates are: 2.5 Gbps, 2.7 Gbps, 5.0 Gbps and 5.4 Gbps 

Old DP 2.0 LT When checked LT will follow initial DP 2.0 spec description.  

Otherwise, LT as per DP 2.1 specification 

Force cable status to plugged: UCD-400 RX device supports source device detection via AUX by 

default. Checking this on DPRX disables this behavior. 

Enable Fast LT: Indicates support for link training without AUX transactions. 

eDP AUX Preamble Use eDP AUX Preamble protocol. 

Sink count Selects the number of sinks capable of to transmitter. 

MST: When 8b/10b link coding enabled, indicate support for MST mode and 

Sideband MSG handling. When 128b/132b link coding enabled, indicate 

support for multi-stream transport and Sideband MSG. 

SS SBM: When selected, indicate support Sideband MSG while not supporting 

multi-stream transport. Valid only with 128b/132b channel coding and 

when “MST” is unchecked. 

FEC (8b/10b): Indicated support for Forward Error Correction feature when 8b/10b link 

coding is enabled 

TPS4, TPS3: Indicate support for Link Training Pattern Sequence 4 and 3. 

DSC (8b/10b) Select to enable Display Stream Compression (DSC) feature when 

8b/10b link coding is enabled 

HPD pulse on Apply: Select to apply a Hot-Plug Detect (HPD) pulse automatically after 

updating the status. HPD pulse duration will be defined in the Pulse 

HPD field in HPD dialog in the bottom of the tab. 
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Note:  Please note that deviating from to the rules set in DP 2.1 Specification, UCD-5XX allows selection of 

maximum link rate for 8b/10b coding also when support for 128b/132b link coding is enabled. 

 

Note:  When changing link coding capability of the Sink device (8b/10b vs 128b/132b), please make sure to 

issue a Long HPD Pulse after applying new setting or make sure that "HPD pulse on Apply" is selected 

before applying the change 

Scrambler Seed 

Selection of the value to which the Linear Feedback Shift Register (LFSR) is reset during scrambler 

reset.  

Used only when 8b/10b link coding is enabled. 

HDCP Status & Configuration 

Copy of HDCP status and controls on HDCP tab. 

Note: Please note that HDCP 1.3 is not supported in 3.8 release. 

HDCP Stream Status 

 

Shows HDPC status for each stream. 

ALPM Status 

 

ALPM: Disabled / Enabled 

ALPM mode: ALPM mode / N/A 

Active: Green light indicates PM is active 

ALW_Sleep AUX-less mode SLEEP state 

FW_Sleep AUX-wake mode SLEEP state 

FW_Standby AUX-wake mode STANDBY state 
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Stream Info 

Stream Info is achieved from the Main-Stream Attributes (MSA) of the monitored stream. Frame rate 

is measured by UCD Local Sink 

The content of Stream Info table can be copied by right-clicking on the table and selecting Copy. 

Framerate: Vertical refresh rate 

HTotal: Horizontal total of transmitted main video stream, measured in pixel count. 

HStart: Horizontal active start from leading edge of HSync, measured in pixel count. 

HActive: Horizontal active, number of active pixels in video line 

HSync: HSync width, measured in pixel count. (+)/(-) positive / negative sync. 

VTotal: Vertical total of transmitted main video stream, measured in line count. 

VStart: Vertical active start from leading edge of VSync, measured in line count. 

VActive: Vertical active, number of active lines in video frame 

VSync: VSync width, measured in line count. (+)/(-) positive v.s. negative sync. 

CEF: Used color mode: Color format + subsampling / colorimetry 

BPC: Color depth in bits per color (BPC) 

CRC (RGB/CrYCb): 16-bit Cyclic redundancy check (CRC) value per color component calculated 

from active pixels. Value order in YCbCr color format: Cr, Y, Cb. 

VFREQ: Video Frequency (128b/132b channel coding only) 

MVID/NVID: Mvid and Nvid video time stamp values (8b/10b channel coding only) 

DSC CRC: 16-bit Cyclic redundancy check (CRC) calculated from compressed pixel 

stream. Value order: Engine 0, 1, 2. 
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VCP Table 

VCP Table shows allocation of Virtual Channel Payload for active virtual channels. 

The contents of VCP Table can be copied by right-clicking on the table and selecting Copy. 

 

Port#: Port number where the virtual channel is directed. 

SID: Stream identification number of the virtual channel 

Req.PBN: Requested PBN (payload bandwidth number) value for the virtual channel 

Alloc.PBN: PBN value allocated for the virtual channel 

First slot: Time slot where the first VC Payload for the virtual channel is stored 

Slot num: Number of VC Payload slots reserved for the virtual channel. 

 

HPD 

Cable: LED indicates that the hardware has detected an upstream cable.  

HPD: LED indicates that the HPD signal is Asserted (logical “high”). 

Assert: Click to re-activate the HPD line (set to logical “high”). 

Deassert: Click button to set HPD line to logical “low” (de-asserted) and hence no HPD 

pulse can be generated.  

Pulse HPD: Click to apply an HPD Pulse with programmable duration. Duration will be defined 

in the provided field. 

Short Pulse: Click to apply a short pulse with programmable duration. Duration will be defined 

in the provided field. 
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HDCP Tab 
HDCP tab is the dialog for monitoring the HDCP (for High-Bandwith Digital Content Protection) status 

and controlling the HDCP capabilities of the UCD device. 

Note: Please note that HDCP 1.3 is not supported in 3.8 release. 

 

Status 

The status field indicates the HDCP status of the UCD device. 

Active: The link between UCD and the upstream source has been 

encrypted. 

Authenticated: The HDCP handshake between the UCD and the sink unit has been 

completed successfully. 

Declared as HDCP capable: The UCD unit recognizes HDCP handshake messages. 

Keys loaded: The HDCP keys are loaded to the UCD unit. 

SST Mode Type Type when in SST mode and in Link mode 8b/10b. 

Stream status Shows HDPC status on each stream. 

Configuration 

HDCP Capable:  To disable HDCP, uncheck the box. 

Keys 

Select between Production or Facsimile HDCP keys. To remove the keys, select None.  
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Video Tab 

 Video tab is the Preview window for the captured video stream. 

Disable / Enable Preview 

Click the button to start or stop capturing video frames. 

Stream 

When Multistreaming (MST) is enabled, the monitored stream can be selected here. 

Video Status 

The details of the captured video are presented below the preview window. 

First row: Cursor location, pixel value at cursor location in YCbCr and RGB  

Second row: Time stamp, Color mode, color depth, frame counter. 

Third row: Mvid, Nvid, Horiz Total, Vert Total, Horiz Active, Vert Active, Horiz Start,  

Vert Start, Hor Sync Width, Vert Sync Width. 

Fourth row: Live preview frame rate. 

Note: HDCP preview is only available on UCD Console for Windows operating system. 

 Please note that UCD test equipment are able to capture video at full frame rate.  

Live preview frame rate indicates the rate of updating captured video on UCD Console preview 

screen. Live preview frame rate is limited e.g., by the USB communication between UCD test 

equipment and the PC. 
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Override Color Detection 

Captured video will be by default automatically converted to RGB 8 bpc for preview and saving based 

on the information in video metadata.  

By clicking Auto button a dialog opens for overriding the automatic conversion. Captured image data 

will be interpreted based on the values set in the dialog.  

Color space: Define as which format captured data will be interpreted. 

(Auto-detect, RGB, YCbCr4:4:4, YCbCr4:2:2, YCbCr4:2:0) 

Colorimetry: Define as which colorimetry captured data will be interpreted. 

(ITU-R BT.601, ITU-R BT.709, ITU-R BT.2020) 

Bits per color Define as which color depth captured data will be interpreted. 

(Auto-detect, 6, 8, 10, 12, 16) 

Note: Please note that the color mode selection applies to the preview window only. All internal functions 

use the raw image data as captured from the input channel. 

Frame recording 

 

Clicking the button opens a dialog for definition of number of frames recorded.  

Recorded frames are stored by default in C:/Users/<Current user>/Pictures. Please refer to Tools > 

Options where the location of this folder can be customized. 

Open 

 

Open folder where captured frames are stored. Please refer to Tools > Options where the location of 

this folder can be customized. 
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Snap Frame 

 

When clicked, one frame of the incoming video is captured and shown in a new tab. Each click 

captures a new frame and opens a new tab. 

Color Information of the captured frame can be evaluated by placing the mouse cursor on top of the 

preview image.  

Info field in the lower right side of the bottom panel lists: 

• Location of the cross cursor on the bitmap stating from the upper left corner 

• The intensity of the RGB and YCbCr components of the pixel on the cursor location in 

hexadecimal values 

Zoom  

Zoom level of the captured frame can be altered by right clicking on top of the preview image and 

selecting between 

• Fit Window 

• Zoom 25%, 50%, 100%, 200%, and 500% 

Save Frame 

The captured frame current tab can be saved to a bitmap file in the PC by right clicking on top of the 

preview image and selecting Save as…. The format and storage location can be selected in the 

opening dialog. The available bitmap formats are BMP, JPG, PNG, and PPM.  

Note: In PPM format the files are stored with the captured color depth, with other formats the color depth 

is truncated to 8 bits per color. 

The selections in Tools > Options menu define if the frame bitmap will be stored as captured from the 

display interface or if the color mode conversion selected for preview will be applied. 
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Full Screen 

Preview captured video full screen, scaled to vertically fit the screen. 

Double-click on the screen or press <Esc> to exit full screen mode. 

Preview DSC Decompressed Stream 

In order to capture and preview DSC compressed video DSC must be enabled in Link Capabilities 

dialog in Link tab. 

Select Enable Preview to verify that DSC compressed stream is received. 

Click the Snap button to capture one frame and start the decompressor (offline in the PC). Once the 

decompression is ready, the frame is shown, and Log lists the details of the compressed image. 
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 Capture Tab 
UCD device has an internal frame buffer that can be used for continuous capture of video data. In 

addition, audio and metadata can be captured and saved for later analysis. Video can be stored as 

RGB or RAW data.  

Start / Stop: Start or Stop capturing 

Capture N frames …: The number of video frames captured. 

Format: Selection of the format of the saved video frame bitmaps. BIN, PPM, 

BMP, BIN + PPM, BIN + BMP. 

Capacity of buffer: The number of video frames that can be stored to UCD frame buffer 

using current video signal format. 

Align to MSB Store binary data aligned to the Most Significant Bit (MSB).  

When this is left unchecked the binary data is aligned to the Least 

Significant Bit (LSB).  

Events: Please refer to chapter Event Log for details of the captured events. 

Status: Status of the capture. 

Open Timeline Viewer Open Event Timeline Viewer to view the captured data. Refer to chapter 

seven of this manual for detailed instructions. 

Open storage folder: Data save folder is defined in menu Tools > Options. Captured video, 

audio and data is saved in a subfolder of this folder. The name of the 

subfolder is “buffered_capture_yyyymmdd_hhmmss” (e.g., 

buffered_capture_20210301_130532). 

 

Note: Video Preview needs to be disabled to use Data Capture functionality. 
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Link Analyzer Tab 
Capture of Main-link Data Events and AUX Transactions for evaluation with Link Timeline Viewer. 

Please refer for details to chapter Link Timeline Viewer later in this manual for more details. 

Start Start capturing main link data defined by Main Link Capture Options  

Open Timeline 

Viewer 

Open Link Timeline Viewer. For detailed description of Link Timeline 

Viewer, please refer to chapter six of this manual. 

Open storage folder Open folder in the PC where capture data is stored. Folder is the video 

storage folder defined in Tools > Options.  

Captured video, audio and data is saved in a subfolder of this folder. The 

name of the subfolder is “capture_yyyymmdd_hhmmss). (e.g. 

capture_20210215_093351). 

Main Link Capture Options 

Amount: The amount of data logged to buffer. Buffer size 4 GBytes maximum. 

Encoding: Auto, 8b/10b or 128b/132b 

Lane count: Auto, 1, 2 or 4 
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Trigger Point Options 

 

Start of data capture can occur without defined trigger of triggered by a predefined signal 

combination. 

The Position drop-down list at the upper right shows where in the trigger event it will start capture. 

First select the event block from the Trigger drop-down list and use context sub-menus to select 

detail.  

 

Trigger Source Position 

No active trigger — — 

Start of TPS1 / TPS2 / TPS3 / TPS4 TPS1, TPS2, TPS3, TPS4 Initial LT, 

After ALPM, 

Initial LT or After ALPM 

Exit of TPS1 / TPS2 / TPS3 / TPS4 TPS1, TPS2, TPS3, TPS4 Initial LT, 

After ALPM, 

Initial LT or After ALPM 

Trigger Source Mask (hex) 

VB-ID with the MASK – any change, match, 

selected bit transition 

Any VB-ID change 

VB-ID match with VB-ID 

Mask 

Change of any bit in VB-

ID that is set in VB-ID 

mask 

Set Mask value in hex 

format. 

VB-ID on TYPE – BS/SR/CPBS/CPSR BS, SR, CPBS, CPSR — 

Trigger Options HB0 (hex), HB1 (hex) 

SDP Type received – HB0 and/or HB1 match Match on HB0, HB1 can 

be any value 

Match on HB1, HB0 can 

be any value 

Match on HB0 and HB1 

Set HB0/HB1 values in hex 

format. 

Trigger Source Options 

MSA – any change, change by mask, match by 

mask 

Any MSA change 

Change of any MSA 

attribute set in mask 

Match of any MSA 

attribute set in mask 

MVid, NVid, HTotal, VTotal, 

HActive, VActive, HSyncW, 

VSyncW, HSyncP, VSyncP, 

HSyncS, VSyncS, MISC0, 

MISC1 

Any AUX transition — Initial LT, 

After ALPM, 

Initial LT or After ALPM 

Trigger Type Address (hex) 

AUX read or write of specific address AUX native write 

AUX natve read 

Set address in hex format. 

Trigger   

ACT (Allocation Change Trigger)   

Note:   If you want to capture during link training and you have set the trigger accordingly, you can initiate 

link training by clicking Pulse HPD at the bottom of the window. 
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Events 

The following events can be included in the captured data. 

HPD 

Status and status changes of Hot Plug Detect (HPD) signal 

AUX 

AUX Channel transactions. 

SDP 

Secondary-data Packets received in the Main-Link. Click the button to open the Event Filter Dialog. 

The dialog enables filtering of SDP packets. In the dialog, the reference to Packet Type Value is 

indicated in square brackets “[ ]”. 

VB-ID 

Vertical Blanking ID packets. Click the button to open the Event Filter Dialog. The dialog enables 

definition of which bit changes will be logged. 
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MSA 

Log Main Stream Attributes. Click the button to open the Event Filter Dialog. The dialog enables 

definition of which events will be logged. 

Link Pattern:  

Detect link patterns. Click the button to open the Event Filter Dialog. The dialog enables definition 

of which patterns will be logged. 

AUX_BW: 

Capture AUX Channel signal details. 

VFRAME INFO 

Dimensions of the catured frame measured by the Sink 
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Audio Tab 
Audio tab has a preview of the audio signal format and the controls for audio playback and recording. 

Up to eight channels will be shown based on the received audio stream. 

 

The audio signal format is shown in three ways. 

• The ‘oscilloscope’ panel displays the waveforms of the received audio channels.  

• The frequency spectrum of the audio is shown in the lower panel. The range of the spectrum 

display is from 0 to 1/2 of the input sampling rate. The amplitude scale of the spectrum display 

can be selected between ‘Linear’ to 100 dB. 

• The input audio mode field (in the bottom of the dialog) indicates detected audio mode in the 

input stream and the number of audio packets captured. 

Enable Preview / Disable Preview 

This button controls capturing the audio data. 

Select Monitored Stream 

When Multistreaming (MST) is enabled, the monitored stream can be selected from Current Stream 

selection in the bottom of the dialog. 

Note: Please note that if the captured audio signal is constant, and audio signal frequency and audio 

sampling rate (e.g. 1000 Hz audio and 32 KHz sampling) match audio preview sampling rate, the 

‘oscilloscope’ panel will seem static. Signal capture can be verified by ensuring that Frame # below 

the panels is increasing. 
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Playback Device Selection 

The captured audio can be played back in the PC. The combo-box defines the audio device in the 

host PC through which the captured audio is played. By default, No audio playback is selected. 

Note: Please note that the audio capabilities of the audio playback device of the PC are not automatically 

reflected in the audio capabilities description in UCD device EDID. Since UCD devices are not 

performing any audio format conversion, it might occur that the source provides an audio format that 

the selected playback device is not supporting. In case a conflict occurs, please change manually the 

EDID content, or disable audio playback to monitor the waveforms in UCD Console. 

Refresh Audio Device List 

 

Click here to re-read the list of audio devices after making changes to the host PC configuration. 

Start Audio Recording 

 

The captured audio can be recorded in the PC using Waveform Audio File Format, WAV (*.wav) 

format. Recording duration is defined in milliseconds (ms). The folder where the audio file will be 

saved can be selected in Tools > Options. 
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EDID/DisplayID Tab 
EDID/DisplayID Tab provides tools for accessing the EDID/DisplayID data presented to the connected 

Source Device. There are three basic functions: 

• Load and save data files on the host PC. 

• Edit contents in Editor Mode or Hex Edit Mode. 

• Read and write to EDID/DisplayID memory for up to 4 virtual ports. 

EDID/DisplayID Files 
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With Load… and Save as… a file can be read and written from the PC. Please note that the program 

does not alter the contents of the file or verify its integrity during load and save operations. 

Note: Four blocks (512 bytes) of EDID code are read. If the device does not support all four blocks, the 

non-supported data is zeroed. 

 

The Enable DisplayID checkbox, when checked, informs generator devices that DisplayID data is 

available. 

The Text EDID and Text DisplayID tabs allow viewing data in tree form. 

EDID/SDisplayID Editor 

Please see the description in Chapter EDID/DisplayID Editor later in this document. 
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DPCD Tab 
DPCD tab is a tool for monitoring and editing the DPCD registers of the UCD Sink. 

 

The DPCD Decoder panels on the right show the interpretation of the DPCD byte selected on the 

monitoring windows. The selected byte is shown with a green background.  

Save: Select DPCD content to a binary DPCD Data file (*.DPD). 

Load: Select previously saved binary DPCD Data file (*.DPD). 

Report: Save parsed content of selected DPCD register ranges as HTML file 

Refresh: Re-read the data from the DPCD registers to the window in question 

Write Changes Write the portion of data shown in the window in question to the DPCD registers. 

Set Reference Store currently shown data as a reference for comparison 

When the data is Refreshed from the DPCD registers the changed bytes will be highlighted with blue 

color. The fields edited by the user will be highlighted with red color. 

Note: - User control like Link Training or mode changes will modify the content of the DPCD registers 

- During a reboot of the UCD device the DPCD registers will be returned to their default values 
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SDP Tab 
In SDP Tab shows the Secondary-Data Packets sent by the Source device. Click Refresh to update 

the data. Show/hide the SDP  data by clicking Packet Info button. The divider line can be draged to 

adjust the pane size. 

SDP CRC16 error counters (128b/132b) 

 

SDP CRC16: Shows if connected DP Source device supports SDP CRC16. Green light indicates 

that the source supports SDP CRC 16. 

Streams: Streams from 0 to 3. 

Error count 

(click to 

clear): 

Shows error counter values on each lane. Click the row to clear the error 

counters. 

 

The following packets are recognized: 

• Audio_TimeStamp 

• Audio_Stream 

• Extension 

• Audio_CopyManagement 

• ISRC (International Standard Recording Code) 

• Video Stream Configuration (VSC) 

• Camera Generic 0 

• Camera Generic 1 

• Camera Generic 2 

• Camera Generic 3 

• Camera Generic 4 

• Camera Generic 5 

• Camera Generic 6 

• Camera Generic 7 

• Vendor-Specific Infoframe packet 

• AVI InfoFrame packet 

• Source Product Descriptor InfoFrame packet 

• Audio InfoFrame packet 
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• MPEG Source InfoFrame packet 

• Dynamic Range and Mastering InfoFrame 

• Picture Parameter Set (PPS) 

 

 

Saving SDP Packets 

Packets can be saved in a file in binary format. Click Save and in the dialog select the packet types 

of choise. File name will be of format ATS_2022-07-28T15_54_24.bin, where ATS is the packet type 

and 2022-07-28T15_54_24 the time stamp.  

Saved packets can be evaluated and edited using Packet Editor. Please see section Packet Editor 

later in this document 
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DSC Tab 
DSC tab contains status of the Display Stream Compression (DSC) feature, and definition of DSC 

support capabilities that UCD-5XX defines in its DPCD register. 

Enabling DSC 

Enabling DSC feature is controlled by the connected source device. When connected, a source 

verifies corresponding registers in DPCD of UCD-5XX sink to find out if DSC capability is declared.  

DSC Capable UCD-5XX sink is declared as DSC capable. Control is only in use with 

8b/10b link coding. 

DSC Enabled Connected source has enabled DSC 

Enabling 16K capability for DSC 

UCD-5XX sink can support throughputs other than the default value (340 MP/s). To do so, users need 

to select required 'Throughput mode 0' for 4:4:4 and Simple 4:2:2 modes or 'Throughput mode 1' for 

for Native 4:2:2 and Native 4:2:0 modes. The DP DSC Source device may then use this information 

to identify possible supported configurations. In order to give an opportunity to the DP DSC Source 

to enable DSC with 16K resolution, it is necessary to increase the declared DSC throughput at the 

sink. It should be set to 1000 MP/s. 
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DSC Support Capabilities 

The various controls in this tab change the content of UCD-5XX sink DPCD register address range 

(0x00061 through 0x0006F) related to DSC. Please click Apply to enable the change. 

Apply: Write changes to the DPCD registers of UCD Sink 

Refresh: Re-read the content of UCD Sink DPCD and update the control status. 

Reset: Reset the content of DSC related DPCD registers in UCD Sink (0x00060 

through 0x0006F) to the default values as defined in UCD firmware. 
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Panel Replay Tab 
 

Panel Replay consists of two main panels:  Panel Replay and Panel Self Refresh. 

The Status panels show if Panel Replay and Panel Self Refresh are enabled, and if so, the statuses are 

reflected in the color widgets below them. 

Panel Replay and Panel Self Refresh Capabilities can be modified in the Capabilities panels and applied 

by clicking the Apply buttons (when enabled), 

 

 

 

Panel Replay  

Panel Replay panel consists of Status and Capabilities panels. 

The Statuses shown are  

•  Self refresh status: Disabled, Inactive, Active 

•  Active frame CRC error: Colored for error 

•  RFB storage error: Colored for error 

•  PSR VSC SDP uncorrectable error: Colored for error 

•  AS SDP missing and not disabled: Colored for condition 
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The Capabilities panel has: 

Checkboxes for: 

•  Panel Replay 

•  Selective Update 

•  Early Transport 

•  Selective Update Granularity Needed 

•  SU Y  Granularity Extended Caps 

•  DSC CRC of multiple SU regions 

•  DSC decode in PR 

•  Asynch Video Timing 

•  Link OFF 

Combo boxes for:  

• PR selective update X granularity 

• PR selective update Y granularity.  

• These can have values: One-line address, Two-line address, Four-line address, Eight-line 

address, 16-line address. 

Grouping for A SU Y granularity extended capability: checkboxes for selections 

Press Apply to configure and check the HDP pulse on Apply if desired. 

 

Panel Self Refresh  

Panel Self Refresh consists of Status and Capabilities panels. 

The Statuses shown are  

•  Self refresh status: Disabled, Inactive, Active 

•  Link CRC error: Colored for error 

•  RFB storage error: Colored for error 

•  PSR VSC SDP uncorrectable error: Colored for error 

•  SU PSR capability change: Colored for change 

 

The Capabilities panel has: 

Combo boxes for:  

•  PSR supports:  

 

 

 

 

 

•  PSR Setup Time (us): 330, 275, 220, 165, 110, 55, 0 

• PR selective update X granularity 

• PR selective update Y granularity.  

These can have values: One-line address, Two-line address, Four-line address, Eight-line address, 

16-line address. 

 

Checkboxes for: 

•  Link Training Requirement of Sink 

•  Y-coordinate for PSR22 SU 

•  SU coordinates shall adhere 

•  Do not update AUX FRAME SYNC 

Press Apply to configure.  
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FEC Tab 
FEC tab contains control of the FEC (Forward Error Correction) feature, Error Detection table and 

FEC Status Log. 

 

Enabling FEC 

Enabling FEC feature is controlled by the source device. When connected, Source verifies 

corresponding registers in Sink DPCD to find out if sink is FEC capable. FEC Status Log lists FEC 

events 

FEC Capable: UCD-5XX Sink is declared as FEC capable. Control is only in use with 8b/10b 

link coding. 

Generate HPD on change: When selected, UCD-5XX Sink generates an HPD to establish a new 

connection after the change to make sure that connected Source re-reads the 

FEC capability status 

FEC Enabled: LED to indicate if the source has enabled FEC 

Enable aggregated errors Declare that UCD-5XX Sink is able to indicate aggregated errors in counters 

Update: Read FEC Error Counters from DPCD 

Clear Counters: Clear FEC Error Counters in DPCD. 
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Source DUT Testing Tab 
Please refer to Appendix E later in this document for a description of the tests available. 

Select the tests for execution by checking checkboxes or by clicking the test name. All tests item on 

the left-hand side is really just for viewing all tests available. Select the desired test category (ex. DP 

1 .4 LLCTS) when running tests. 

Run/Run 

Checked: 

Select to start selected/checked tests. Once tests are running the Run Checked 

button is relabeled Abort to stop the test sequence if desired. 

Select: Includes three sets of options: Select All, Clear All, Invert All for changing the tests 

current selections; Save (checked items), Load (and check relevant items), Remove 

(named tests list) for handling named templates; Import (check all items contained in 

file) and Export (save all checked items to file) for loading and saving file-based 

templates. Do not confuse Import and Export with those below: These are for setting 

and saving tests to run. 

Configure: Opens a test parameters dialog for the selected test set. Make sure a test category 

other than All tests is selected. Refer to Test Parameters below for details. 

Import: Load saved test parameter files (*.td or *.json) for into UCD Console. Select 

Configure to see current parameters.  Loading *.td files to UCD Console is currently 

unreliable. 

Export: Save test parameters for later use or for use in test automation. For saving 

parameters for later use in UCD Console, either format can be used. For saving 

parameters for TSI scripting, please use *.td files. For use with Python applications, 

please use *.json files. 

Stop on Failure: Stops execution of tests if one fails. 

Repeats: Number of times to repeat the selected test sequence. 

Delay time: Delay in seconds between individual tests. 

On completion of each test the result of the test is displayed in the table columns on the right. For 

each test the table lists the number Pass, Fail, Skips, Runs and Last Status (status of last run). 
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Save Report: Select to generate a HTML report file. This will also open  a tab in the default 

browser and display the results. 

Clear Selected: Clear the test results of the selected (not checked) tests results. A 

subsequently saved report will not include these test results. 

Clear All: Clear the test log view and the outstanding results. 

 

 

Test Parameters 

Each test suite has a dedicated set of test parameters. Select Configure to launch the parameters 

dialog for the selected tests. 

See Appendix E for parameter descritptions for each test category. 

Saving Test Parameters 

Test parameters can be saved in various ways. 

• Export parameters in Source DUT Testing tab to a *.td file for later use in UCD Console or with 

TSI scripting or sharing. 

• Export parameters in Source DUT Testing tab to a *.json file for later use in UCD Console or 

with Python applications or sharing. 

• Save parameters in Configure dialog as Presets to be later used in Console. See description 

below. 

Presets 

All Configure dialogs selected parameters can be saved and loaded via Presets dropdown menu. 

Select Save or Load for named internal configuration parameter sets. Select Remove to delete a 

named internal set. Select Import and Export for loading and saving parameter sets from and to  

external files. Note that Importing and Exporting *.json files here have a different format than importing 

those described above 
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Cable Info Tab 
Cable properties for DP RX and USB-C RX are shown below  

Devices with older Front Ends may not display DP cable properties correctly. 

DPTX / DPRX Cable Info 

UHBR Capabilities: Shows DP UHBR capabilities of connected cable. 

UHBR 13.5 Capable: For DP, shows if the connected cable is UHBR 13.5 capable. 

Cable Type For DP, shows type of the cable connected. 

USB-C Cable Info 

Data received from cable in response to Discover Identity command sent to SOP’. 

 

DP Cable Information 

DP Cable information panel shows if the connected cables are DP56 / DP80 capable. 

 

Note: USB-C cable info can only be read when in Down Facing Port role.  

Select Refresh after changing roles. 
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PDC Tab 

When UCD-5XX device is in USB-C DP Alt-Mode Sink or Source role, the following interface specific 

tabs are available. 

 

 

USB-C Power Delivery Controller Tab is for Power Delivery Contract behavior control.  

The PDC tab itself consists of tabs: DP Alt Mode, Power Source, Power Sink, EPR Source, EPR Sink, 

Controls. 

Status List, PD Control and Orientation groups are always visible when any of the above-mentioned 

tabs are selected. 

View the current PDC status for both contract partners in the Status List. 

Select power and data roles and VCONN using the PD Control group buttons: Send PR_SWAP, Send 

DR_SWAP, Send VCONN_SWAP. 

Cable Orientation can be seen via the Orientation group radio buttons. 
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Status List 
Status List information is presented as collapsible sections. Each section contains information related 

to PDC contract status and available features. See DP Alt Mode for pin assignments. 

 

 

TE Status 

Data Role Up facing port (UFP) or Down facing port (DFP). 

Power Role Sink or Source. 

VConn Off or On. 

E-Marked Cable Cable details. 

DP Alt Mode Alt Mode configuration pin assignment details. 

PD Contract PDO type, current and voltage. 

 

PD Contract (Power Source) 

-PDO  Type Type of PDO. 

-PDO voltage Voltage supplied by source. 

-PDO max current Maximum current supplied by source. 

 

PD Contract (Power Sink) 

-RDO max current RDO maximum current (A). 

-RDO oper current RDO operating current (A). 

-No USB suspend No USB suspend, Yes or No. 

-USB comm capable USB comm capable, Yes or No. 

-Capability mismatch Capability mismatch, Yes or No. 

-Give back Give back flag, Yes or No. 

 

Bus Electrical Status 

Voltage and current statuses in volts and amps 

• Vbus voltage 

• Vbus current 

• CC1 voltage 

• CC2 voltage 

• VCONN voltage 

• VCONN current 

• SBU-1 voltage 

• SBU-2 voltage. 
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Internal load 

• Internal load (Ohm) status: Enabled or Disabled. 

• Overcurrent protection status: Triggered or Not triggered. 

DUT Discovery 

Data Capable as host (yes/no) 

Data Capable as Device (yes/no) 

Product Type Product type 

USB Vendor ID Value (hex) 

USB-IF Product ID Value (hex) 

BCD Device Value (hex) 

SVID0 and SVID1 Values (hex) 

DUT DP Alt Mode Capabilities 

DP Capable  

Receptacle Indication  

USB 2.0 Signaling  

Pin Assignment supported  

 DFP_D Down Facing Port pin assignment 

 UFP_D Up Facing Port pin assignment 

DPAM Version Version 

TE DP Alt Mode Status 

Status Active or Not Active 

Multi-function preferred Yes, no or not relevant 

HDP state asserted or not asserted 

DP Capable Bandwidth e.g. HBR3 

Pin Assignment Pin assignment with description 

Cable UHBR 13.5 Support Description 

Cable Active Component Description 

DPAM Version Version 

DUT DP Alt Mode Status 

Status Port and connection status 

Multi-function preferred Yes, no or not relevant 

HDP state asserted or not asserted 

Power low Power low indicator 

DPAM Version Version 
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Capabilities 

 

Initial Role Power contract negotiation initial role for TE (UCD-5XX) (power and 

data). 

Reject Swaps Allow or reject role swap requests. 

CC Pull-up Rp resistance used to advertise current capability. 

Try Behavior Power contract negotiation initial power role.  

UCD-500 Identity Status information provided by TE.  

Vendor ID and Product ID can be modified by entering new values and 

selecting Apply. Select Refresh to see that changes have been applied. 

  

Accessories 

Audio Accessor: Enable simulation of Audio Accessory support. 

Debug Accessory Enable simulation of Debug Accessory support. 

 

Enabling Audio Accessory and Debug Accessory extends USB Type-C Connection State Machine 

with *.Accessory states. (Please refer to USB Type-C specification for details). 

Note: Note that UCD-500 does not support physical connections for the Accessory functions. The 

selections are behavioral simulations. 
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DP Alt Mode 
Controls and capability settings for DisplayPort Alternate Mode. 

Enter 2 lane mode (D): Restart mode discovery and advertise support for mode D  

(2 DP lanes + USB SS). 

Enter 2 lane mode (C,E): Restart mode discovery and advertise support for modes C and D 

(4 DP lanes). 

Exit DP Alt Mode: Exit DP Alternate mode. 

Disable DP Alt Mode: Exit DP Alternate mode and advertise no DP Alternate mode 

support. 

Auto enter on connect: Start mode discovery after connection and enter DP Alternate 

mode if suitable configuration is found. 

Multi-function preferred: When entering DP Alternate Mode, select mode D. 

Align DP and USB Data Roles When selected, before entering to DP Alternate Mode, DP role 

and USB Data role will be aligned to match the role selected for 

the UCD device, i.e. DFP in Generator role and UFP in Analyzer 

role. 

DPAM 2.1 Control Enable or Disable. 

 

DP Alt Mode Capabilities 

Supported Pin Assignments declared in DisplayPort Capabilities discover message. Separate for 

UFP_D (DisplayPort sink) and DFP_D (DisplayPort source) 
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Power Source 
Definition of Power Data Objects (PDO) for UCD-5XX when acting as Power Source Port. 

 

PDO Type: Definition of power source type (Disabled, Fixed, Variable or Battery) 

Note: The requirement is that Sources shall supply at least one fixed supply capable of supplying vSafe5V 

 

Note: Note that UCD-5XX devices are not able to simulate electrical behavior of Variable or Battery source 

types. 

Refresh Re-read status from UCD-5XX 

Apply Program new values to UCD-5XX 

Send PDO Send a Source Capabilities message 

Load PDO Load a stored Power Source PDO configuration from file. 

Save PDO Store current Power Source PDO configuration to a file 
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Power Sink 
 Controls and Definition of Power Data Objects (PDO) for UCD-5XX when acting as Power Sink Port. 

 

Give back flag: UCD-5XX sets GiveBack flag in its Request Data Object 

No USB suspend: UCD-5XX sets No USB Suspend flag in its Request Data Object 

PDO type priority: Setting of the policy used for automatic selection from available PDOs 

advertised by Source Device. (Prefer higher current / Prefer higher 

voltage / Prefer higher power) 

Max Operation 

Current 

Setting the highest current UCD-5XX will ever require when operating as 

a Power Sink. 

 

PDO Type: Definition of power source type (Disabled, Fixed, Variable or Battery) 

Note: The requirement is that Sinkss shall supply at least one fixed supply capable of supplying vSafe5V 

 

Refresh Re-read status from UCD-5XX 

Apply Program new values to UCD-5XX 

Load PDO Load a stored Power Source PDO configuration from file. 

Save PDO Store current Power Source PDO configuration to a file 

 

Controls 
Control tab includes miscellaneous controls related to UCD behavior as a USB-C PD Port Partner. 
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PD Contract Settings 

Automatically negotiate power contract: When selected UCD will start power contract negotiation if 

suitable configuration is found.  

USB Internal Load 

Current Load feature that only applicable when UCD-5XX is operating as Power Sink role. Only fixed 

current value in around 900mA is able to be sinked by UCD-5XX. 
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Bottom Panel 

HPD 

 

Cable Cable status 

HPD: HPD status 

Assert / Deassert: Manually Assert or Deassert. 

Pulse HPD: Manually pulse HPD. Set the lenght in milliseconds. 

Short pulse: Manually perform a short pulse. Set the length in milliseconds. 

Note: Please note that UCD-5XX is not automatically Attached to the connected port partner even if the 

cable is connected physically. The user needs to click the Attach button manually to make the 

connection. 

PD Control 

Send PR_SWAP: Send PR_Swap message to request an exchange of power roles. 

Send DR_SWAP: Send DR_Swap message to request an exchange DFP and UFP operation 

between Port Partners while maintaining the direction of power flow over 

Vbus. 

Send VCONN_SWAP: Send VCONN_Swap message to request an exchange of Vconn Source. 

 

PD 

 

DUT Attached: Indication that Attach event is detected by the Source port in one of its CC 

lines. Type of USB-C cable detected. 

Detach: Manually Detach USB-C port partners. 

Reconnect: Restart USB-C Source-to-Sink attach procedure. 

PDC and Orientation 

 

PDC Status: UCD-500 PD Controller Status 

Reset: Reset the PD Controller in UCD-500 to overcome abnormal situations. 

Reconnect: Restart USB-C Source-to-Sink attach procedure. 

Orientation: CC1 / CC2 and Cable orientation 
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 GENERATOR OPERATION 
When used as a Generator, the UCD device acts as DisplayPort or USB-C DisplayPort Alt Mode 

Source or Transmitter device. Generator functionality related controls and dialogs can be used by 

selecting DP TX tab.  

Please note that in most UCD-5XX Series units Analyzer functionality is available simultaneously with 

Generator functionality. Please find description of Analyzer functionality earlier in this manual.  

Functionality Tabs 

UCD Console features are presented in tabs. Standard tabs are similar in all functional roles, Interface 

Specific tabs present features and controls that are only available for a particular interface. 

Some of the tabs are enabled by default, some only when an applicable license is included.  

Note: Some of the tabs are enabled by default, some only when an applicable license is included. Please 

refer to Appendix B Licensing of this document for description of features and licensing 

Link Tab 
The link tab shows the status and control items for the DisplayPort link. 
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Link Status 

Link Status displays the status of the link training and the link parameters negotiated between the 

connected Sink and UCD Source. It also lists the status of other link modes. The data is retrieved 

from the DPCD status registers of the connected Sink. The status is updated automatically, but in 

case it seems that the update is delayed, please click on the Force update button. 

Lanes: Indicates the number of lanes used for DisplayPort or DisplayPort Alt Mode. 

CR/SL/EQ: LED indicators for status of Clock Recovery / Symbol Lock / Channel 

Equalization. 

VS/PE (level): Voltage Swing / Pre-emphasis level. 

FFE preset: TX Feed Forward Equalization (FFE) preset value  

(only with 128b/132b channel coding). 

Error count: Content of DPCD Error Count registers. 

ILA: Status LED for Inter-Lane Alignment. 

EQ_ILA Status LED for Inter-Lane Alignment on Equalization stage (only with 128b/132b 

channel coding). 

CDS_ILA Status LED for Inter-Lane Alignment on Clock and Data Switch stage (only with 

128b/132b channel coding). 

LT_FAIL Status LED for Link Training failure (only with 128b/132b channel coding). 

Bit rate: Currently enabled link bit rate. 

Link mode: Currently enabled channel coding (128b/132b or 8b/10b). 

Framing mode: Status of Enhanced Framing symbol sequence (only with 8b/10b). 

Scrambling: Status of link Data Scrambling (Enabled or Disabled). 

MST mode: Status of the Multistreaming (MST) mode. 

SSC status: Status of Spread-Spectrum Clock (SSC) function. 

DSC Status: Status of Display Stream Compression (DSC) function. 

FEC status: Status of Forward Error Correction (FEC) function. 

LTTPR Status: Status of Link Training-tunable PHY Repeater (LTTPR) function.. 

 

Send ACT: Force sending Allocation Change Trigger (ACT) sequence over the Main-Link.  

Force update: Re-read statuses to update the panel. 
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Link Configuration 

 

Set target capabilities for the link training. Click Link Training or Fast LT to apply.  

Set target capabilities for the link training. Click Link Training or Fast LT to apply.  

DP Lane Count (8b/10b): Lane count used when 8b/10b link coding is selected in LT. 

DP Bitrate (8b/10b), Gbps: Link rate used when 8b/10b link coding is selected in LT. 

DP Lane Count (128b/132b): Lane count used when 128b/132b link coding is selected in LT. 

DP Bitrate (128b/132b), Gbps: Link rate used when 128b/132b link coding is selected in LT. 

Additional DP Bitrate (8b/10b), 

Gbps 

Additional bit rates available. 

eDP Bitrate, Gbps Bitrates available for eDP .eDP support is limited to eDP 1.5 (i.e. 

8b/10b link coding) 

Force DP (128b/132b): UCD-5XX Source uses only 128b/132b link layer protocol, no fall back 

to 8b/10b link layer. 

Enhanced Framing Mode: Enable Enhanced Framing Mode. 

Max Link Bandwidth Policy 

supported (8b/10b): 

When checked, UCD supports Link Training Flow with Maximum Link 

Data Bandwidth Policy (only in 8b/10b coding). 

FEC (8b/10b): Enable Forward Error Correction feature (only in 8b/10b coding). 

LTTPR: Select to enable Link Training Tunable PHY Repeater (LTTPR) 

protocol support. 

Old DP 2.0 LT: When checked LT will follow initial DP 2.0 specification,  

otherwise, LT is per DP 2.1 specification. 

FEC (8/10b) Enable Forward Error Correction feature (only for 8b/10b coding). 

Try DP (128b/132b): UCD-5XX Source checks capabilities of the connected Sink and, if it 

supports 128b/132b link layer protocol, it starts Link Training with 

128b/132b link layer. If LT fails it falls back to 8b/10b link layer 

protocol. 

Try eDP Try to link with eDP. 

Force eDP Force eDP linking. 

eDP AUX Preamble Use eDP AUX Preamble protocol when linking. 
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Instead of 10 Gbps, use: For supporting low link rate Sink devices, the user can make UCD-

5XX source PHY to use a selectable lower link rate when performing 

‘10 Gbps’ link training in protocol level. 

Link rates are: 2.5 Gbps, 2.7 Gbps, 5.0 Gbps and 5.4 Gbps 

LTTPR Mode Select LTTPR mode: Default, Ignore, Transparent, Non-Transparent. 

EQ pattern (8b/10b) Pattern (8b/10b) to be used for equalization: auto, TPS2, TPS3 or 

TPS4.  

Enable SSC: Enable down spreading of link frequency (SSC). 

Amp (‰): SSC Spreading Amplitude (0.1% to 2.5% in 0.01% steps).  

Freq (Hz): SSC Modulation frequency (30 to 33 kHz).  
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Link Overrides 

Voltage Swing (level): Override Voltage Swing level selected during link training. 

Pre-emphasis (level): Override Pre-emphasis levels selected during link training. 

FFE pre-sets: TX Feed Forward Equalization (FFE) preset value (only with 

128b/132b channel coding). 

Click Apply to validate changes. VS/PPE or FFE overrides are applied immediately to DPTX 

transceiver when 'Apply' is clicked. Please note, that It affects main link signal amplitude and pulse 

shape only. No AUX exchange takes place. The change can be checked only with a scope. Overrides 

are removed at the beginning of the next link training. 

 

Link Pattern 

 

Select between Active video and audio, Idle pattern, or special bit patterns. 

Active Video Transmit Video Pattern, Audio and Metadata. 

Idle Pattern Link is active but no stream data is being transmitted. 

Training Pattern 1 Send Link Training Pattern Sequence 1 (TPS1 same as 

D10.2). 

Training Pattern 2 Send Link Training Pattern Sequence 2 (TPS2). 

Training Pattern 3 Send Link Training Pattern Sequence 3 (TPS3). 

Training Pattern 4 Send Link Training Pattern Sequence 4 (TPS4 same as 

CP2520 3). 

PRBS7 Send PRBS7 Link Quality Test Pattern. 

HBR2 (CP2520 1) Send HBR2 Compliance pattern CP2520 1. 
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SER (Symbol Error Rate) Send Symbol Error Rate Measurement pattern. 

Force Video Reference Source will continue Video pattern transmission on 

the previously established link configuration regardless of the 

link status. 

Force Idle Reference Source will continue Idle pattern transmission on 

the previously established link configuration regardless of the 

link status.  

HBR2 (CP2520 2) Send HBR2 Compliance pattern CP2520 2. 

PRBS9 Send PRBS9 Link Quality Test Pattern. 

PRBS11 Send PRBS11 Link Quality Test Pattern. 

PRBS15 Send PRBS15 Link Quality Test Pattern. 

PRBS23 Send PRBS23 Link Quality Test Pattern. 

PRBS31 Send PRBS31 Link Quality Test Pattern. 

Link square pattern Send Square Sequence Pattern. 

The number of continuous 1s followed by continuous 0s is 

given as a parameter. 0x00 represents one set of 1s and 0s, 

0xFF represents 256 1s and 0s. 

Click Apply to validate the selection. 

Note: Please note that except for Active Video and Idle Pattern, Link Training will NOT be initiated on such 

events as cable re-plug, Long HPD pulse and IRQ_HPD pulse due to link loss. 

 After using the special bit patterns, in order to return to the default operation mode, please select 

Active Video and click Apply. 

 

Scrambler Seed 

Selection of the value to which the Linear Feedback Shift Register (LFSR) is reset during scrambler 

reset. Used only when 8b/10b link coding is enabled. 

HDCP Status & Configuration 

Copy of HDCP status and controls on HDCP tab. 

Note: Please note that HDCP 1.3 is not supported in 3.8 release. 
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HDCP Stream Status 

Shows HDCP stream status for each stream. 

 

SDP Configuration 

 

Enable SDP Splitting. 

Note Selecting this configuration option does not guarantee that SDP splitting will occur for a given 

configuration of the Video and Audio pattern generators. SDP splitting will take place when it makes 

sense and required for SDP splitting conditions are met.  

Stream Info 

Stream Info is achieved from the Main-Stream Attributes (MSA) of the monitored stream. Frame rate 

is measured by UCD Local Sink 
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The content of Stream Info table can be copied by right-clicking on the table and selecting Copy. 

Framerate Vertical refresh rate 

HTotal Horizontal total of transmitted main video stream, measured in pixel count. 

HStart Horizontal active start from leading edge of HSync, measured in pixel count. 

HActive Horizontal active, number of active pixels in video line 

HSync HSync width, measured in pixel count. (+)/(-) positive / negative sync. 

VTotal Vertical total of transmitted main video stream, measured in line count. 

VStart Vertical active start from leading edge of VSync, measured in line count. 

VActive Vertical active, number of active lines in video frame 

VSync VSync width, measured in line count. (+)/(-) positive v.s. negative sync. 

CEF Used color mode: Color format + subsampling / colorimetry 

BPC Color depth in bits per color (BPC) 

CRC (RGB/CrYCb) 16-bit Cyclic redundancy check (CRC) value per color component calculated 

from active pixels. Value order in YCbCr color format: Cr, Y, Cb. 

VFREQ: Video Frequency (128b/132b channel coding only) 

MVID/NVID: Mvid and Nvid video time stamp values (8b/10b channel coding only) 

DSC CRC 16-bit Cyclic redundancy check (CRC) calculated from compressed pixel 

stream. Value order Engine 0, 1, 2. 

VCP Table 

VCP table shows allocation of Virtual Channel Payload for active virtual channels. 

The content of VCP Table can be copied by right-clicking on the table and selecting Copy. 

Port#: Port number where the virtual channel is directed. 

SID: Stream identification number of the virtual channel 

Req.PBN: Requested PBN (payload bandwidth number) value for the virtual channel 

Alloc.PBN: PBN value allocated for the virtual channel 

First slot: Time slot where the first VC Payload for the virtual channel is stored 

Slot num: Number of VC Payload slots reserved for the virtual channel. 
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Pattern Generator Tab 

Note: The actual number of streams sent will be negotiated between the source and the sink during link 

training. 

 The video modes that can be used in MST streams are limited by the overall capabilities of the 

DisplayPort link and the connected DisplayPort Sink or Branch device.  

Auto-Apply: New settings are being validated when the user is clicks Apply. 

Automatic validation is applied when Auto-Apply is checked. 

When Select DSC Image pattern is being streamed and an incompatible 

Horizontal and Vertical Active timings are set, the user is presented 

with a dialog: H-Active and V-Active don’t match with DSC data. Do you 

want to upload image? See Sourcing DSC Compressed Patterns. 

Apply All: Apply recent changes to all streams. 

When Select DSC Image pattern is being streamed and an incompatible 

Horizontal and Vertical Active timings are set, the user is presented 

with a dialog: H-Active and V-Active don’t match with DSC data. Do you 

want to upload image? See Sourcing DSC Compressed Patterns 

MST Enable multi-stream transport mode. In 8b/10b link mode, select 

between SST and MST transport modes. In 128b/132b link coding 

mode, enable single stream output if checkbox is cleared. 

Number of streams Set number of steams via combo box. 

Force EDID preferred 

timing after LT 

UCD reads the EDID of the connected Sink and after next LT enables to 

Stream 0 the timing listed in 18 byte descriptor 1 in VESA block of the 

sink’s EDID. 

Use timings from EDID UCD reads the EDID of the connected Sink and lists only timings that 

are featured there. 

Manage Timings: Please see chapter Manage Timings later in this manual 

Total bitrate: Used link payload / Total link capability in Gbps 

Pattern Generator Status panel shows the Timing, Pattern (Name), CEF (color format and 

subsampling and colorimetry), BPC (bits per color), Status, and CRC value, for each active stream. 
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Pattern 

Configuration of the video sent in the corresponding stream  

(Controls vary between selected pattern type) 

Predefined Timings 

The list includes a set of common fixed video timings. Please find a list of the timings with their major 

details in Appendix C of this document. With the Manage Timings function the user can add timings 

to the list and select which timings are shown in the selection. 

Color Format, Subsampling and Color Depth 

The table below lists the available color modes and related available color depths. 

Selection Color Format Subsampling Available Color Depths 

RGB: RGB 4:4:4 6, 8, 10, 12 and 16 bpc 

YCbCr444: YCbCr 4:4:4 8, 10, 12 and 16 bpc 

YCbCr422: YCbCr 4:2:2 8, 10, 12 and 16 bpc 

YCbCr420: YCbCr 4:2:0 8, 10, 12 and 16 bpc 

Y-Only: Y 4:0:0 6, 7, 8, 10, 12, 14 and 16 bpc 

RAW: RAW N/A 6, 7, 8, 10, 12, 14 and 16 bpc 

Quantization Range 

VESA: Patterns are sent with Full Range color values (0 to 255 with 8 bpc) 

CTA: Patterns are sent with Limited Range color values (16 to 235 with 8 bpc) 

Quantization range selection is enabled based on the type of pattern selected. 

Video Pattern 

The selection includes a set of predefined patterns and a possibility to load user defined custom 

patterns. Please find a description of the available predefined patterns in Appendix D of this 

document. By selecting Disabled you can have the links activated but no video data transferred. 

Note: When MST mode is selected, full selection of test patterns is available only in virtual channel 0  

  

Color Depth 

Predefined  

Timings 

Selected 

Pattern 

Color Format and Subsampling 

Pattern 

Options 

Colorimetry 

Load pattern file Loaded 

pattern file 

Bitmap scaling 

Quantization 

Range 

Filter 
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Filter 

Filter timings by specific vendors and resolutions. Timings can be sorted by Vendor ID or width. 

 

Custom Image Patterns 

BMP, PNG, JPG and SVG files can be loaded from the PC to be used as custom images. 

Please refer to Link Pattern in description of Generator role Link tab earlier in this manual for sending 

special binary patterns in the link instead of video.  

Bitmap Scaling 

When bitmap patterns are used, they can be used either in their original resolution, aligned to top left 

corner (=un-check Scale), or upscaled or downscaled to match the selected video resolution (=check 

Scale). 

Pattern Options 

Some of the predefined patterns include additional configuration parameters. The controls for the 

parameters appear below the pattern selection when the pattern in question has been selected. 

Please find a description of patterns options in Appendix D of this document. 

Pattern Scrolling 

When Pattern Scrolling is enabled, the pattern is moved horizontally and vertically between display 

scans. The function is available for all patterns except the following: Color Bars, Chessboard, Solid 

Color, Solid colors (white, red, green, blue), White V-Strips, Motion Pattern, DSC Pattern. 

Enable: Enable or disable pattern scrolling 

Horizontally X pixels: Horizontal step of the pattern movement in pixels  

(values in range -127…0…128, for YCbCr 4:2:2 even values).  

0 = no movement, positive values = pattern moves to the right. 

Vertically Y pixels: Vertical step of the pattern movement in pixels  

(even values in range –127…0…128, for YCbCr 4:2:0 even values).  

0 = no movement, positive values = pattern moves up. 

Every N frame: Delay of pattern movement in display frames (values in range 0… 255).  

0 = no movement, 1 = move every frame, n = move every n:th frame. 

Note: Please click Apply to enable changes or check Auto-Apply. 
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Sourcing DSC Compressed Patterns 

UCD Pattern Generator function is able to source DSC content originating from pre-created DSC 

compressed files. DSC compressed pattern files can be created with a separate tool called DSC 

Compressor. It can be launched from Tools > DSC Compressor. 

 

Select the source bitmap file in Source File field. Define the Output Resolution, the color depth, 

compression ratio and number of horizontal and vertical slices in the frame. 

Source File: Source bitmap file to be compressed (JPG, PNG, PPM) 

Sink DSC capability registers: Click Update to read DPCD registers 0x60 to 0x6f from the connected 

Sink device 

Color Space: Color space of the output compressed file (RGB, YCbCr 4:4:4, 4:2:2, 

4:2:0, Simple 4:2:2) 

Color depth: Color space of the output compressed file (8, 10, 12, 16) 

Output resolution: Resolution of the output compressed file 

Resize mode: The way the DSC image is created from the Source file 

Compression ratio: Used compression ratio 

Horizontal slices: Nr. of slices horizontally (1 to 24 Slices) 

Vertical slices: Vertical slices (1 to 24 Slices, Custom)  

Custom vertical slices size: minimum 1, recommended 108 

YUV Color range: Selection of color range between Full range (Full) (0 to 255 at 8 bpc) 

and Limited Range (CTA) (16 to 235 at 8 bpc) 

Refresh: Refresh the list after adding a custom resolution 

Custom: Create a custom output resolution  

DSC Version: DSC version used (1.1, 1.2) 

Line Buffer Depth: Line buffer bit depth used to generate the bitstream. (8 to 16 bits, 

default 9 bits) 

Open storage folder: Open DSC temp folder defined in Tools > Options 

Start Compression: Start the compression process 
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The result of the compression process is saved in the same folder as the source file. The start of the 

file name is the same as the source bitmap file; resolution and color format are added to the end of 

the file name. 

Example:  

unigraf_default_image_16k.ppm >> 

unigraf_default_image_16k_1920x1080_YUV422_FULL_bpc8_bpp6.dsc 

To use the created DSC file in Pattern Generator, select pattern:  

Select DSC Image and click Select … to open file selection dialog. 

When a DSC image is selected as the pattern, UCD Console will automatically enable the resolution 

and the color mode matching the DSC image. If the connected Sink device declares support for DSC 

in its DPCD, UCD Console enables DSC.  

When Select DSC Image pattern is being transmitted and incompatible Horizontal and Vertical Active 

timings are set (Via Apply or Apply All), the user is presented with a dialog: H-Active and V-Active 

don’t match with DSC data. Do you want to upload image? 

 

 

 

 

 

Above, “Do you want to upload image?” is misleading and will be changed to “Continue to transmit 

image?”. 

If you select No, the new settings will not be applied. 

If you select Yes, the Pattern will continue to be transmitted. DSC data is transferred in the active 

window. To transfer all DSC data without loss, active video should be large enough for DSC 

compressed data (DSC_pic_height * DSC_pic_lenght / compression_ratio). MSA H-active should also 

not be less than DSC pic_height. 

MSA V-active parameters can be reduced without DSC corruption until active video area is no longer 

large enough to pass all DSC data. 

MSA V-active and H-active can be increased until HW limitation (pixel clock limit) and link bandwidth 

are reached. 
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Preview DSC image 

To preview an DSC image before it is applied to the pattern generator, select the eye icon. CRC and 

DSC CRC values are indicated in the preview image. 
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Manage Timings 

Custom timings can also be created and edited with pop-up Timing Editor. Launch the editor by 

clicking Manage Timings. 

Customizing Timings List 

The list of timings that are shown on the pull-down menu in Pattern Generator and Link tabs can be 

limited by un-checking the checkbox in the left edge of Name column. The timings will remain in the 

list and can be brought back to the pull-down menu, when needed. 

Editing Timings 

Video timing Name and Description are shown in the list. Lock icon      indicates that a timing is a 

fixed timing which cannot be edited or deleted. Custom timings are indicated with a head icon . 

New: Create a new custom timing based on the selected fixed timing. 

Delete: Delete the selected custom timing 

Save: Save changes in the selected custom timing. 

Revert: Undo all changes 

The dialog will make a sanity check for the values entered and will warn the user for any combinations 

that cannot be used.  
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Playback Tab 
Playback Tab is for running Playlist and scenario files. Playlists have scenarios which specify timing, 

video patterns, audio content, related metadata packets and duration for transmission. 

 

Term Functionality 

Playlist 

Playlists (text files) specify the UCD devices 

and output protocol for transmission. It lists 

scenarios to be transmitted. 

Scenario 

Scenarios (text files) allow users to select 

video frames, metadata packets and audio 

to be transmitted and their order. 

Advanced Playlists 

Unigraf UCD devices can be used as 

compatibility test tools for dedicated 

standards such as Dolby Vision™ and 

HDR10+. Contact Unigraf for details. 

Note: Note that Playlists and Scenarios are protocol dependent.  

Provided examples for HDMI and DisplayPort are somewhat different. 
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Common Tab 

The Import button is for importing *.json files into the common tab treeview. Sample content on 

windows can abe found at C:\Program Files\Unigraf\Unigraf UCD Tools\Resources\playback\ 

basic_library.json. Be warned that once imported, items cannot at present be removed. Actually you 

can but it involves using Windows Register Editor to remove values from (uninstall will not help): 

Computer\HKEY_CURRENT_USER\SOFTWARE\Unigraf\UCD Console\Playback 

Computer\HKEY_CURRENT_USER\SOFTWARE\Unigraf\UCD Console\MetadataScenario 

Sample playlists are included in UCD Console. Select a sequence (a playlist or scenario) from the 

Sample Content treeview and  press Run (or double click it) to play. 

The Run button label changes to Stop as a Scenarios run. Press Stop to stop playing the scenario. 

Press Skip to skip to next scenario (available when there are multiple scenarios in a playlist) while 

playing. While the scenario is loading the Run button label changes to Cancel to allow cancelation. 

Status Log 

Scenario commands are listed in the Status Log as they are run. 
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Selected Sequence 

Running scenario video and audio details and their sources are shown in the Selected Sequence 

group panel. 

Note that the triggered scenario or playlist to be run is the last selected: If an item was selected via 

the treeview, it is the triggered item to be run. If the Select button was used to select an item, it is the 

triggered item to be run (regardless of what is selected in the tree control). 

Press the Select button to load a playlist or scenario to be run (selecting a sample from the Sample 

Content treeview will load them as the playlist or scenario to be run). It will also be the scenario used 

as a template if the Scenario Editor is launched: default scenario values will be set if a playlist is 

selected. 

Press the Editor button to launch the Scenario Editor (see below). 

The Selected Sequence group panel displays transmission parameters. 
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Scenario Editor 

Press the Select button  (shown above) to select a playlist scenario desired to use as a template for 

creating a new scenario. Press the Editor button to launch the Scenario Editor. The the dialog 

parameters will be generated from the scenario file shown under the panel Source label (Philips 

FHD.txt as seen above) or default values if a playlist is selected. 

Press OK to save. You are presented with a save dialog. You need to navigate to a directory you can 

save to. Run Console 2 with administration rights if you want to save to default locations on windows 

such as: C:\Program Files\Unigraf\Unigraf UCD Tools\Resources\playback\content. 

Refer to Appendix H: Playlists and Scenarios later in this manual for details. 
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Metadata Tab 

 

The Metadata tab is for creating scenarios with metadata. 

 

Select the Delete button to delete a scenario or the Generate button to launch the Custom Metadata 

Scenario dialog (shown below). 

 

Current Pattern Generator timing details are shown at the top (CTA 1920 x 1080 @ 60Hz (VIC 0) 

above). You can change the color mode (RGB444, YUV444, YUV422, YUV420) and color depth (8 

bpc, 10 bpc, 12 bpc, 16 bpc) via the dropdown combo boxes. 

Select the Add or Delete buttons to add or remove metadata from the scenario. 

Check the Audio checkbox and then the Browse… button to add an audio file. Sampling, channels 

and bits can be selected via the combo boxes. 

The scenario Comment can be added in line edit box after the three dashes (---). 

Use the Content folder Browse… button to select save location. 

You can press Play to run the scenario, Export to save it or Cancel to cancel. 

Export will create a folder something like Metadata1920x1080@60-RGB444-8bpc in the Content 

folder. In it you will find generated files frame.svg (displayed while running), the metadata files you 

selected and a scenario.txt file. You may edit and rename these files. 
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HDR10+ Test Tab 

Please refer to HDR10+ CTS User Manual for detailed description of the tab. 

Adaptive-Sync Tab 

 

Select Generate to generate custom Adaptive-Sync scenarios. Custom Scenario Generator window 

will open. 

 

First you are asked to select the folder where the generated content will be stored. 

 

Click Browse… to select the folder. 

 

Adaptive-Sync settings 

In the Adaptive-Sync section you can set the transition and scenario duration parameters. Different 

transition types are Fixed frame rate, Min and max and Gradual.  
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When fixed frame rate is selected, the scenario is played at the minimum frame rate set in the first 

field. In scenario duration, select how many times frame is repeated. 

 

When min and max is selected, the output scenario will alter the framerate between the two values 

set in the drop down menus. You can also set the duration for step in seconds and select how many 

times frames are repeated. 

 

When gradual is selected, the frame rate is changed with each frame. For example, when min frame 

rate is set at 20 and max is set at 60 and the scenario has 40 frames, frame rate would be incremented 

by 1 with each frame. 

Info at the bottom of the segment shows the minimum and maximum values for VRR framerate defined 

in EDID, and the base frame rate set in the pattern generator. 

 

 

Video 

 

The section at the bottom shows details of the output video. The default pattern is a spinner. You can 

select the speed of the spinner video from the predefined options in the drop-down menu or you can 

set a number of frames it takes for the spinner to rotate a full circle. You can also select a custom 

video. The supported file types are .jpg, .png, .gif, .bmp, .tiff, .ppm and .tif 

Available memory is shown in bytes and frames. Below, the folder selected for the sequence is shown. 

You can change the folder by clickin Browse… Lastly, the duration of the sequence is shown in 

frames. 
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You can export the scenario by clicking Export. When exporting, you are asked to select a location 

for the export. The content folder will be automatically created in the chosen location. The folder 

inlcudes the image files, packets and scenario parameters. 

You can play the scenario by clickin Play. When the scenario starts playing, the scenario generator 

window will close. You can now inspect the progress in the log in the palyback tab as shown below. 

 

Audio Generator Tab 
Audio generator allows the user to play LPCM audio generated internally or from files in WAV format.  

To load internally generated audio, select Generate audio, and adjust the controls to the desired audio 

format. 

 

 

To load an audio file from your PC, select Load Audio from File, click the Open WAV file… button, 

browse and select the file and Open. 

The Compressed checkbox indicates that the audio loaded from the selected file is compressed. 

To play the selected audio content, click the Play button. 

The content will be repeated until the Stop button is clicked.  

Audio Status displays current audio content status.  
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Audio Content 

Audio transmission can be internally generated or loaded from a *.wav file. 

For *.wav files, file parameters will be used. When generating audio internally, set the details of the 

LPCM Audio signal: 

Waveform Selection of audio waveform: Sine, Sawtooth, Square, or Incremental. 

Signal Frequency Audio signal frequency in Hz. 

Sample Rate (Hz) Audio sampling rate: 32000, 44100 (default), 48000, 88200, 96000, 

176400, 192000. 

Bits/Sample Sample bit depth: 16, 20, 24. 

Amplitude(%) Audio amplitude: 10%, 20%, …, 90%, 100%. 

Channels Audio channels: 1, 2, …, 7, 8. 

LPCM (uncompressed) audio is used. 

 

  



  Generator Operation 

UCD-5XX User Manual • UCD Console 3.8 95 

HDCP Tab 
HDCP tab is the dialog for monitoring the HDCP (for High-Bandwith Digital Content Protection) status 

and controlling the HDCP capabilities of the UCD device. 

Note: Please note that HDCP 1.3 is not supported in 3.8 release. 

 

Status General 

The status fields indicate the HDCP status of the UCD device. 

Active: The stream between UCD and the downstream sink has been encrypted. 

Authenticated: HDCP handshake between the UCD and the sink unit has been completed 

successfully. 

Keys loaded: HDCP keys are loaded to the UCD unit. 

Km is stored: Master Key (Km) is stored. 

SST Mode Type Type when in SST mode and in Link mode 8b/10b. 

Status By stream 

Stream status shows HDCP status on each stream. 

Configuration Control 

Enable encryption: Check to enable the encryption of the stream between UCD and the 

downstream sink. 

Authenticate: Perform the HDCP initiation handshake between the UCD and the sink unit. 

Use stored Km: Use stored Master key (Km) 

Configuration type 

Select to configure HDCP for All streams at once or By stream. 
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By stream 

Select and configure  streams.  

Type Value (All streams) 

Select Type 0 or Type 1. Type 1 ensures that content encryption is done with HDCP version 2.2 or 

higher. 

Configuration Keys 

Select Production or Facsimile HDCP keys. To remove the keys, select None.  
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EDID/DisplayID Tab 
The EDID/DisplayID Tab provides tools for accessing the EDID/DisplayID data of the connected sink 

device. 

There are three basic functions: 

• Load and save the data files on the host PC. 

• Edit data contents either in Editor Mode or in Hex Edit Mode. 

• Read and write data to the connected sink. Up to 4 virtual channels can be accessed. 

EDID/DisplayID Files 

With Load… and Save As… a file can be read into the editor or written to a file from the PC.  
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At the top the DisplayID tab dialog are radio buttons to control how DisplayID data is read: Disabled, 

Try DisplayID, else EDID, and Read both DisplayID and EDID.  These have no effect when downloading 

from the sink unless the sink supports DisplayID protocol. 

The contents of the device EDID/DisplayID file are not modified, or their integrity checked during load 

and save operations. 

Note: Four blocks (512 bytes) of EDID code are read. If the device does not support all four blocks, the 

non-supported data values are set to zero. 

In the Editor Panes (upper right pane), the Text EDID and Text DisplayID tabs allow viewing data in 

tree form. 

EDID/DisplayID Editor 

Please see the description of the EDID editor in Chapter EDID/DisplayID Editor later in this document. 
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DPCD Tab 
DPCD tab is a tool for monitoring and editing the DPCD registers of the connected DisplayPort or 

DisplayPort Alt Mode Sink. 

The DPCD Decoder panels on the right show the interpretation of the DPCD byte selected on the 

monitoring windows. The selected byte is shown with a green background.  

Save: Select DPCD content to a binary DPCD Data file (*.DPD). 

Load: Select previously saved binary DPCD Data file (*.DPD). 

Report: Save parsed content of selected DPCD register ranges as HTML file 

Refresh: Re-read the data from the DPCD registers to the window in question 

Write Changes Write the portion of data shown in the window in question to the DPCD registers. 

Set Reference Store currently shown data as a reference for comparison 

 

When the data is Refreshed from the DPCD registers the changed bytes will be highlighted with blue 

color. The fields edited by the user will be highlighted with red color. 
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SDP Tab 
SDP CRC16 signature generation is an optional feature in the standard. A 128b/132b DP-capable DP 

Source device that supports SDP CRC16 shall generate an SDP CRC16 signature and place it in the 

SDP. 

 

The CRC 16 (128b/132b) checkbox enables SDP CRC16. 

The SDP CRC16 Error Generator groupbox is for selecting streams and type for injection. 

The SDP Type edit control determines the type of SDP that gets the signature. 

The IgnoreType checkbox is for any type. 

Selecting Generate will inject the signature into the next SDP of the selected type. 

The Split SDP checkbox allows SDP to be split into non-contiguous data packets. 
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FEC Tab 
Forward Error Correction (FEC) can be enabled if connected sink supports it. For debugging 

purposes, error injection to main link is possible. There is an error type for each standard sink DPCD 

error counter.  

Enable FEC UCD will verify if connected sink supports FEC and begins the 

handshake for enabling FEC. Only available with 8b/10b link coding. 

Disable FEC UCD will start the FEC disable handshake. Only available with 8b/10b 

link coding. 

Prefer FEC Enabled If selected, and the connected sink supports FEC, UCD will start the 

FEC Enable Sequence after a successful connection. Only available with 

8b/10b link coding. 

 

Error Generator 8b/10b Link Coding 

Selections will set how many errors will be inserted into one FEC block, and to which link symbols. 

There are five options: 

Uncorrected block 3 symbol errors with 3 error bits together 

Corrected block 2 symbol errors with 2 error bits together 

Corrected parity 2 parity byte errors with 2 error bits together 

Corrected block 1 error 1 symbol error with 1 error bit together 

Corrected parity 1 error 1 parity byte error with 1 error bit together 

Note:  FEC must be enabled and running before errors can be added. 

Link training will reset sink FEC error counters. 
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Error Generator 128b/132b Link Coding 

Selections will set how many errors will be inserted into one FEC block, and to which link symbols. 

There are five options: 

Uncorrected block 3 symbol errors with 3 error bits together 

Corrected block 4 errors 2 symbol errors with 4 error bits together 

Corrected block 2 errors 1 symbol errors with 2 error bits together 

 

Each lane can have its individual error amount. Errors can be injected to even and odd decoders by 

using Lane #0 and Lane #1 counters when link is configured to one lane. 

Apply Start error injection 

Enable aggregated errors Enables FPGA logic that can calculate FEC errors sum across all 

active lanes.  

Update Read sink DPCD FEC error counter registers 

Clear counters Clear sink DPCD FEC error counter registers 

 

 

 

 

Note: When using 128b/132b link coding the errors are inserted to Pre-coded RS block right after PHY 

Sync symbol (Pls see the illustration above). Because of this, on the RX side the number of bit errors 

will differ from the errors that are inserted on TX side, since pre-coding removal is XOR of the 

previous bit with the current bit. 

 

  

FEC Error 

Generation 

DPTX PHY Logical Sublayer 

FEC Encoding Pre-Coding 

DPRX PHY Logical Sublayer 

Removal of 

Pre-coding 
FEC Decoding 
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Panel Replay Tab 
 

 

Current Pattern Capabilites 

Current Pattern Capabilities panel displays what features are supported. Selecting different patterns 

in the Pattern Generator will affect supported features shown here. For example Patter Generator 

pattern Color Bars will disable Early Transport capability wheras Color Squares will enable it. 

Command 

Command panel has the following functions (reflected in the Status panel below it): 

Disable Disable Panel Replay. 

Inactive mode Set mode to inactive. 

Active mode Set mode to active. 

Full-screen update Transmit Full-screen update. 

Selective update Transmit selective update (shown in Command Status and History). 

 

Status 

Status panel reflects the Command Status, Status and Error. 

Command Status will show Selective update when Active mode and Selective update buttons have 

been selected (see above); otherwise it will display No command. 

Status will show state: Disable, Inactive mode or Active mode. 

Error will show  No error, Incorrect command or an error message. 
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History 

History panel displays results from applying commands in the command panel (see above). 

Configuration  

Configuration panel allows users to configure Panel Replay behavior. 

The  Mode combo box allows mode selection: PR, PSR1, PSR2. 

Configuration checkboxes available are: 

• Early transport: can be set when  supported in Current Pattern Capabilities  

• HPD_IRQ on missing AS SDP 

• HPD_IRQ on uncorrectable VSC SDP error 

• Enable CRC check 

• HPD_IRQ on RFB storage error 

• HPD_IRQ on actaive frame CRC error 

• Main-link remains ON during PSR1/PSR2 

• Self refresh unlock 

• SU extended Y granularity 

• Frame Capture 

• SU:Region scan line capture 

 

The available parameters for Frame1 and Frame 2 for Region 1 and Region 2 are: 

X coordinate X coordinate of region 

Y coordinate Y coordinate of region 

Width Width of region 

Height Height of region 

 

These are the transmitted blocks sent when command Selective update is pressed (see above). 

Apply button is used to set the Configuration panel state. 
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ALPM Tab 

 

 

Link Status panel shows current ALPM status. 

Link Control panel is for enabling ALPM and for setting ALPM state. Note that ALPM is only available 

in 8b/10b SST mode. 

Power-off entering offers two modes via radio buttons ML_PHY_SLEEP and ML_PHY_STANDBY.  

Additional sequences and PHY hold pattern length, symbols can be set via the combo boxes. 

Power-off exiting offers two methods via the AUX-less and AUX_wake radio buttons. Parameters for 

each can be set via the widgets in the respective groups. 

If the AUX_wake method is selected and AUX_PHY_WAKE_ACK is checked and the sink does not 

respond with AUX_PHY_WAKE_ACK, the Errors group  AUX_PHY_WAKE_ACK not received indicator 

will be lit. 

ML_PHY_LOCK_1  and ML_PHY_LOCK_2 times may be set along with their patterns: TPS1 – TPS4. 

ML_PHY_LOCK_2 is available if TPS1 is selected for ML_PHY_LOCK_1. 
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Sink DUT Testing Tab 
Refer to Appendix E for descriptions of the tests available. The tests are presented in a split view, the  

left being test categories and the right being the tests within. 

 

Select the tests for execution by checking checkboxes or by clicking the test name. All tests item on  

the left hand side is really just for viewing all tests available. Select the desired test category (ex. DP 

1 .4 LL CTS) when running tests. 

Run/Run 

Checked: 

Select to start selected/checked tests. Once tests are running the Run Checked 

button is relabeled Abort to stop the test sequence if desired. 

Select: Includes three sets of options: Select All, Clear All, Invert All for changing the tests 

current selections; Save (checked items), Load (and check relevant items), Remove 

(named tests list) for handling named templates; Import (check all items contained in 

file) and Export (save all checked items to file) for loading and saving file-based 

templates. Do not confuse Import and Export with those below: These are for setting 

and saving tests to run. 

Configure: Opens a test parameters dialog for the selected test set. Make sure a test category 

other than All tests is selected. Refer to Test Parameters below for details. 

Import: Load saved test parameter files (*.td or *.json) for into UCD Console. Select 

Configure to see current parameters.  Loading *.td files to UCD Console is currently 

unreliable. 

Export: Save test parameters for later use or for use in test automation. For saving 

parameters for later use in UCD Console, either format can be used. For saving 

parameters for TSI scripting, please use *.td files. For use with Python applications, 

use *.json files. 

Stop on Failure: Stops execution of tests if one fails.  

Repeats: Number of times to repeat the selected test sequence. 

Delay time: Delay in seconds between individual tests. 
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On completion of each test the result of the test is displayed in the table columns on the right. For 

each test the table lists the number Pass, Fail, Skips, Runs and Last Status (status of last run). 

Save Report: Select to generate a HTML report file. This will also open a tab in the default 

browser and display the results. 

Clear Selected Clear the test results of the selected (not checked) tests results. A 

subsequently saved report will not include these test results. 

Clear All: Clear the test log view and the outstanding results. 
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Test Parameters 

Each test set has its dedicated set of test parameters. To open a dialog for defining the parameters 

click Configure. 

Description of parameters for each test set can be found within the description of tests in Appendix E 

of this document. 

Saving Test Parameters 

Test parameters can be saved in various ways. 

• Export parameters in Sink DUT Testing tab to a *.td file for later use in UCD Console, to run TSI 

scripts, or to share test parameters with someone. Presently importing *.td files into UCD Console 

is unreliable. 

• Export parameters in Sink DUT Testing tab to a *.json file for later use in UCD Console, to run 

Python scripts, or to load test parameters into UCD Console. 

• Save parameters in Configure dialog as Presets later to be used in UCD Console. See description 

below. 

Presets 

All Configure dialogs selected parameters can be saved and loaded via Presets dropdown menu. 

Select Save or Load for named internal configuration parameter sets. Select Remove to delete a 

named internal set. Select Import and Export for loading and saving parameter sets from and to  

external files. Note that importing and Exporting *.json files here have a different format than importing 

those described above. 
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Adaptive-Sync Tab 
Adaptive-Sync feature is available for Stream 0. 

 

 

Auto enabled if supported by Sink: The feature is enabled based on connected Sink status 

Disabled: Feature is disabled unless Auto Enabled … box is 

checked. Please see the note below. 

Adaptive Total, constant refresh rate: Added blank lines 

Adaptive Total, Square pattern: Added blank lines, min; Added blank lines, max; Period, 

frames. 

Adaptive VTotal, Zigzag pattern: Added blank lines, min; Added blank lines, max; Increase, 

lines; Decrease, lines. 

Fixed Average VTotal: Target refresh rate, Hz; Increase, lines; Decrease, lines 

Note: Please note that in case Auto enabled if supported by Sink is selected and the connected Sink device 

supports Adaptive-Sync, but the selected mode is Disabled, then Adaptive-Sync is enabled in mode 

“Adaptive Total, constant refresh rate” with 0 (zero) added blank lines. Control dialog will be updated 

to indicate the status. 
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Cable Info Tab 
Cable properties for DP TX and USB-C TX are shown below. 

Some information may not be available for older front ends. 

 

DPTX / DPRX Cable Info 

UHBR Capabilities: DP UHBR capabilities of the connected cable. 

UHBR 13.5 Capable: DP UHBR 13.5 capable. 

Cable Type Type of the cable. 

 

USB-C Cable Info 

Displays the information received from cable in response to Discover Identity command sent to SOP’. 

Cable Information 

For DP connection, Cable information panel shows if the connected cables are D80 / DP40 capable. 

 

 

Note: For USC-C, Cable info can only be read when in Down Facing Port role.  

Select Refresh after changing roles 
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PDC Tab 

When USB-C DP Alt Mode Reference Source role is in use, the following interface specific tabs are 

available. 

The PDC Tab for TX is almost identical to PDC Tab for RX (see PDC Tab). 
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 LINK TIMELINE VIEWER 
Link Timeline Viewer is a tool for studying streamed data and timing for data captured with Link Analyzer. 

• Link Timeline Viewer main panel contains three tabs (for three modes):   

• FrameView tab is the primary tab for analyzing captured events on the timeline. 

• Reports tab can be used to summarize events (AUX at present). 

• Images tab lets the user view captured video frame images. 

 

The FrameView tab and its views are shown below. 
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Wave Form View zoomed out and zoomed in views are shown below. Event periods are shown under the 

timeline (at the top) in their proper row as period rectangles with text descriptions (or abbreviations or no text, 

space permitting). Double-clicking a period rectangle will highlight the timeline portion of the rectangle and 

the row header(s). To zoom the Wave Form View, position the cursor and use the mouse wheel to zoom in or 

out with respect to the cursor location. Drag to scroll the Wave Form View and the Symbols View horizontally. 
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A splitter cursor appears when hovering between the Wave Form View and the Symbols View when all content 

cannot be displayed (typical with MST streams). Drag the splitter cursor to view hidden rows (see image 

below). Removing rows via the gear icon may also help. 

 

 

Wave Form and Symbol View Settings 
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Gear Icon 

 

The gear icon under the scroll bar allows users to select which events are shown in Wave Form and 

Symbol View. Click the red circle to remove events.  

 

You can select which VBID bits are shown by clicking the pen tool. 
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Save Icon 

 

By clicking the Save icon you can save, load and remove settings selected with the gear icon. You 

can also import and export .json files and reset settings to default. 

 

Zooming 

 

You can zoom in/out with the magnifying glass icons. The zooming in/out option applies to Wave 

Form View only. 

Scrolling 

 

You can use the arrow keys to move in the timeline. One arrow moves the timeline one interval, two 

arros move it 10 intervals and three arrows move it 100 intervals. 

Alternatively, you can scroll by clicking, holding and dragging.  

Clock icon 

 

With the clock icon you can move to a time point. Enter the values and press OK. 

 

Eraser 

 

The eraser icon deletes all made measurements on the timeline. 

Move to Previous or Next Interval 

Move back interval and Move next interva 

 

l 
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Sync Data 

Sync data for views. 

 

   Not synchronized.     Synchronized. 
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FrameView Tab 

FrameView tab consists of five areas (views) shown below. 

Event Selector View 

Event Details View 

Wave Form View 

Symbols View 

Frame Image View 

Each of these areas will be described in detail. These views are sycnchronized and actions in one view will 

affect presentations in others. 
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Event Selector View  

Main Link Events Tab 

Event Selector View events are presented as a folding list of Lane Events and FRAMEs. Each FRAME 

contains a set of BLANK LINEs followed by a set of ACTIVE LINEs. Select items in Main Link Events 

tab to locate items of interest and focus the Wave Form View and the Symbol View. 

 

The timing format used in Timeline Viewer consists of two timings based on time and bits. 

The time format is shown as follows:  

seconds:milliseconds.microseconds.nanoseconds.picoseconds 

The timing format is demonstrated in the image below where you can see the time format on top and 

the bit format under it with a smaller grey font. 
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When selecting a Frame, a Line, an Event, or a Symbol, both Wave Form View and Symbols View are 

focused, and the time stamp of the item is highlighted as shown below. 

 

Event Selector timing column details are: 

Type: Type of item. FRAME, LINE, or name of Event 

Id: Event’s occurrence number 

Position: Start of the event from start of the captured data 

Duration: Duration of the event 

End: End of the event from start of the captured data 
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Under Main Link Events, there are two types of event categories (for an SST link): Lane events and 

SST/MST Stream(s). 

  

Lane events shows events such as SST, TPS1, TPS3 and TPS4 for each lane.  

Find all the captured frames under SST Stream (or MST Streams). Selecting a Frame in the Event 

Selector, highlights it and focuses the Wave Form View and the Symbols View as seen below. Event 

details are shown in Event Details View in the lower left corner. 
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MST mode streams are shown below. Select a stream to focus it (sync with other views). All aspects 

are as for SST mode described above. 

 

Search 

You can search events by typing in the Search bar and pressing enter. Events are highlighted and 

selected in the Wave Form View and the Symbols View. 
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Aa  Toogle case sensitive or not. 

RExp Use regular expressions. 

 

                            Click the enter icon to apply filters. 

 

Click Find Prev and Find Next icons to navigate. Instance 2 out of 77 is selected. 

 

The gear icon opens Configure search window. In addition to settings described above, you can select 

which colums are shown in Main Link Events window. 

 

Symbols Tab 

Symbols view lists all the PHY level events found in the capture made. Where Main Link Events is 

structured as a tree, Symbols view is presented as a list of symbols. Search and filter as explained 

above. 

 

Type: Type of item. 

Id: Event’s occurrence number 

Position: Start of the event from start of captured data 

Lane: The main link lane for Symbol 

Value:  
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Event Details View 
The event details are shown in the window in the lower left corner. The event details consists of two tabs: 

Details tab and Image tab. 

Details Tab 

The information shown in the Details tab is context dependant. 

Frame details are shown below. 

For example, in the image below we can see that the line is part of blanking as the value for  

 

VerticalBlanking details are shown below. VerticalBlanking is set as TRUE. AudioMute is set as FALSE 

so audio is being transferred. 
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MSA frame data is shown below. 

 

 

SDP events contain several different kinds of events all with individual details. An audio stamp event 

is shown below.  
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Events such as BS, VBID and MVID will be shown under [PHY _SYMBOL] title. A VBID event is shown 

below. 

 

 

PHY Area events shows TPS events. In the image below you can see a TPS1 event and its start, end 

and duration. 

 

 

Image Tab 

Image tab shows the frame captured with active area. Please note that Images are shown only shown 

when a frame is selected. 
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Wave Forms View 
Wave Forms View consists of two tabs: Wave Forms and Spatial View. Image for SST mode. 

Wave Forms Tab 

AUX: Events of the AUX channel. 

Link: Link state (TPS1, TPS2, TPS3, TPS4, SST, MST etc.) 

Lines: Frame and line number 

VBID: Location of VBID events 

MSA/SDP: Location of MSA and SDP events 

Symbols: Control and special symbols 

Lanes (0-3): Decoded data and control symbols 

  

The scroll bar on the top of the panels shows all captured frames of the bulk. As no triggers were set 

on the example capture shown in the image below, the first frame is not captured fully. Please, note 

that this view cannot be zoomed in.  

 

You can select a frame by double-clicking on it. After a frame is selected, it turns into light purple 

(shown in SST mode) and Wave Form View will be focused to view this frame. 
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When you hover the cursor over the timeline, the timestamp of that position on the timeline is shown 

as illustrated in the image (shown in SST mode) below. 

 

When you hover over an event in Wave Form View, a popup shows details of the event. 
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When doble-clicking on timeline or within the perimeters of Wave Forms View, Symbol View is 

focused, and the event is selected in Event Selector View as shown below. The green vertical line in 

Wave Form View positions the event. 

 

 

Double clicking on a frame in Wave Form View focuses areas as seen below. 
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The ruler tool allows users to measure the distance between two points on the timeline. When you 

right click on the timeline, a point willl appear. Right click again on the timeline and the distance 

between the two points will be shown as illustarted below. 

 

 

Various zoom levels are described: 

Zoom in a bit and the area shown in Wave Form View is highlighted with light green color. 

 

Zoom in more and the frames shown in Wave Form View, are highlighted in green in the scroll bar. 
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Zooming in further, Wave Form View shows the events as small vertical lines. When zooming inon a 

certain event, make sure to keep the cursor on top of the event you are interested in. 

 

 

Zooming in further, the area shown in Symbols View is highlighted in Wave Form View with green 

color. 

 

The image below shows a view of one frame in Wave Form View when zoomed in on a frame level. 

You can see the blank area and active in this view.  
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Zooming in closer, you begin to see the Frame line numbers (L560 for ex.) in the Lines row.  

 

 

The lines shown in Wave Form View are symbols that match those shown in Symbols View. When 

you zoom in close enough, you can see the symbols in both views as shown below. 

 

Spatial View Tab 

Spatial view shows the geometry of the frame. 
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If you select a frame in Event Selector the frame will be shown in Spatial View as shown in the image 

below. 

 

If you double-click on the timeline, the line on that time stamp will be selected in the Event Selector 

View as illustrated in the image below. 

 

When you hover a cursor on top of the frame, frame details will be shown. Frame details include the 

start, end and duration of the frame. 
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When you hover your mouse over an event shown next the frame, details of that event will be show 

in a popup window. If you double-click on the event, it will be selected in the Event Selector and its 

details will be shown in the Event Details. 
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Symbols View 
In addition to Wave Form View, Symbols View (shown in SST mode) shows symbols from the PHY 

lanes. Identically to Wave Form View you can scroll the Symbols View by clicking it, holding and 

dragging or by using the arrow keys. 

AUX: Events of the AUX channel. 

Link: Link state (TPS1, TPS2, TPS3, TPS4, SST, MST etc.) 

Lines: Frame and line number 

MSA/SDP: Location of MSA and SDP events 

Symbols: Control and special symbols 

Lanes (0-3): Decoded data and control symbols 

PHY Lanes (0-3): Binary bit stream, 10b/8b scrambled symbols, symbol code and 

descrambled values 

  

 

Link Symbols 

 

The lower part of the Symbol View (shown in SST mode) describes the distribution of link symbols in 

the physical link lanes. You can see the individual bits above the symbol blocks. When you mouse 

hover  over a symbol, a popup shows details of the selected symbol. Details include: 

10b symbol: Link symbol as sent (in this case 8b/10b link coding) 

8b symbol: Link symbol after conversion to 8 bits 

Symbol code: Link symbol K or D code 

Descrambled: Link symbol value after de-scrambling 

Start: Start of the item from start of the captured data 

End: End of the item from start of the captured data  

Duration: Length of the symbols 

 

  



  Link Timeline Viewer 

UCD-5XX User Manual • UCD Console 3.8 140 

For clarity, the position of control symbols and and payload of link events is marked with a gray bar 

on top of the corresponding link symbols. Shown in SST mode. 

 

 

Each individual block contains the following information 

First row: 10b/8b link symbol in HEX format 

Second row: Link symbol K or D code. K symbols are highlighted with red color. 

Third row: Descrambled value if available 

 

Scrambling 

You can see the result of scrambling in Symbols View (shown in SST mode). As you can see in the 

image below, all blocks have value of 00. However, the first row of each block reads a different 10b/8b 

link symbols. 

 

Forward Error Correction (FEC) 

FEC parity codes are highlighted in Symbols View with a light green color. CD_ADJ symbols are 

highlighted with light red color. Image for SST mode. 
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SDP 

SDPs are highlighted with turquoise color. You can see the start of the SDP event marked as SS and 

the end of the SDP event marked as SE. Image for SST mode. 

  

Pixel data 

Grey area is fill symbols (scrambled 00). Light yellow area is actual pixels (surrounded by fill end 

symbol and fill start symbol). K30.7 is fill start and K23.7 is fill end. Image for SST mode. 

  

MSA 

MSA symbols are highlighted in purple color. Image for SST mode. 
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VBID 

The Event Details will show information of what the line will contain. In the image below you can see 

that the line is vertical blanking without pixel data. Image for SST mode. 

 

TPS Events 

The image below shows how the events are shown for each lane in Event Selector, Symbol View and 

Event details. The image below shows a TPS1 event. Image for SST mode. 

 

The image below illustrates the transition from TPS1 to TPS4. Image for SST mode. 
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Images Tab 

Video frames decoded from Main Link Data Capture can be previewed in Images tab. Frames are 

listed on the left-hand side of the window. Each frame has two lines. The first line shows the frame 

with its active area only. 

 

The second line is a structure frame, which shows total and active area. 
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Frame Image View 

 

Frame Image View can be used to select Frames and MSA events in related views. As shown below 

selecting the MSA event in Frame Image View also selects it in Event Selector View and synchronizes 

the other views. Hovering over the Active0 area will show the frame geometry details, Stream combo 

box allows selection of streams for MST. Simple view checkbox presents a simplified view (does not 

work at present). 
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 EVENT TIMELINE VIEWER 
Event Timeline Viewer is an application for inspecting data captured in capture and event log tabs.  

Event Timeline Viewer consists of four areas. 

1. Frame View 

2. Event View 

3. Event Log 

4. Details / Image 

 

Frame View 

 

The uppermost panel shwos the captured frames. The selected frame is highlighted in purple. You can select a 

frame by double-clickin it. The area highlighted in green indicates the area shown in the Events view. Please, note 

that you cannot zoom in or out in the frame view. 

Event View 

 

The view below shows all frames and events selected in the capture tab. The are highlighted in green in frame view 

indicates the are shown in events view. 

  

1 

2 

3 

4 
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Tools 

Tool Function 

 Gear Icon Hide / add events on the timeline 

 Save Icon 
Save, load, remove, import, export and 

remove presets 

 Magnifying Glass Icons Zoom in/out on the timeline 

 Arrow Icons 

Move on the timeline. More arrows moves 

the timeline more. You can also move by 

clicking and dragging on the timeline. 

 Move to a time point 

Move to a certain time point on the timeline 

by double clickin on the timeline. The 

selected event is highlighted in the event 

log. By right clicking on the timeline and 

right clicking again you can measure 

distance between two time points. 

 Erase all rulers Erase all measurements made. 

 

Zooming on the timeline

 

Went the timeline is zoomed out, you can see events as grey lines. When you zoom in you can see 

the event block. You can zoom in either with the magnifying glass icons or by scrolling with your 

mouse. 

 

When you double click on event or frame, the correseponding event or frame is selected in the event 

log and highlighted in purple. 
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Event Log 

 

Event log shows all captured events and frames. The following info is presented in the table: 

Type Function 

ID Number of captured frame 

Start Start of the event 

Duration Duration of the event 

End End of the event 

Info Additional information about the event. 

 

Event Log Tools 

 Search  
Search events from the event log. Search 

results are highlighted in purple. 

 Apply search filters Apply filters. 

 Search filters 
Aa filter: Make search case sensitive 

RExp: Use regular expressions in search 

 Search results 

Shows search results. Move from one 

search result to another by clicking the 

arrows. 

 Configure 
Selec which columns are shown in event 

log. 

 



  Event Timeline Viewer 

UCD-5XX User Manual • UCD Console 3.8 149 

Details / Image 

 

Details tab shows details of the selected event. When the selected event is a frame, the image tab 

shows the captured frame. 
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 EVENT LOG 
Event Log dialog is divided into two panels: the left panel lists all transactions, and the right panel 

shows the parsed transaction data for the line selected in the list on the left. 

 

Role Logged Events 

DP Sink  

DP Alt Mode Sink  

HPD, AUX, SDP, VB-ID, MSA, Link Pattern, AUX_BW 

DP Source  

DP Alt Mode Source  

HPD, AUX 

DP Alt Mode Sink 

DP Alt Mode Source 

PD, LSE 

 

Start: Starts event logging and stop it by clicking Stop. 

Save: Save transactions as Event Log data as binary or as CSV 

Load: Load saved Event Log data 

Report: Store event logs as reports in HTML format to be shared and viewed 

with any web browser. 

Open Timeline Viewer Open Event Timeline Viewer to inspect the captured data. Refer to 

chapter seven of this manual for detailed instructions. 

AutoScroll: When selected, the transaction list is automatically scrolled vertically, 

and the latest transaction is shown as the last item of the list. When not 

selected, the items shown before clicking Start will be shown. 

Events: Number of events detected 

Colors: Open configure colors dialog 

Clear: Click to clear transaction list. When Clear on Start is selected, the list is 

cleared when clicking Start. 
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Selecting Logged Events  

HPD 

Status and status changes of Hot Plug Detect (HPD) signal, power detection status and cable 

connection status. HPD Trace, HPD De-assert to HPD Assert interval. 

AUX 

Log DP AUX Channel transactions and Sideband Messaging. 

SDP 

Log DP Secondary-data Packets. Click the button to open the Event Filter Dialog. The dialog 

enables the filtering of SDP packets. In the dialog, the reference to Packet Type Value is indicated in 

square brackets “[ ]”. 

VB-ID 

Log Vertical Blanking ID packets sent in DP stream. Click the button to open the Event Filter Dialog. 

The dialog enables definition of which events will be logged.   
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MSA 

Log Main Stream Attributes sent in DP stream. Click the button to open the Event Filter Dialog. The 

dialog enables logging of all MSA packets and the changes on the selected parameter.  

VFRAME INFO 

Dimensions of the catured frame measured by the Sink  

PD 

Log USB-C PD communication messages 

LSE 

Low Speed Electrical logger captures the Voltage and Current on the low-speed lanes of the  

USB-C connector including CC, VBUS, VCONN, and SBU. 

Event Filter Dialog sets the threshold values for capturing the changes. Parsed transaction data shows 

the captured data with indication of the changed values. 

AUX_BW 

Log AUX_Bitwise transactions as a series of Manchester II codes. 

Link Pattern 

Click the button to open the Event Filter Dialog. 

Log link patterns. Event filter dialog sets the type of link patterns that will be captured.  

Custom Pattern (80 bit) is a sequence that either splits into 10 bytes or 8b/10b encoded symbols. For 

10b symbols, either K/D odes or hex values must be provided. For bytes, hex values must be provided.
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Event Transaction List 
Transaction data in Transaction List is ordered in columns. Each column provides additional 

Information. 

You can search events by typing its name in the Search bar and pressing enter or selecting the Search 

button. Pressing F3 (Ctrl+G on macos) takes you to the next found and Shift+F3 (Shift+Ctrl+G on 

macOS) takes you to the previous found. 

 

 

Source: The communication port: DP RX to DP TX 

Type The logged item: HPD, AUX, SDP, VB-ID, MSA, Link Pattern, AUX_BW, 

VFRAME INFO 

Start: Each line is identified by its timestamp, marking the instant when an event 

or error was detected, or when a data transaction got started.  

The timestamp can be displayed as a time delay from the start of the 

acquisition (absolute) or from the previous line (relative).  

The timestamp can be displayed in milliseconds or in minutes, seconds, 

and microseconds. 

Info This column provides a short description of the message content 

 

When hovering the mouse over the transaction list, a mouse-over window will open. It provides a brief 

list of the content in the transaction under the mouse. 
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Customizing Transaction List 
User Can change what data is shown in the transaction list by adding and removing columns or 

limiting the transaction types in the list. Users can also color highlight various types of transactions 

for better readability. 

Right-click on the list to open the menu. 

Configure Start 

The time indicated in column Start can be either: 

• Time from start of logging. 

• Time from previous reboot. 

• Time from previous event. 

The time can be expressed either: 

• In microseconds (1/1 000 000 Second). 

• Hours : minutes : seconds . milliseconds . microseconds . nanoseconds. 

Configure Colors 

Configure colors dialog allows the user to highlight various types of transactions in the list by changing 

character color and background color of the transaction line. 

Add: Add a new color highlight rule 

Config: Modify the selected rule 

Remove: Delete the selected rule 

Clone: Duplicate the selected rule 

▲: Change the order where rules are applied.  

The rules are applied from the bottom to the top of the list. 
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Adding Rules 

The color highlight rules are set by transaction type. The content of Add rules dialog is dependent on 

the type of item selected. 

Configure Columns 

In the dialog there are two columns: Available and Active. An item from the Available list can be 

included in the Active column by selecting it and clicking on the right arrow [>] in the middle of the 

two columns. 

The order of Active items can be changed by selecting an item and moving its position in the list with 

up ▲and down ▼ arrows. 

Type Filter 

Type filter dialog lists the types of transactions found in the list and allows the user to select which 

transaction lines are currently shown. 

Quick Filter 

By entering a DPCD address in the Quick Filter field on top of the transaction line, the user can limit 

the list to show only the reads or writes to this DPCD address. 
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Event Details 

HPD 

HPD transactions include the following statuses: 

HPD Level: Status of HPD signal: HIGH (Asserted), LOW (De-asserted) 

Power Level:  

(in DP RX) 

Status of source device detection: High (DP Tx detected),  

LOW (DP Tx not detected) 

Cable Detect Level: 

(in DP RX): 

Status of cable detection HIGH (Cable connection detected) LOW 

(Cable connection not detected) 

HPD Trace 

 HPD De-assert to HPD Assert interval. 

AUX 

Transaction list includes the following DP AUX Channel transactions. The parsed transactions panel 

provides details for each transaction. 

RD: Native AUX Request Transaction for read 

WR: Native AUX Request Transaction for write 

I2C RD: I2C-over-AUX Request Transaction for read 

I2C WR: I2C-over-AUX Request Transaction for write 

AUX_ACK: AUX Reply Transaction (Request accepted) 

AUX_NACK: AUX Reply Transaction (Request not accepted) 

AUX_DEFER: AUX Reply Transaction (Delayed, new request needed) 

Sideband REQ: Sideband down request message (DOWN_REQ_MSG) 

Sideband REP: Sideband down reply message (DOWN_REP_MSG) 

EDID Trace: Accumulated EDID content from I2C or sideband down messages 

DisplayID: Accumulated DisplayID content from I2C or sideband down messages 

HDCP Trace 1.X or  

HDCP Trace 2.3: 

HDCP Transmitter and HDCP Receiver communicate DPCD values 

over AUX Channel. Transactions are listed as DPCD Address Range 

Traces where HDCP Port name is indicated. 
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Native AUX Transaction Example 

 Sideband Message Example 

HDCP Trace Example 
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SDP 

DP Secondary-data Packets.  

VB-ID 

Vertical Blanking ID packets sent in DP stream.  

 

MSA 

Main Stream Attributes sent in DP stream.  
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VFRAME INFO 

Measured dimensions of the captured video frame 

PD 

USB-C PD communication messages 

LSE 

Status of USB-C Low Speed Electrical signals 
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Link Pattern 

Status of link pattern detected in which lane. 

 

 

AUX_BW 

Status of captured binary Manchester II codes. The duration of the preamble and postamble will be 

presented.  
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 EDIDDISPLAYID EDITOR 

The EDID/DisplayID Editor main window is divided into three views. Command buttons are 

Additionally located in the bottom. The top left Navigation View selection focuses and highlights the 

Editor View (top-right) and Hex Editor View (bottom-right). The Editor View values may be edited 

when the Editor Mode checkbox is checked. Hex Editor View presents blocks as hex values and can 

be edited when the HEX Edit Mode checkbox is checked. 

 

 

Add Item Add a new EDID or DisplayID block. Available when in Editor Mode 

exclusivly. 

Remove Item Delete the selected EDID or DisplayID block. Available when in Editor 

Mode exclusivly. 

Filter Show only items having the filter string in their field name. 

Read mode Select EDID data reading mode: 

I2C (using I2C protocol) or SBM (MST mode only): virtual channels read 

via SBM protocol. 

Show Read Only Automatically generated non-editable fields are additionally shown. 

Recurse All subitems of the selected item are presented in Editor View. 

Virtual Sink #1 Dropdown labled with the currently selected virtual sink (MST). 
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 The buttons at the bottom of the dialog differ based on role: Analyser (Read fromTE and Write to TE) 

or Generator (Download from Sink and Upload to Sink). 

Read from TE (Analyzer): Read device local EDID/DisplayID blocks into editor. 

Write to TE (Analyzer): Write editor data to device local EDID/DisplayID blocks. 

Download from Sink (Generator): Read EDID/DisplayID blocks from connected sink device into 

editor. 

Upload to Sink (Generator): Write editor EDID/DisplayID blocks to connected sink device.  

See note below. 

Editor Mode: Enable editing EDID/DispslayID content in top right view. For 

example, for testing purposes, it’s possible to load invalid 

EDID/DisplayID data and write it to TE without modifications. 

Once Editor Mode is enabled, the validator corrects errors 

such as invalid checksums.  Top right view name-value pairs 

can be edited. 

HEX Edit Mode: Enable editing EDID/DisplayID content in bottom right HEX  

view. When enabled, HEX values may be edited. Click Apply 

to validate changes and update other views. 

Save As…: Save the current editor data to disk in various formats: 

binary, hex, ecd, txt and xml. 

Load …: Load EDID/DisplayID data from disk. Same formats as above 

available. 

Note: A source device is always able to read EDID data of the connected Sink device. A source device can 

read the DisplayID data of the sink device if the sink device permits. The connected sink device may 

or may not allow its EDID/DisplayID content to be modified. 
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Select the Main Features button to view items of common 

interest. For example, whether the sink is capable of HDR, or 

Dolby Vision, etc.  

 

 

 

The Main Features view CTA v3 tab (avalable only in EDID tab 

not DisplayID tab) allows enabling/disabling features. You 

enable/disable a feature by selecting the Value field with 

Editor Mode enabled  (AND HEX Edit Mode disabled). When a 

value is disabled and you want to enable it, the Editor View 

will be blank as focus has been set on the values to be 

enabled (and are zero when disabled). New highlighted hex 

values will be added and highlighted in the lower right Hex 

View. New node data will also appear under the CTA node in 

the top left tree view. 

 

 

 

EDID Editor Features 
A practically unlimited number of extension blocks may exist in a single collection. The number of 

blocks is limited by VESA Specifications and possibly by available system resources. Most 

EDID/DisplayID blocks contain a structure that is very similar to a tree structure. The Editor decodes 

each block into a tree view of the block. The tree view then contains all values within the data block. 

Contents can be browsed. The Editor has a support for automatic variables, such as the block 

checksum. When a value in a block is modified, the checksum will be updated. Automatic variables 

are read only. A log print will be made when an automatic variable is updated by the editor.  

Editing Tips 
Editing is straightforward: 

Select property fields to edit. 

Red values in HEX View show that values have been modified. 

Press Enter to apply edit values and combo box selections. 
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In CTA-861 blocks, you can add and remove 18-byte descriptors and CEA data blocks by 

setting the values “18-byte Descriptors in this block” and “CEA Data block count”.  

Enter hex values with prefixes “0x” or “$”.  No prefix represents a decimal value. 

Values may be entered as hexadecimal or decimal regardless of  presentation. 

Floating point values must have a period “.” decimal separator. 

Click Set after changing a bit-value presented as a single checkbox if you want the new value 

applied. 

Note: The Editor does not have an Undo function. Therefore, it is recommended that you back up unedited 

data to a file before editing. 
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 PACKET EDITOR 
Packet Editor enables creation and editing metadata packets. 

The types of supported packets are: 

• Audio InfoFrame (Audio) 

• AVI InfoFrame (AVI) 

• Custom InfoFrame (Custom) (HDMI) 

• Custom Packet (custom) (DP) 

• DR&M InfoFrame (DR&M) (HDMI) 

• DR&M Packet (DR&M) (DP) 

• EMP-VRR (EMP-VRR) 

• GCP InfoFrame (GCP) 

• SPD InfoFrame (SPD) 

• Vendor-Specific InfoFrame (VS) (HDMI)* 

• Vendor-Specific SDP (VS) (DP)* 

 

*) Please select from available VS packet types in field “4: Type” in the packet editor. 
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 PATTERN EDITOR 
Pattern Editor is a tool for editing and debugging Unigraf Custom VTP Pattern scripts. 

Please refer to APPENDIX F: VTP PATTERN LANGUAGE later in this document for description of the 

VTP Pattern Language syntax. 

Pattern Editor consists of three tabs: 

Image Tab 

Monitoring the rendering of the VTP pattern script. 

Source Tab 

Tool for editing VTP Pattern Language script. Click Apply to render the code in the resolution of the 

preview image in Image tab. 
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Logs Tab  

Log of the pattern code parsing indicating the values assigned to logical variables and the actual 

parameter values used for render instructions. 

Saving and Recalling the Script 

In File pull-down menu the user can save his work. 

Open: Open a VTP language script from PC 

Save Script: Save the script currently in Source tab to PC 

Save Image: Save a rendered pattern in PNG, BMP, JPG or PPM format 

Select Save Resolution: Select from six common resolutions the size in which the pattern script 

will be rendered when saved. 
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 IMAGE CONVERTER 
Image Converter is a tool for converting images from one color format to another. This kind of 

conversion is typically needed when creating YCbCr test images from RGB bitmaps. Open the image 

converter from UCD Console’s menu Tools > Image Converter. 

Click Upload files to load the Source image.  

 

 

Colorspace YCbCr, RGB 

Colorimetry ITU-R BT.601, ITU-R BT.709, ITU-R BT2020 

Sampling 4:4:4, 4:2:2, 4:2:0 

Bit depth 8, 10, 12, 16 

Align to MSB Store binary data aligned to the Most Significant Bit (MSB).  

When this is left unchecked the binary data is aligned to the Least 

Significant Bit (LSB). 

Change resolution Select a resolution for the destination image from the pre-defined list 

Covert All Convert all uploaded images to destination format and save them in the 

same folder as the source images. 

Covert All and save to 

the custom folder 

Convert all uploaded images to destination format and save to the 

selected folder. 

 

File name for the destination image is of form: 

Test image[1920x1080_yuv444_8bpc_BT601_Packed_YCbCr_LSB] 
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APPENDIX A: PRODUCT SPECIFICATION 

UCD-500 

Input 
DisplayPort: DP 2.0/2.1 capable (DP In) (10 Gbps link rate maximum) 

USB-C: PD 3.0 compliant (USB-C In) (20 Gbps link rate maximum) 

Output 
DisplayPort: DP 2.1 compliant (DP Out) (10 Gbps link rate maximum) 

USB-C: PD 3.0 compliant (USB-C Out) (20 Gbps link rate maximum) 

Max video mode 
7680 × 4320 p60 input and output. 

15360 × 8640 p60 input and output with DSC. 

Audio 
Source and receive LPCM, 2 – 8 channels, 44.1 to 192 kHz. 

Source compressed formats using TSI 

Content Protection HDCP 2.3 supported 

DSC Capability 
DSC sink, with off-line decompression 

DSC source using pre-compressed content 

Additional features Playback function 

Computer interface USB 3.0 

Operating System 

Debian 11.0 or higher. 

Ubuntu 20.04.4 LTS or higher. 

MacOS Big Sur 11.7.10 or higher. 

Windows 10 10.0.19045 or higher. 

Power supply 
AC/DC Power supply 

(100 to 240 Vac 50/60 Hz input, +24 Vdc output) 

Environmental 

Operating temperature: 15 to 35 deg C 

Storage temperature: 0 to 50 deg C 

Humidity 30% to 70% RH, non-condensing 

Mechanical Size 331 mm x 197 mm x 66 mm 

Weight 1.9kg 

UCD-500 Gen2 

Input 
DisplayPort: DP 2.1 compliant (DP In) (20 Gbps link rate) 

USB-C: PD 3.0 compliant (USB-C In) (20 Gbps link rate) 

Output 
DisplayPort: DP 2.1 compliant (DP Out) (20 Gbps link rate) 

USB-C: PD 3.0 compliant (USB-C Out) (20 Gbps link rate) 

Max video mode 
7680 × 4320 p60 input and output. 

15360 × 8640 p60 input and output with DSC 

Audio 
Source and receive LPCM, 2 – 8 channels, 44.1 to 192 kHz. 

Source compressed formats using TSI 

Content Protection HDCP 2.3 supported 

DSC Capability 
DSC sink, with off-line decompression 

DSC source using pre-compressed content 

Additional features Playback function 

Computer interface USB 3.0 

Operating System 

Debian 11.0 or higher. 

Ubuntu 20.04.4 LTS or higher. 

MacOS Big Sur 11.7.10 or higher. 

Windows 10 10.0.19045 or higher. 

Power supply 
AC/DC Power supply 

(100 to 240 Vac 50/60 Hz input, +24 Vdc output) 

Environmental 

Operating temperature: 15 to 35 deg C 

Storage temperature: 0 to 50 deg C 

Humidity 30% to 70% RH, non-condensing 

Mechanical Size 331 mm x 197 mm x 66 mm 
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Weight 1.9kg 
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APPENDIX B: PRODUCT FEATURES 
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DP Reference Sink               

Video status, preview and saving ●             ▲ 

Buffered capture ●              

Audio monitoring, graphical preview 

and saving 
● 

            
▲ 

Link status ●             ▲ 

Link control ●             ▲ 

HPD status and control ●             ▲ 

Fast Link Training (Link Training 

without AUX Transaction) 
● 

   
 

 
 

 
    

 
 

MST Feature (up to 4 streams) ●             ▲ 

FEC Feature ●             ▲ 

DSC Decoder, DSC Control ●             ▲ 

Adaptive-Sync Feature** ●             ▲ 

DPCD editor ●              

Monitor InfoFrame Status (SDP) ●             ▲ 

EDID read and write ●             ▲ 

EDID / DisplayID Editor ●              

HDCP 1.3 status and control* ●             ▲ 

HDCP 2.3 status and control  ●             ▲ 

Event Log, AUX Analyzer ●             ▲ 

Source DUT Testing (Link and CRC 

test) 
● 

            
▲ 

DP Link Analyzer  ●             

eDP Reference Sink               

eDP Link Training & Link Rate 

Support** 
 

  ● 
 

 
 

 
    

 
 

Alternate Scrambler Seed Reset (ASSR) ●              

Ability to Ignore Certain MSA Data 

Fields 
● 

   
 

 
 

 
    

 
 

OUI Support ●              

GUID Register Support ●              

Source Device Detection by way of the 

AUX_CH 
● 

   
 

 
 

 
    

 
 

 

*) HDCP 1.3 is not supported in 3.8 

**) eDP support is limited to eDP 1.5 (i.e. 8b/10b link coding)  
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DP Reference Sink              

Panel Replay ●             

PSR1  ●            

PSR2  ●            

Early Transport ● ●            

Selective Update ● ●            

AUX-less ALPM ● ●            

AUX-wake ALPM  ●            

DP 1.4 / 2.1 CTS for testing Source DUT              

DP 1.4 LL, Audio, FEC CTS for testing 
Source DUT 

  ●           

DP 2.1 LL CTS for testing Source DUT    ●          

DP 1.4a DSC CTS for testing Source    DUT     ●         

DP 2.1 DSC CTS for testing Source DUT      ●        

DP 2.1 MST CTS for testing Source DUT       ●       

DisplayID-EDID CTS for testing Source DUT        ●      

Adaptive-Sync CTS for testing Source DUT         ●     

HDCP 2.3 CTS for testing DP Source DUT          ● ●   

HDCP 2.3 CTS for testing DP Repeater DUT           ●   

DP 2.1 LTTPR CTS for testing Source DUT            ●  

DP 2.1 MST CTS for testing Source DUT             ● 

  



  Appendix B: Product Features 

UCD-5XX User Manual • UCD Console 3.8 173 

    Input / Output Role U
C

D
-5

X
X

 D
e
fa

u
lt
 

P
an

e
l 
R

e
p
la

y 

e
D

P
 S

u
p
p
o
rt

 

D
P
 1

.4
a 

L
L
 C

T
S

 

D
P
 2

.1
 L

L
 C

T
S

 

D
P
 1

.4
a 

D
S

C
 C

T
S

 

D
P
 2

.1
 D

S
C

 C
T
S

 

D
is

p
la

yI
D

 /
 E

D
ID

 C
T
S

 

A
d
ap

ti
ve

-S
yn

c 
C

T
S

 

H
D

C
P
 2

.3
 C

T
S

 S
in

k 
D

U
T
 

H
D

C
P
 2

.3
 C

T
S

 S
in

k 
 

S
o
u
rc

e
 a

n
d
 R

e
p
e
at

e
r 

D
U

T
 

D
P
 2

.1
 L

T
T
P
R

 C
T
S

 f
o
r 

S
in

k 
D

U
T
 

T
S

I 
B

as
ic

 

DP Reference Source                     

Video pattern generator (fixed patterns and 

timings) 
● 

           
▲ 

Custom video patterns and timings ●            ▲ 

Audio generator ●            ▲ 

Playback ●            ▲ 

Link status ●            ▲ 

Link control ●            ▲ 

HPD status ●            ▲ 

EDID read and write ●            ▲ 

EDID / DisplayID Editor ●             

Fast Link Training (Link Training without AUX 

Transaction) 
● 

  
 

 
 

 
    

 
 

MST Feature (up to 4 streams) ●            ▲ 

FEC Feature ●            ▲ 

DSC Encoder ●             

Adaptive-Sync Feature ●            ▲ 

DPCD editor ●             

LTTPR Feature ●            ▲ 

HDCP 1.3 status and control* ●            ▲ 

HDCP 2.3 status and control ●            ▲ 

Event Log, AUX Analyzer ●             

Playback ●             

eDP Reference Source              

eDP Link Training & Link Rate Support**   ●           

Alternate Scrambler Seed Reset (ASSR) ●             

OUI Support ●             

GUID Register Support ●             

Live Frame Mode ●             

Panel Replay, PSR, ALPM              

Panel Replay  ●            

PSR1   ●           

PSR2   ●           

Early Transport  ● ●           

Selective Update  ● ●           

AUX-less ALPM  ● ●           

AUX-wake ALPM   ●           

 

*) HDCP 1.3 is not supported in 3.8 

**) eDP support is limited to eDP 1.5 (i.e. 8b/10b link coding)  



  Appendix B: Product Features 

UCD-5XX User Manual • UCD Console 3.8 174 

    Input / Output Role 

U
C

D
-5

X
X

 D
e
fa

u
lt
 

P
an

e
l 
R

e
p
la

y 

e
D

P
 S

u
p
p
o
rt

 

D
P
 1

.4
a 

L
L
 C

T
S

 

D
P
 2

.1
 L

L
 C

T
S

 

D
P
 1

.4
a 

D
S

C
 C

T
S

 

D
P
 2

.1
 D

S
C

 C
T
S

 

D
is

p
la

yI
D

 /
 E

D
ID

 C
T
S
 

A
d
ap

ti
ve

-S
yn

c 
C

T
S
 

H
D

C
P
 2

.3
 C

T
S

 S
in

k 
D

U
T
 

H
D

C
P
 2

.3
 C

T
S

 S
in

k 
 

S
o
u
rc

e
 a

n
d
 R

e
p
e
at

e
r 

D
U

T
 

D
P
 2

.1
 L

T
T
P
R

 C
T
S

 f
o
r 

S
in

k 
D

U
T
 

DP 1.4 / 2.1 Link Layer CTS for testing Sink DUT             

DP 1.4a LL, Audio and FEC CTS for testing Sink 

DUT  
   

● 
        

 DP 2.1 LL CTS for testing Sink DUT     ●        

DP 1.4a DSC CTS for testing Sink DUT      ●       

DP 2.1 DSC CTS for testing Sink DUT       ●      

DisplayID / EDID CTS for testing Sink DUT        ●     

Adaptive-Sync CTS for testing Sink DUT         ●    

HDCP 2.3 CTS for testing DP Sink DUT          ● ●  

HDCP 2.3 CTS for testing DP Repeater DUT           ●  

DP 2.1 LTTPR CTS for testing Sink DUT            ● 
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UCD-5XX Product Options 
Hardware Test Tool P/N 

UCD-500 Gen2 066710 

UCD-500 Upgrade to UCD-500 Gen2 066705 

HDCP 2.3 CTS Testing  

HDCP 2.3 CTS for testing Source DUT on DP MT6634 

HDCP 2.3 CTS for testing Sink DUT on DP MT6636 

HDCP 2.3 CTS for testing Repeater DUT on DP MT6638 

DP 2.1 CTS Testing  

DP 2.1 LL CTS for testing Source DUT MT6662 

DP 2.1 LL CTS for testing Sink DUT MT6660 

DP 2.1 DSC CTS for testing Source DUT MT6656 

DP 2.1 DSC CTS for testing Sink DUT MT6657 

DP 2.1 MST CTS for testing Source DUT MT6663 

DP 1.4a CTS Testing  

DP 1.4a LL CTS for testing Source DUT MT6637 

DP 1.4a LL CTS for testing Sink DUT MT6635 

DP 1.4a DSC CTS for testing Source DUT MT6642 

DP 1.4a DSC CTS for testing Sink DUT MT6643 

DisplayID / EDID CTS testing  

DP 2.1 DisplayID / EDID CTS for testing Source DUT MT6646 

DP 2.1 DisplayID / EDID CTS for testing Sink DUT MT6647 

Adaptive Sync CTS Testing  

DP 2.1 Adaptive-Sync CTS for testing Source DUT MT6648 

DP 2.1 Adaptive-Sync CTS for testing Sink DUT MT6649 

LTTPR CTS Testing  

DP 2.1 LTTPR CTS for testing Source DUT MT6680 

DP 2.1 LTTPR CTS for testing Sink DUT MT6679 

DP 2.1 LTTPR CTS for testing LTTPR DUT MT6682 

Link Analyzer  

DP 2.1 Link Analyzer MT6682 

Panel Replay and eDP support  

DP 2.1 Panel Replay support for testing Sink & Source DUT MT6683 

eDP support for testing Sink & Source DUT** MT6684 

HDR10+ CTS  

HDR 10+ Distribution Device for testing Source DUT on DP MT6678 

HDR 10+ Display Device and SSTM for testing Sink DUT on DP MT6676 

 

            **) eDP support is limited to eDP 1.5 (i.e. 8b/10b link coding) 
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APPENDIX C: PREDEFINED TIMINGS 

Description* HA VA HT VT HST VST HSYN VSYN FR 

Pixel 

Clock 

(MHz) 

CVT 640 × 480 @ 60 Hz   640 480 800 525 144 35 96 2 60 25,20 

CTA 640 × 480 @ 60 Hz (VIC 1) 640 480 800 525 144 35 96 2 60 25,17 

CTA 720 × 480 @ 60 Hz (VIC 2) 720 480 858 525 122 36 62 6 60 27,03 

CTA 720 × 480 @ 60 Hz (VIC 3) 720 480 858 525 122 36 62 6 60 27,00 

CTA 720 × 576 @ 50 Hz (VIC 17) 720 576 864 625 132 44 64 5 50 27,00 

CTA 720 × 576 @ 50 Hz (VIC 18) 720 576 864 625 132 44 64 5 50 27,00 

CTA 720 × 576 @ 100 Hz (VIC 42) 720 576 864 625 132 44 64 5 100 54,00 

CTA 720 × 576 @ 100 Hz (VIC 43) 720 576 864 625 132 44 64 5 100 54,00 

CTA 720 × 480 @ 120 Hz (VIC 49) 720 480 858 525 122 36 62 6 120 54,00 

CTA 720 × 480 @ 120 Hz (VIC 48) 720 480 858 525 122 36 62 6 120 54,05 

CTA 720 × 576 @ 200 Hz (VIC 52) 720 576 864 625 132 44 64 5 200 108,00 

CTA 720 × 576 @ 200 Hz (VIC 53) 720 576 864 625 132 44 64 5 200 108,00 

CTA 720 × 480 @ 240 Hz (VIC 56) 720 480 858 525 122 36 62 6 240 108,00 

CTA 720 × 480 @ 240 Hz (VIC 57) 720 480 858 525 122 36 62 6 240 108,00 

DMT 800 × 600 @ 60 Hz (ID 9) 800 600 1056 628 216 27 128 4 60 39,79 

DMT 848 × 480 @ 60 Hz (ID 14) 848 480 1088 517 224 31 112 8 60 33,75 

DMT 1024 × 768 @ 60 Hz (ID 16) 1024 768 1344 806 296 35 136 6 60 65,00 

CTA 1280 × 720 @ 50 Hz (VIC 19) 1280 720 1980 750 260 25 40 5 50 74,25 

CTA 1280 × 720 @ 100 Hz (VIC 41) 1280 720 1980 750 260 25 40 5 100 148,50 

CTA 1280 × 720 @ 24 Hz (VIC 60) 1280 720 3300 750 260 25 40 5 24 59,40 

CTA 1280 × 720 @ 25 Hz (VIC 61) 1280 720 3960 750 260 25 40 5 25 74,25 

CTA 1280 × 720 @ 30 Hz (VIC 62) 1280 720 3300 750 260 25 40 5 30 74,25 

CTA 1280 × 720 @ 24 Hz (VIC 65) 1280 720 3300 750 260 25 40 5 24 59,40 

CTA 1280 × 720 @ 25 Hz (VIC 66) 1280 720 3960 750 260 25 40 5 25 74,25 

CTA 1280 × 720 @ 30 Hz (VIC 67) 1280 720 3300 750 260 25 40 5 30 74,25 

CTA 1280 × 720 @ 50 Hz (VIC 68) 1280 720 1980 750 260 25 40 5 50 74,25 

CTA 1280 × 720 @ 60 Hz (VIC 69) 1280 720 1650 750 260 25 40 5 60 74,25 

CTA 1280 × 720 @ 100 Hz (VIC 70) 1280 720 1980 750 260 25 40 5 100 148,50 

CTA 1280 × 720 @ 120 Hz (VIC 71) 1280 720 1650 750 260 25 40 5 120 148,50 

CTA 1280 × 720 @ 48 Hz (VIC 108) 1280 720 2500 750 260 25 40 5 48 90,00 

CTA 1280 × 720 @ 48 Hz (VIC 109) 1280 720 2500 750 260 25 40 5 48 90,00 

CTA 1280 × 720 @ 60 Hz (VIC 4) 1280 720 1650 750 260 25 40 5 60 74,25 

CTA 1280 × 720 @ 120 Hz (VIC 47) 1280 720 1650 750 260 25 40 5 120 148,50 

CVT 1280 × 768 @ 60 Hz  [RB1] 1280 768 1440 790 112 19 32 7 60 68,26 

DMT 1280 × 768 @ 60 Hz (ID 23) 1280 768 1664 798 320 27 128 7 60 79,67 

DMT 1280 × 800 @ 60 Hz (ID 27) 1280 800 1440 823 112 20 32 6 60 71,11 

DMT 1280 × 800 @ 60 Hz (ID 28) 1280 800 1680 831 328 28 128 6 60 83,76 

DMT 1280 × 960 @ 60 Hz (ID 32) 1280 960 1800 1000 424 39 112 3 60 108,00 

DMT 1280 × 1024 @ 60 Hz (ID 35) 1280 1024 1688 1066 360 41 112 3 60 107,96 

DMT 1360 × 768 @ 60 Hz (ID 39) 1360 768 1792 795 368 24 112 6 60 85,48 

DMT 1400 × 1050 @ 60 Hz (ID 41) 1400 1050 1560 1080 112 27 32 4 60 101,09 

DMT 1400 × 1050 @ 60 Hz (ID 42) 1400 1050 1864 1089 376 36 144 4 60 121,79 

*) CVT: Coordinated Video Timings (CVT v2.0) 

DMT: VESA and Industry Standards and Guidelines for Computer Display Monitor Timings 

CTA: A DTV Profile for Uncompressed High Speed Digital Interfaces (CTA-861-H) 
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Description* HA VA HT VT HST VST HSYN VSYN FR 

Pixel 

Clock 

(MHz) 

CTA 1440 × 240 @ 60 Hz (VIC 8) 1440 240 1716 263 238 18 124 3 60 27,00 

CTA 1440 × 240 @ 60 Hz (VIC 9) 1440 240 1716 263 238 18 124 3 60 27,00 

CTA 1440 × 480 @ 60 Hz (VIC 14) 1440 480 1716 525 244 36 124 6 60 54,00 

CTA 1440 × 480 @ 60 Hz (VIC 15) 1440 480 1716 525 244 36 124 6 60 54,00 

CTA 1440 × 576 @ 50 Hz (VIC 22) 1440 576 1728 625 264 22 126 3 50 54,00 

CTA 1440 × 288 @ 50 Hz (VIC 23) 1440 288 1728 314 264 22 126 3 50 27,00 

CTA 1440 × 288 @ 50 Hz (VIC 24) 1440 288 1728 314 264 22 126 3 50 27,00 

CTA 1440 × 576 @ 50 Hz (VIC 29) 1440 576 1728 625 264 44 128 5 50 54,00 

CTA 1440 × 576 @ 50 Hz (VIC 30) 1440 576 1728 625 264 44 128 5 50 54,00 

CVT 1600 × 1200 @ 60 Hz  [RB1] 1600 1200 1760 1235 112 32 32 4 60 130,42 

DMT 1600 × 1200 @ 60 Hz (ID 51) 1600 1200 2160 1250 496 49 192 3 60 162,00 

CTA 1680 × 720 @ 24 Hz (VIC 79) 1680 720 3300 750 260 25 40 5 24 59,40 

CTA 1680 × 720 @ 25 Hz (VIC 80) 1680 720 3168 750 260 25 40 5 25 59,40 

CTA 1680 × 720 @ 30 Hz (VIC 81) 1680 720 2640 750 260 25 40 5 30 59,40 

CTA 1680 × 720 @ 50 Hz (VIC 82) 1680 720 2200 750 260 25 40 5 50 82,50 

CTA 1680 × 720 @ 100 Hz (VIC 84) 1680 720 2000 825 260 100 40 5 100 165,00 

CTA 1680 × 720 @ 48 Hz (VIC 110) 1680 720 2750 750 260 25 40 5 48 99,00 

CTA 1680 × 720 @ 60 Hz (VIC 83) 1680 720 2200 750 260 25 40 5 60 99,00 

CTA 1680 × 720 @ 120 Hz (VIC 85) 1680 720 2000 825 260 100 40 5 120 198,00 

DMT 1680 × 1050 @ 60 Hz (ID 57) 1680 1050 1840 1080 112 27 32 6 60 119,23 

DMT 1680 × 1050 @ 60 Hz (ID 58) 1680 1050 2240 1089 456 36 176 6 60 146,36 

DMT 1792 × 1344 @ 60 Hz (ID 62) 1792 1344 2448 1394 528 49 200 3 60 204,75 

DMT 1856 × 1392 @ 60 Hz (ID 65) 1856 1392 2528 1439 576 46 224 3 60 218,27 

CTA 1920 × 1080 @ 50 Hz (VIC 31) 1920 1080 2640 1125 192 41 44 5 50 148,50 

CTA 1920 × 1080 @ 24 Hz (VIC 32) 1920 1080 2750 1125 192 41 44 5 24 74,25 

CTA 1920 × 1080 @ 25 Hz (VIC 33) 1920 1080 2640 1125 192 41 44 5 25 74,25 

CTA 1920 × 1080 @ 100 Hz (VIC 64) 1920 1080 2640 1125 192 41 44 5 100 297,00 

CTA 1920 × 1080 @ 24 Hz (VIC 72) 1920 1080 2750 1125 192 41 44 5 24 74,25 

CTA 1920 × 1080 @ 25 Hz (VIC 73) 1920 1080 2640 1125 192 41 44 5 25 74,25 

CTA 1920 × 1080 @ 30 Hz (VIC 74) 1920 1080 2200 1125 192 41 44 5 30 74,25 

CTA 1920 × 1080 @ 50 Hz (VIC 75) 1920 1080 2640 1125 192 41 44 5 50 148,50 

CTA 1920 × 1080 @ 60 Hz (VIC 76) 1920 1080 2200 1125 192 41 44 5 60 148,50 

CTA 1920 × 1080 @ 100 Hz (VIC 77) 1920 1080 2640 1125 192 41 44 5 100 297,00 

CTA 1920 × 1080 @ 120 Hz (VIC 78) 1920 1080 2200 1125 192 41 44 5 120 297,00 

CVT 1920 × 1080 @ 30 Hz  [RB1] 1920 1080 2080 1096 112 13 32 5 30 68,39 

CVT 1920 × 1080 @ 30 Hz  [RB2] 1920 1080 2000 1096 72 14 32 8 30 65,76 

CVT 1920 × 1080 @ 144 Hz  [RB3] 1920 1080 2080 1157 152 14 32 8 144 346,66 

CVT 1920 × 1080 @ 200 Hz  [RB3] 1920 1080 2080 1190 152 14 32 8 200 495,21 

CTA 1920 × 1080 @ 30 Hz (VIC 34) 1920 1080 2200 1125 192 41 44 5 30 74,25 

CVT 1920 × 1080 @ 60 Hz  [RB1] 1920 1080 2080 1111 112 28 32 5 60 138,65 

CVT 1920 × 1080 @ 60 Hz   1920 1080 2000 1111 72 14 32 8 60 133,32 

DMT 1920 × 1080 @ 60 Hz (ID 82) 1920 1080 2200 1125 192 41 44 5 60 148,50 

CTA 1920 × 1080 @ 60 Hz (VIC 16) 1920 1080 2200 1125 192 41 44 5 60 148,50 

CVT 1920 × 1080 @ 120 Hz  [RB1] 1920 1080 2080 1144 112 61 32 5 120 285,54 

CVT 1920 × 1080 @ 120 Hz  [RB2] 1920 1080 2000 1144 72 14 32 8 120 274,56 

CTA 1920 × 1080 @ 120 Hz (VIC 63) 1920 1080 2200 1125 192 41 44 5 120 297,00 

*) CVT: Coordinated Video Timings (CVT v2.0) 

DMT: VESA and Industry Standards and Guidelines for Computer Display Monitor Timings 

CTA: A DTV Profile for Uncompressed High Speed Digital Interfaces (CTA-861-H) 
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Description* HA VA HT VT HST VST HSYN VSYN FR 

Pixel 

Clock 

(MHz) 

CTA 1920 × 1080 @ 48 Hz (VIC 111) 1920 1080 2750 1125 192 41 44 5 48 148,50 

CTA 1920 × 1080 @ 48 Hz (VIC 112) 1920 1080 2750 1125 192 41 44 5 48 148,50 

DMT 1920 × 1200 @ 60 Hz (ID 69) 1920 1200 2592 1245 536 42 200 6 60 193,62 

DMT 1920 × 1440 @ 60 Hz (ID 73) 1920 1440 2600 1500 552 59 208 3 60 234,00 

CVT 2048 × 1536 @ 60 Hz  [RB1] 2048 1536 2208 1580 112 41 32 4 60 209,32 

CTA 2560 × 1080 @ 24 Hz (VIC 86) 2560 1080 3750 1100 192 16 44 5 24 99,00 

CTA 2560 × 1080 @ 25 Hz (VIC 87) 2560 1080 3200 1125 192 41 44 5 25 90,00 

CTA 2560 × 1080 @ 30 Hz (VIC 88) 2560 1080 3520 1125 192 41 44 5 30 118,80 

CTA 2560 × 1080 @ 50 Hz (VIC 89) 2560 1080 3300 1125 192 41 44 5 50 185,63 

CTA 2560 × 1080 @ 100 Hz (VIC 91) 2560 1080 2970 1250 192 166 44 5 100 371,25 

CVT 2560 × 1440 @ 60 Hz  [RB2] 2560 1440 2640 1481 72 14 32 8 60 234,59 

CVT 2560 × 1440 @ 60 Hz  [RB1] 2560 1440 2720 1481 112 38 32 5 60 241,70 

CVT 2560 × 1440 @ 144 Hz  [RB3] 2560 1440 2720 1543 152 14 32 8 144 604,57 

CVT 2560 × 1440 @ 200 Hz  [RB3] 2560 1440 2720 1586 152 14 32 8 200 863,09 

CTA 2560 × 1080 @ 48 Hz (VIC 113) 2560 1080 3750 1100 192 16 44 5 48 198,00 

CVT 2560 × 1080 @ 60 Hz   2560 1080 3424 1120 704 37 272 10 60 230,09 

CVT 2560 × 1080 @ 60 Hz  [RB1] 2560 1080 2720 1111 112 28 32 10 60 181,32 

CVT 2560 × 1080 @ 144 Hz  [RB3] 2560 1080 2720 1157 152 14 32 8 144 453,33 

CVT 2560 × 1080 @ 200 Hz  [RB3] 2560 1080 2720 1190 152 14 32 8 200 647,59 

CTA 2560 × 1080 @ 60 Hz (VIC 90) 2560 1080 3000 1100 192 16 44 5 60 198,00 

CTA 2560 × 1080 @ 120 Hz (VIC 92) 2560 1080 3300 1250 192 16 44 5 120 495,00 

DMT 2560 × 1600 @ 60 Hz (ID 77) 2560 1600 3504 1658 752 55 280 6 60 348,58 

DMT 2560 × 1600 @ 60 Hz (ID 76) 2560 1600 2720 1646 112 43 32 6 60 268,63 

CTA 2880 × 240 @ 60 Hz (VIC 12) 2880 240 3432 263 476 18 248 3 60 54,00 

CTA 2880 × 240 @ 60 Hz (VIC 13) 2880 240 3432 263 476 18 248 3 60 54,00 

CTA 2880 × 288 @ 50 Hz (VIC 27) 2880 288 3456 314 528 22 252 3 50 54,00 

CTA 2880 × 288 @ 50 Hz (VIC 28) 2880 288 3456 314 528 22 252 3 50 54,00 

CTA 2880 × 480 @ 60 Hz (VIC 35) 2880 480 3432 525 488 36 248 6 60 108,00 

CTA 2880 × 480 @ 60 Hz (VIC 36) 2880 480 3432 525 488 36 248 6 60 108,00 

CTA 2880 × 576 @ 50 Hz (VIC 37) 2880 576 3456 625 528 44 256 5 50 108,00 

CTA 2880 × 576 @ 50 Hz (VIC 38) 2880 576 3456 625 528 44 256 5 50 108,00 

2880 × 1440 @ 60 Hz 2880 1440 2976 1456 48 8 8 1 60 259,98 

CVT 3840 × 2160 @ 30 Hz  [RB1] 3840 2160 4000 2191 112 28 32 5 30 262,92 

CVT 3840 × 2160 @ 30 Hz  [RB2] 3840 2160 3920 2191 72 14 32 8 30 257,66 

CVT 3840 × 2160 @ 144 Hz  [RB3] 3840 2160 4000 2314 152 14 32 8 144 1333,33 

CVT 3840 × 2160 @ 60 Hz  [RB1] 3840 2160 4000 2222 112 59 32 5 60 533,28 

CVT 3840 × 2160 @ 60 Hz  [RB2] 3840 2160 3920 2222 72 14 32 8 60 522,61 

CVT 3840 × 2160 @ 60 Hz  [RB3] 3840 2160 4000 2222 152 14 32 8 60 533,47 

CTA 3840 × 2160 @ 60 Hz (VIC 97) 3840 2160 4400 2250 384 82 88 10 60 594,00 

CTA 3840 × 2160 @ 24 Hz (VIC 93) 3840 2160 5500 2250 384 82 88 10 24 297,00 

CTA 3840 × 2160 @ 25 Hz (VIC 94) 3840 2160 5280 2250 384 82 88 10 25 297,00 

CTA 3840 × 2160 @ 30 Hz (VIC 95) 3840 2160 4400 2250 384 82 88 10 30 297,00 

CTA 3840 × 2160 @ 50 Hz (VIC 96) 3840 2160 5280 2250 384 82 88 10 50 594,00 

CTA 3840 × 2160 @ 24 Hz (VIC 103) 3840 2160 5500 2250 384 82 88 10 24 297,00 

CTA 3840 × 2160 @ 25 Hz (VIC 104) 3840 2160 5280 2250 384 82 88 10 25 297,00 

CTA 3840 × 2160 @ 30 Hz (VIC 105) 3840 2160 4400 2250 384 82 88 10 30 297,00 

*) CVT: Coordinated Video Timings (CVT v2.0) 

DMT: VESA and Industry Standards and Guidelines for Computer Display Monitor Timings 

CTA: A DTV Profile for Uncompressed High Speed Digital Interfaces (CTA-861-H) 
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Description* HA VA HT VT HST VST HSYN VSYN FR 

Pixel 

Clock 

(MHz) 

CTA 3840 × 2160 @ 50 Hz (VIC 106) 3840 2160 5280 2250 384 82 88 10 50 594,00 

CTA 3840 × 2160 @ 60 Hz (VIC 107) 3840 2160 4400 2250 384 82 88 10 60 594,00 

CTA 3840 × 2160 @ 48 Hz (VIC 114) 3840 2160 5500 2250 384 82 88 10 48 594,00 

CTA 3840 × 2160 @ 48 Hz (VIC 116) 3840 2160 5500 2250 384 82 88 10 48 594,00 

CTA 3840 × 2160 @ 100 Hz (VIC 117) 3840 2160 5280 2250 384 82 88 10 100 1188,00 

CTA 3840 × 2160 @ 100 Hz (VIC 119) 3840 2160 5280 2250 384 82 88 10 100 1188,00 

CTA 3840 × 2160 @ 120 Hz (VIC 120) 3840 2160 4400 2250 384 82 88 10 120 1188,00 

CVT 4096 × 2160 @ 60 Hz  [RB2] 4096 2160 4176 2222 72 14 32 8 60 556,74 

CVT 4096 × 2160 @ 60 Hz  [RB1] 4096 2160 4256 2222 112 59 32 10 60 567,41 

CVT 4096 × 2160 @ 60 Hz  [RB3] 4096 2160 4256 2222 152 14 32 8 60 567,61 

CVT 4096 × 2160 @ 144 Hz  [RB3] 4096 2160 4256 2314 152 14 32 8 144 1418,66 

CTA 4096 × 2160 @ 60 Hz (VIC 102) 4096 2160 4400 2250 216 82 88 10 60 594,00 

CTA 4096 × 2160 @ 120 Hz (VIC 219) 4096 2160 4400 2250 216 82 88 10 120 1188,00 

CTA 4096 × 2160 @ 100 Hz (VIC 218) 4096 2160 5280 2250 384 82 88 10 100 1188,00 

CTA 4096 × 2160 @ 50 Hz (VIC 101) 4096 2160 5280 2250 216 82 88 10 50 594,00 

CTA 4096 × 2160 @ 48 Hz (VIC 115) 4096 2160 5500 2250 384 82 88 10 48 594,00 

CTA 4096 × 2160 @ 24 Hz (VIC 98) 4096 2160 5500 2250 384 82 88 10 24 297,00 

CTA 4096 × 2160 @ 25 Hz (VIC 99) 4096 2160 5280 2250 216 82 88 10 25 297,00 

CTA 4096 × 2160 @ 30 Hz (VIC 100) 4096 2160 4400 2250 216 82 88 10 30 297,00 

CVT 3840 × 2160 @ 120 Hz  [RB1] 3840 2160 4000 2287 112 124 32 5 120 1097,76 

CVT 3840 × 2160 @ 120 Hz  [RB2] 3840 2160 3920 2287 72 14 32 8 120 1075,80 

CTA 3840 × 2160 @ 120 Hz (VIC 118) 3840 2160 4400 2250 384 82 88 10 120 1188,00 

CVT 5120 × 2160 @ 30 Hz  [RB1] 5120 2160 5280 2191 112 28 32 10 30 347,05 

CVT 5120 × 2160 @ 30 Hz  [RB2] 5120 2160 5200 2191 72 14 32 8 30 341,80 

CTA 5120 × 2160 @ 30 Hz (VIC 123) 5120 2160 6000 2200 216 32 88 10 30 396,00 

CVT 5120 × 2160 @ 60 Hz  [RB1] 5120 2160 5280 2222 112 59 32 10 60 703,93 

CVT 5120 × 2160 @ 60 Hz  [RB2] 5120 2160 5200 2222 72 14 32 6 60 693,26 

CTA 5120 × 2160 @ 60 Hz (VIC 126) 5120 2160 5500 2250 216 82 88 10 60 742,50 

CVT 5120 × 2160 @ 120 Hz  [RB1] 5120 2160 5280 2287 112 124 32 10 120 1449,04 

CVT 5120 × 2160 @ 120 Hz  [RB3] 5120 2160 5280 2287 152 14 32 8 120 1449,55 

CVT 5120 × 2160 @ 120 Hz  [RB2] 5120 2160 5200 2287 72 14 32 8 120 1427,09 

CTA 5120 × 2160 @ 120 Hz (VIC 193) 5120 2160 5500 2250 216 82 88 10 120 1485,00 

5120 × 2880 @ 60 Hz 5120 2880 5280 2962 112 79 32 5 60 938,36 

5120 × 2880 @ 60 Hz 5120 2880 5200 2962 72 14 32 8 60 924,14 

5120 × 2880 @ 60 Hz 5120 2880 5280 2962 152 14 32 8 60 938,69 

CTA 5120 × 2160 @ 48 Hz (VIC 124) 5120 2160 6250 2475 384 307 88 10 48 742,50 

CTA 5120 × 2160 @ 50 Hz (VIC 125) 5120 2160 6600 2250 384 82 88 10 50 742,50 

CTA 5120 × 2160 @ 100 Hz (VIC 127) 5120 2160 6600 2250 384 82 88 10 100 1485,00 

CTA 5120 × 2160 @ 25 Hz (VIC 122) 5120 2160 7200 2200 384 32 88 10 25 396,00 

CTA 5120 × 2160 @ 24 Hz (VIC 121) 5120 2160 7500 2200 384 32 88 10 24 396,00 

CVT 7680 × 4320 @ 30 Hz  [RB1] 7680 4320 7760 4381 72 14 32 8 30 1019,90 

CVT 7680 × 4320 @ 30 Hz  [RB1] 7680 4320 7840 4381 112 58 32 5 30 1030,41 

CVT 7680 × 4320 @ 60 Hz  [RB1] 7680 4320 7760 4443 72 14 32 8 60 2068,66 

CVT 7680 × 4320 @ 100 Hz  [RB1] 7680 4320 7760 4529 72 14 32 8 100 3514,50 

CVT 7680 × 4320 @ 60 Hz   7680 4320 7840 4443 112 120 32 5 60 2089,99 

CVT 7680 × 4320 @ 100 Hz  [RB1] 7680 4320 7840 4529 112 206 32 5 100 3550,74 

*) CVT: Coordinated Video Timings (CVT v2.0) 

DMT: VESA and Industry Standards and Guidelines for Computer Display Monitor Timings 

CTA: A DTV Profile for Uncompressed High Speed Digital Interfaces (CTA-861-H) 
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Description* HA VA HT VT HST VST HSYN VSYN FR 

Pixel 

Clock 

(MHz) 

CTA 7680 × 4320 @ 120 Hz (VIC 201) 7680 4320 8800 4500 768 164 176 20 120 4752,00 

CTA 7680 × 4320 @ 120 Hz (VIC 209) 7680 4320 8800 4500 768 164 176 20 120 4752,00 

CTA 7680 × 4320 @ 30 Hz (VIC 204) 7680 4320 9000 4400 768 64 176 20 30 1188,00 

CTA 7680 × 4320 @ 30 Hz (VIC 196) 7680 4320 9000 4400 768 64 176 20 30 1188,00 

CTA 7680 × 4320 @ 60 Hz (VIC 207) 7680 4320 9000 4400 768 64 176 20 60 2376,00 

CTA 7680 × 4320 @ 60 Hz (VIC 199) 7680 4320 9000 4400 768 64 176 20 60 2376,00 

CTA 7680 × 4320 @ 100 Hz (VIC 208) 7680 4320 10560 4500 768 164 176 20 100 4752,00 

CTA 7680 × 4320 @ 100 Hz (VIC 200) 7680 4320 10560 4500 768 164 176 20 100 4752,00 

CTA 7680 × 4320 @ 25 Hz (VIC 203) 7680 4320 10800 4400 768 64 176 20 25 1188,00 

CTA 7680 × 4320 @ 25 Hz (VIC 195) 7680 4320 10800 4400 768 64 176 20 25 1188,00 

CTA 7680 × 4320 @ 50 Hz (VIC 198) 7680 4320 10800 4400 768 64 176 20 50 2376,00 

CTA 7680 × 4320 @ 50 Hz (VIC 206) 7680 4320 10800 4400 768 64 176 20 50 2376,00 

CTA 7680 × 4320 @ 24 Hz (VIC 194) 7680 4320 11000 4500 768 164 176 20 24 1188,00 

CTA 7680 × 4320 @ 48 Hz (VIC 197) 7680 4320 11000 4500 768 164 176 20 48 2376,00 

CTA 7680 × 4320 @ 24 Hz (VIC 202) 7680 4320 11000 4500 768 164 176 20 24 1188,00 

CTA 7680 × 4320 @ 48 Hz (VIC 205) 7680 4320 11000 4500 768 164 176 20 48 2376,00 

CTA 10240 × 4320 @ 24 Hz (VIC 210) 10240 4320 12500 4950 768 614 176 20 24 1485,00 

CTA 10240 × 4320 @ 25 Hz (VIC 211) 10240 4320 13500 4400 768 64 176 20 25 1485,00 

CTA 10240 × 4320 @ 30 Hz (VIC 212) 10240 4320 11000 4500 472 164 176 20 30 1485,00 

CTA 10240 × 4320 @ 48 Hz (VIC 213) 10240 4320 12500 4950 768 614 176 20 48 2970,00 

CTA 10240 × 4320 @ 50 Hz (VIC 214) 10240 4320 13500 4400 768 64 176 20 50 2970,00 

CTA 10240 × 4320 @ 60 Hz (VIC 215) 10240 4320 11000 4500 472 164 176 20 60 2970,00 

CTA 10240 × 4320 @ 100 Hz (VIC 216) 10240 4320 13200 4500 768 164 176 20 100 5940,00 

CTA 10240 × 4320 @ 120 Hz (VIC 217) 10240 4320 11000 4500 472 164 176 20 120 5940,00 

CTA 15360 x 8640 @ 30Hz [RB1] 15360 8640 15520 8761 112 118 32 5 30 4079,00 

CTA 15360 x 8640 @ 30Hz [RB2] 15360 8640 15440 8761 72 14 32 8 30 4058,10 

CTA 15360 x 8640 @ 30Hz [RB3] 15360 8640 15520 8761 152 14 32 8 30 4080,55 

*) CVT: Coordinated Video Timings (CVT v2.0) 

DMT: VESA and Industry Standards and Guidelines for Computer Display Monitor Timings 

CTA: A DTV Profile for Uncompressed High Speed Digital Interfaces (CTA-861-H) 
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APPENDIX D: PREDEFINED PATTERNS 

Fixed Patterns 

Selection Pattern Description 

Disabled 

 

The links are activated but no video data transferred 

Color Bar 

 

100% intensity color bars of all primaries and mixed combinations. 

Chessboard 

 

8 by 8 chessboard with black (0%) and 100% intensity white 

Solid Color 

 

Solid color. User selected RGB values 

Solid White 

 

100% white 

Solid Red 

 

100% red 

Solid Green 

 

100% green 

Solid Blue 

 

100% blue 

White V-Strips 

 

Vertical stripes of black (0%) and white (100%).  

Parameters set the widths of the black and white stripes in pixels 

respectively. Default black / white = 20 / 20 pixels. Parameter range 

1 to 1000. 

RGB Wide Strips 

 

16 pixels high horizontal red, green, blue, and white stripes. 

Intensity is increased from 0 to 100% with steps defined by the 

given parameter (Color Step = cs) and selected color.  

(step = cs*color_depth/256). “n” range 0 to 5000 (default 100). 

Color Ramp 

 

Color Ramp test pattern defined by VESA DisplayPort Link Layer 

Compliance Test Specification. 

Color Square 

 

Color Square test pattern defined by VESA DisplayPort Link Layer 

Compliance Test Specification. Color mode can be selected 

between RGB, YCbCr 4:4:4, 4:2:2, 4:2:0 (ITU Rec 601 / 709) 

Motion Pattern 

 

Horizontally moving color bar pattern. The pattern is shifted to left 

one pixel in each frame in a sequence. The length of the sequence 

is defined with parameter. Range 0 to 34 (default is 20) 

Square Window 

 

100% intensity white square horizontally and vertically centered. 

Height and width defined by parameter as the percentage of height 

and width of the frame (default 30). 
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Extended Patterns 

Selection Icon Description 

Select Image 
 

Custom image uploaded by the user. Click on Select … to browse. 

Select DSC Image 
 

Custom DSC compressed image file uploaded by the user.  

Click on Select … to browse. 

Unigraf PM5544 
 

Vpattern vector pattern based on PM5544 

Color Web 
 

Vpattern vector pattern. 

Chinese Town Full HD 
 

JPG Bitmap image (1920 x 1080 px) 

UG-2111 HLG Narrow 
 

Software generated pattern. HLG Narrow dynamic range. 

UG-2111 PQ Narrow 
 

Software generated pattern. PQ Narrow dynamic range. 

UG-2111 PQ Full 
 

Software generated pattern. PQ Full dynamic range. 

Multi 
 

Vpattern vector pattern. Multi-purpose pattern w square grid, cross-grids, 

1x1 crosshatches, circles, and color bars 

SMPTE RP-133 
 

Vpattern vector pattern based on SMTPE RP-133 

SMPTE 303M 
 

Vpattern vector pattern. SMPTE 303M; Full Range; RGB values before 

gamma correction based on D65 and PAL primaries 

Blue 
 

Vpattern vector pattern. 100% Blue 

CirclesW 
 

Vpattern vector pattern. Concentric circles 

Complex 
 

Vpattern vector pattern. Complex Pattern w 64 steps 

Green 
 

Vpattern vector pattern. 100% Green 

Hor1W-Even 
 

Vpattern vector pattern. Horizontal 1 px wide White bars in even rows 

Hor1W-Odd 
 

Vpattern vector pattern. Horizontal 1 px wide White bars in odd rows 

Hor4W 
 

Vpattern vector pattern. Horizontal 4 px high White bars 

Hor10W 
 

Vpattern vector pattern. Horizontal 10 px high White bars 

Hor-10xB 
 

Vpattern vector pattern. 10 pcs horizontal Blue bars 

Hor-10G 
 

Vpattern vector pattern. 10 pcs horizontal Green bars 
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Extended Patterns (cont.) 

Selection Icon Description 

Hor-10xR 
 

Vpattern vector pattern. 10 pcs horizontal Red bars 

Hor-10xW 
 

Vpattern vector pattern. 10 pcs horizontal White bars 

HorRainbow-1024 
 

Vpattern vector pattern. Horizontal Rainbow Ramps 1024 steps 

HorRGBW-1024 
 

Vpattern vector pattern. Horizontal RGBW Ramps 1024 steps 

HorScale9 
 

Vpattern vector pattern. Nine Horizontal Color Ramps 

HorScaleW-64 
 

Vpattern vector pattern. Horizontal White ramp 64 steps 

HorScaleW-128 
 

Vpattern vector pattern. Horizontal White ramp 128 steps 

HorScaleW-X2 
 

Vpattern vector pattern. Horizontal White ramp w edges 128 steps 

InnerBox-BKtoB 
 

Vpattern vector pattern. InnerBox pattern from Black to Blue 

InnerBox-BKtoG 
 

Vpattern vector pattern. InnerBox pattern from Black to Green 

InnerBox-BKtoR 
 

Vpattern vector pattern. InnerBox pattern from Black to Red 

InnerBox-BKtoW 
 

Vpattern vector pattern. InnerBox pattern from Black to White 

InnerBoxMIX 
 

Vpattern vector pattern. InnerBox pattern mixed hues. 

InnerBox-RtoB 
 

Vpattern vector pattern. InnerBox pattern from Red to Blue 

Red 
 

Vpattern vector pattern. 100% Red 

Ver1W-Even 
 

Vpattern vector pattern. Vertical 1 px wide White bars in even columns 

Ver1W-Odd 
 

Vpattern vector pattern. Vertical 1 px wide White bars in odd columns 

Ver4W 
 

Vpattern vector pattern. Vertical 4 px wide White bars 

Ver10W 
 

Vpattern vector pattern. Vertical 10 px wide White bars 

Ver-10xG 
 

Vpattern vector pattern. 10 pcs Vertical Blue bars 

Ver-10xR 
 

Vpattern vector pattern. 10 pcs Vertical Blue bars 

Ver-10xB 
 

Vpattern vector pattern. 10 pcs Vertical Blue bars 

Ver-10xW 
 

Vpattern vector pattern. 10 pcs Vertical Blue bars 
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Extended Patterns (cont.) 

Selection Icon Description 

VerBars75% 
 

Vpattern vector pattern. Vertical 75% intensity Color bars 

VerBars100% 
 

Vpattern vector pattern. Vertical 100% intensity Color bars 

VerRGBW-1024 
 

Vpattern vector pattern. Vertical RGBW Ramps 1024 steps 

X-HatchBK-C 
 

Vpattern vector pattern. Black 16 x12 Grid w Circle on White background 

X-HatchW 
 

Vpattern vector pattern. White 16 x12 Grid on Black background 

X-HatchW-C 
 

Vpattern vector pattern. White 16 x12 Grid w Circle on Black background 

X-HatchW-CC 
 

Vpattern vector pattern. White 16 x12 Grid w Ellipses, Circle and 100% 

color bars 

Gray Box 10 

 

Vpattern vector pattern. China 5.6 White Window 10% 

Gray Box 20 

 

Vpattern vector pattern. China 5.6 White Window 20% 

Gray Box 30 

 

Vpattern vector pattern. China 5.6 White Window 30% 

Gray Box 40 

 

Vpattern vector pattern. China 5.6 White Window 40% 

Gray Box 50 

 

Vpattern vector pattern. China 5.6 White Window 50% 

Gray Box 60 

 

Vpattern vector pattern. China 5.6 White Window 60% 

Gray Box 70 

 

Vpattern vector pattern. China 5.6 White Window 70% 

Gray Box 80 

 

Vpattern vector pattern. China 5.6 White Window 80% 

Gray Box 90 

 

Vpattern vector pattern. China 5.6 White Window 90% 

Gray Box 100 

 

Vpattern vector pattern. China 5.6 White Window 100% 

8 Level Gray 

 

Vpattern vector pattern. China 5.5 Ultimate 8 Level Grayscale 
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Extended Patterns (cont.) 

Selection Icon Description 

Black'n'White Window 

HDTV 
 

Vpattern vector pattern. China 5.8 Black and White Window(FOR HDTV) 

Black'n'White Window 

SDTV 
 

Vpattern vector pattern. China 5.8 Black and White Window(FOR SDTV) 

Black Line HDTV 

 

Vpattern vector pattern. China 5.10 Black Line HDTV 

Black Line SDTV 

 

Vpattern vector pattern. China 5.10 Black Line SDTV 

Black Window 

 

Vpattern vector pattern. China 5.7 Black Window 

Check Board 
 

Vpattern vector pattern. China 5.9 Check Board 

Line'n'Window 

 

Vpattern vector pattern. China 5.11 Line and Window 

Narrow White Window 

 

Vpattern vector pattern. China 5.19 Narrow White Window 

Single Dot 

 

Vpattern vector pattern. China Single Dot 

White Line HDTV 

 

Vpattern vector pattern. China 5.10 White Line for HDTV 

White Line SDTV 

 

Vpattern vector pattern. China 5.10 White Line for SDTV 

 

More test patterns can be downloaded e.g. from www.icdm-sid.org/ 
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APPENDIX E: SINK, SOURCE AND REPEATER TESTS 

 

Source DUT Testing 

 

D
ef

au
lt 

D
P

 1
.4

a 
LL

 C
TS

* 

D
P

 1
.4

a 
D

S
C

 C
TS

* 

D
P

 2
.1

 L
L 

C
TS

* 

D
P

 2
.1

 D
S
C

 C
TS

 

D
P

 2
.1

 M
S
T 

C
TS

 

D
P

 2
.1

 D
is

pl
ay

ID
 &

 E
D

ID
 

C
TS

* 

D
P

 2
.1

 A
da

pt
iv

e-
S
yn

c 
C

TS
 

D
U

T*
 

D
P
 2

.1
 L

TT
P
R

 C
TS

 

H
D

C
P
 2

.3
 C

TS
* 

Audio Test 
Validate audio signal frequency and glitch-free audio 

reproduction 
●    

     
 

CRC Video Tests 

 

 

CRC based single frame reference video test, 

CRC based single frame stability test,  

CRC based sequence of frames reference video test, 

CRC based continuous sequence of frames reference 

video test 

●    

     

 

DP 1.4a Link Layer CTS  

4.2.1.1 – 4.2.1.5, 4.2.2.1 – 4.2.2.10, 4.3.1.1 – 4.3.1.13, 

4.3.2.1 – 4.3.2.5, 4.3.3.1, 4.4.1.1 – 4.4.1.3, 4.4.2, 4.4.3, 

4.4.4.2 – 4.4.4.6, 4.5.1.1 – 4.5.1.2 

 ●   

     

 

DP 1.4a DSC CTS 4.6.1.1 – 4.6.1.9   ●        

DP 2.1 Link Layer CTS 

4.2.1.1 – 4.2.1.5, 4.2.2.1 – 4.2.2.2, 4.2.2.4 – 4.2.2.5, 

4.2.2.7 – 4.2.2.8, 4.2.2.10 – 4.2.2.14, 4.3.1.1 – 4.3.1.24, 

4.3.2.1 – 4.3.2.4, 4.3.3.1 – 4.3.3.2, 4.4.1.1-4.4.1.6, 

4.4.2.1 – 4.4.2.2, 4.4.3, 4.4.4.2 – 4.4.4.13, 4.5.1.1-

4.5.1.2 

   ● 

     

 

DP 2.1 DSC CTS 4.6.1.1 – 4.6.1.9     ●      

DisplayID-EDID CTS 

4.7.1.1 – 4.7.1.4, 4.7.2.1 – 4.7.2.2, 4.7.3.1 – 4.7.3.3, 

4.7.4.1, 4.7.4.4 - 4.7.4.5, 4.7.4.8, 4.7.5.1 - 4.7.5.2, 

4.7.6.1 - 4.7.6.4, 4.7.7.1 - 4.7.7.2 

    
  

● 

  

 

Adaptive-Sync CTS 4.8.1.1 – 4.8.1.4, 4.8.2.1 – 4.8.2.6,        ●   

DP 2.1 LTTPR CTS 4.9.1.1 – 4.9.1.22         ●  

DP 2.1 MST CTS 4.10.1.1 – 4.10.1.21      ●     

HDCP 2.3 CTS 1A Test Set HDCP2.3 CTS 1A-01 – HDCP2.3 CTS 1A-12          ● 

HDCP 2.3 CTS 1B Test Set HDCP2.3 CTS 1B-01 – HDCP2.3 CTS 1B-10          ● 

Link Config Tests  
Link Training at All Supported Lane Counts and Link 

Rates 
●    

     
 

Pixel Level Video Tests Compare video frame sequence with a single reference ●          

*) Separate licenses for testing Sink, Source, Branch DUT (LL CTS, DSC, DisplayID, Adaptive-Sync) 

 

  



  Appendix E: Sink, Source and Repeater Tests 

UCD-5XX User Manual • UCD Console 3.8 187 

Sink DUT Testing  

D
ef

au
lt 

D
P

 1
.4

a 
LL

 C
TS

* 

D
P

 1
.4

a 
D

S
C

 C
TS

* 

D
P

 2
.1

 L
L 

C
TS

* 

D
P

 2
.1

 D
S
C

 C
TS

 

D
P

 2
.1

 D
is

pl
ay

ID
 &

 E
D

ID
 

C
TS

* 

D
P

 2
1 

A
da

pt
iv

e-
S
yn

c 
C

TS
 

D
U

T*
 

D
P
 2

.1
 L

TT
P
R

 C
TS

* 

H
D

C
P
 2

.3
 C

TS
* 

DP 1.4 Link Layer CTS  

5.2.1.1 – 5.2.1.12, 5.2.2.1 – 5.2.2.9, 5.3.1.1 – 5.3.1.9, 

5.3.2.1 – 5.3.2.2, 5.4.1.1 – 5.4.1.4, 5.4.2, 5.4.3.1 – 

5.4.3.2, 5.4.4.1 – 5.4.4.6, 5.5.1.1 – 5.5.1.7 

 ●   

 

  

 

 

DP 1.4 DSC CTS 5.6.1.1 – 5.6.1.26, 5.6.2.1 – 5.6.2.14   ●       

DP 2.1 Link Layer CTS 

5.2.1.8 – 5.2.1.12, 5.2.2.1 – 5.2.2.10, 5.3.1.1 – 

5.3.1.5, 5.3.1.8 - 5.3.1.15, 5.3.2.1 – 5.3.2.2, 5.4.1.1 – 

5.4.1.8, 5.4.2.1 – 5.4.2.2, 5.4.3.1 - 5.4.3.4, 5.4.4.1 – 

5.4.4.10, 5.4.5.1 - 5.4.5.5, 5.5.1.1 – 5.5.1.12 

   ● 

 

  

 

 

DP 2.1 DSC CTS 
5.6.1.1 – 5.6.1.26, 5.6.2.1 – 5.6.2.16, 5.6.3.1 – 

5.6.3.7 
    ●

● 
  

 
 

DisplayID-EDID CTS 

5.7.1.1 – 5.7.1.2, 5.7.1.3.1 – 5.7.1.3.4, 5.7.1.4.1 – 

5.7.1.4.9, 5.7.1.5 - 5.7.1.6, 5.7.2.1 – 5.7.2.2, 5.7.2.3.1 

– 5.7.2.3.5, 5.7.2.4.1 – 5.7.2.4.2, 5.7.2.5.1 – 

5.7.2.5.2, 5.7.2.6.1 – 5.7.2.6.2, 5.7.2.7.1, 5.7.2.8, 

5.7.3.1 – 5.7.3.5, 5.7.4.1 – 5.7.4.3, 5.7.4.5, 5.7.4.10 –

12, 5.7.4.14, 5.7.5.1 – 2, 5.7.6.1 – 5.7.6.10, 5.7.7.1 – 

5.7.7.12, 5.7.8.1 – 5.7.8.12, 5.7.9.1 – 5.7.9.6, 

5.7.10.1 – 5.7.10.6, 5.7.11.1 – 5.7.11.10, 5.7.12.1 – 

5.7.12.8, 5.7.13.1-5.7.13.2, 5.7.14.1 – 5.7.14.16, 

5.7.15.1 – 5.7.15.12, 5.7.16.1 – 5.7.16.7, 5.7.16.9-

5.7.16.11, 5.7.17.1 – 5.7.17.10, 5.7.18.1 , 5.7.19.1 - 

5.7.19.6, 

5.7.20.1 - 5.7.20.3, 5.7.21.1 - 5.7.21.5, 5.7.22.1 - 

5.7.22.7 

    

 

●  

 

 

Adaptive-Sync CTS 5.8.1.1 – 5.8.1.6       ●   

DP 2.1 LTTPR CTS 5.9.1.1 – 5.9.1.15        ●  

HDCP 2.3 CTS 2C Test Set HDCP2.3 CTS 2C-01 – HDCP2.3 CTS 2C-05         ● 

*) Separate licenses for testing Sink, Source, Branch DUT (LL CTS, DSC, DisplayID, Adaptive-Sync)  
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LTTPR and DP Tunnel Device Testing 
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DP 2.1 LTTPR CTS for testing LTTPR Device 

7.1.1.1 – 7.1.1.9, 7.1.2.1 – 7.1.2.9, 

7.1.3.1-7.1.3.8, 7.1.4.1-7.1.4.10, 7.1.5.1-

7.1.5.6, 7.1.6.1-7.1.6.7, 7.1.7.1-7.1.7.7, 

7.1.8.1, 7.1.9.1, 7.1.10.1-2, 7.1.11.1-2, 

7.1.12.1-8 

 ● 

 

Repeater DUT Testing 
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HDCP 2.3 CTS 3A Test Set HDCP2.3 CTS 3A-01 – HDCP2.3 CTS 3A-06  ● 

HDCP 2.3 CTS 3B Test Set HDCP2.3 CTS 3B-01 – HDCP2.3 CTS 3B-07  ● 

HDCP 2.3 CTS 3C Test Set HDCP2.3 CTS 3C-01 – HDCP2.3 CTS 3C-25  ● 

*) Separate licenses for testing Sink, Source, Branch (LL CTS) and Repeater (HDCP) DUT 
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Compliance Tests 

Compliance test capability is a license enabled add-on to UCD Console. The tests are included in the 

GUI software, license codes enable the tests for use.  

Please refer to Appendix B Licensing for details. The list of compliance tests that UCD Console 

supports, please refer to document DP CTS Tool Options for Unigraf UCD-500.pdf. It can be 

downloaded in Unigraf Document Center at https://www.unigraf.fi/documents/. If you have any 

additional questions, please contact Unigraf or your local representative. 

Compliance tests (CTS Tests) are part of tests included in Source DUT Testing tab of DP RX and 

Sink DUT Testing tab of DP TX. 

The tests cases are divided into test categories as described in Appendix E of this document. Test 

categories are placed in sub-tabs. Test category tabs are enabled based on licenses present. Please 

refer to chapter 3 License Manager earlier in this document. 

Test Parameters 

Before running the tests, capabilities of the DUT have to be defined for the test engine. Each test 

category has its dedicated test parameter dialog. Click Configure in Source DUT Testing or Sink 

DUT Testing tab to open the parameter dialog. 

For a detailed description of capabilities listed on the tab please refer to Chapter 3 Compliance Test 

Operation of document VESA DisplayPort Link Layer Compliance Test Specification. 

  

https://www.unigraf.fi/documents/
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DP 2.1 LL LTTPR CTS CR iteration delay 

Debug options allows users to manually set the CR iteration delay. To access debug options to set 

the CR iteration delay, select a test from DP 2.1 LL LTTPR CTS test set and click Configure. 

 

 

 

Note: Please make sure that the capability tables are completed before running the tests. The result of the 

test might be misleading if the DUT capabilities and the table do not match. 

DSC Test Content 

When running DSC Compliance Tests, Console needs to have access to DSC content used as test 

patterns. This content will be automatically created during test execution. Creation of the test content 

takes time and considerably slows down the execution of the test. To avoid this after the first test run, 

users are able to save the created DSC content by selecting the option Keep auto-created DSC 

content files described below.  

Warning  Please note, that the space needed for storing the full library can be very large 

(appr. 400 GBytes). Please make sure that the content will be stored in a medium that has the 

required space available. 

Options 

In Tools > Options menu you can define DSC Work folder and DSC test content directory.  

DSC temp folder: Folder for DSC Work files. 

DSC test content folder: Folder where DSC source bitmap files, related 

configuration files and DSC conversion tools are stored. 

Keep auto-created DSC content files: By default, the DSC compressed content is deleted after 

use. If selected, the content is not deleted 
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Running CTS Tests 
Source DUT Testing and Sink DUT Testing tabs include the tests enabled with the set of licenses 

present in UCD Console grouped in test set tabs. In tabs the tests are listed by the test name and 

reference number as in applicable compliance test specification. UCD-5XX firmware implements the 

test according to the test specification.  

Test flow parameters like Test timeout and Test cycle delay can be defined in Test Parameter dialog 

launched by clicking Configure. 

Select the tests for execution by clicking the corresponding row. For selecting multiple consecutive 

tests in the list hold down the Shift key of your keyboard while selecting the tests. For selecting 

multiple individual tests hold down the Ctrl key in your keyboard while selecting. 

Run Selected Click to start selected tests. By clicking Abort the sequence is stopped. 

Select: Includes the following options for creating templates for tests execution: 

Select All, Clear All, Invert All, Save, Import and Export 

Configure Clicking opens a dialog for defining the test parameters for that set. Please 

refer to Test Parameters below for description. 

Import: Load saved test parameter files (*.td or *.json). 

Export: Save test parameters for later use or for use in test automation. For saving 

parameters for later use in UCD Console, either format can be used. For 

saving parameters for TSI scripting, please use *.td files. For use with Python 

applications, please use *.json files. 

Stop on Failure: Stops execution of the selected tests if one of the tests fail 

Repeats: Repeat the selected test several times. 

When repeating a sequence of tests, all selected tests are performed in each 

repetition. E.g., when you repeat tests 1, 2 and 3 two times, the sequence is: 

1, 2, 3, 1, 2, 3. 

Delay time Delay in seconds between individual tests. 

 

Save Report: Click to generate a report file in HTML format for sharing the results with 

other parties for viewing without UCD Console. 

Clear All Clear the test log and the results matrix 
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Saving Test Parameters 

Test parameters can be saved in various ways. 

• Export parameters in Sink/Source DUT Testing tab to a *.td file for later use in UCD Console or 

with TSI scripting or sharing. 

• Export parameters in Sink/Source DUT Testing tab to a *.json file for later use in UCD Console 

or with Python applications or sharing. 

• Save parameters in Configure dialog as Presets to be later used in Console. Please find a 

description below. 

Presets 

In all Configure dialogs the selected parameters can be saved as Presets. Please click Presets… to 

save or recall a configuration. Click Save first to assign the configuration a name, and after that you 

can e.g. Export it to a file. 

Operator Feedback 

In some compliance tests operator action or feedback is required for items that the test itself cannot 

perform or confirm. In these cases test opens a pop-up dialog. In the dialog the operator is instructed 

about items to do or to be verified and buttons for providing the “Proceed” instruction or “Pass” and 

“Fail” feedback. 

Clicking “Abort” stops execution of the test. 
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Evaluating CTS Test Results 
The test procedure advancement can be monitored in the Test Log panel. It describes the steps of 

each individual test in the way defined in the corresponding VESA Compliance Test Specification. 

Please use the Status Log and Specification side by side when interpreting the results. 

At the completion of each test the result of the test is indicated in the matrix on the right hand side of 

the test panel. For each test the matrix lists the number of occurrences of each result and the number 

of tries performed. 
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Test Report 
Results of the test can be saved as a report in HTML format.  

Viewing the CTS Test Report 

The report file can be viewed with any HTML browser. The report has built-in views for Report 

Summary, Test Summary, and individual tests. 

 

DUT Testing Options 

Please refer to Tools > Options earlier in this manual for control on including system date and time in 

the beginning of each event line in created reports.  
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Audio Test Set 

Validate audio signal frequency and glitch-free audio reproduction 

Perform frequency check on the digital audio content and verify the content to be glitch-free. This 

test assumes that a pure sine-wave audio signal content is being transmitted to the test equipment. 

The test will first capture a minimum of one second of audio content. The audio is then analyzed in 

two stages.  

First, the power spectrum is calculated, and the highest peak must be within the defined window. 

Resolution of the peak frequency check is better than ±1 Hz.  

In the second stage, received audio is checked for random glitches, such as dropped or duplicated 

samples.  

The test is considered passed if power of audio content spectrum has its maximum within the defined 

window, and the number of detected audio glitches does not exceed programmed limit. 

Parameters in use 

▪ Expected sampling rate of audio signal (default 44 100 s/sec) 

▪ Expected audible (sine) frequency in Hz (default 1000 Hz) 

▪ Allowed deviation from expected frequency in Hz (default 1 Hz) 

▪ Number of audio glitches allowed per test (default 0) 

▪ Tested audio save conditions (Save none / Save failed / Save all) 

 

Click Location where the captured audio is to be saved to browse for the folder to store tests.  
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CRC Based Video Test Set 

Role: Product: 

DP Reference Sink (DP RX) UCD-500 and Gen 2 

Configuration 

 

 

Test timeout: If enabled test will abort when the time has elapsed 

Repeat until timeout: Omit “Test length” parameter 

Test length (# frames): Number of captured frames to test 

Errors allowed (# frames): Number of failing frames allowed before test Fails 

Repeat “Sequence Test” until timeout: 
Repeat test sequence until the timeout set (length 

parameter below omitted) 

“Sequence Test” length Repeat count of the “Sequence Test” 

Expected Video Format Format of the signal expected 

Expected Frame Rate: 
Verify stability of the video signal. Verification 

disabled if Expected Frame Rate is set to “0” 

Number of captured reference 

frames: 
Number of frames stored as reference 

Capture Reference Frames: Capture reference frames for the test 

Folder to save failed frames: PC folder where failed frames are stored. 

Max number of saved frames: Maximum number of failed frames stored to PC 

Format of saved frames: 
Select saved image format (Binary file, PPM image, 

BMP image) 

Align 12 

12bpc values are be shifted to MSB of a 16bits 

container. If not checked, 12 LSB are used to store 

colour component values. 

Presets: Store and recall settings 
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CRC Based Single Reference Frame Video Test 

The test compares captured frames to a captured reference. In Configure dialog, please select 1 to 

CRC Capture length and click Capture Now. 

TE compares the video mode (Frame Width, Height, BPP and optionally Frame rate) to provided 

parameters and after that captures frames and compares the CRC (check sum) of their three color 

components to the provided reference until the number of bad frame limit provided is detected or the 

provided total number of frames is reached.  

The test is judged FAIL if video mode does not match, or the number of bad frames is exceeded. 

The test optionally captures the failed frames as bitmap images and stores them into the hard disc. 

Parameters in use 

▪ Test Timeout (default 10 000 ms) 

▪ Total number of frames (default 2 00 ms) 

▪ Number of bad frames allowed (default 20) 

▪ Reference width (default 1920) 

▪ Reference height (default 1080) 

▪ Reference BPP (default 24) 

▪ Expected frame rate (mHz, 1/1000 Hz) 

▪ Frame rate tolerance (mHz, 1/1000 Hz) 

▪ Reference CRCs (R, G, B) 

CRC Based Single Frame Video Stability Test 

The test verifies that the captured video is stable. 

TE captures a frame and sets the CRC of its color components as reference. After that TE captures 

frames and compares their CRC (check sum) to the reference until the number of bad frame limit 

provided is detected or the provided total number of frames is reached.  

The test is judged FAIL if the number of bad frames is exceeded. 

The test optionally captures the failed frames as bitmap images and stores them into the hard disc. 

Parameters in use 

▪ Test Timeout (default 100 00 ms) 

▪ Total number of frames (default 200 ms) 

▪ Number of bad frames allowed (default 20) 
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CRC Based Sequence of Reference Frames Test 

The verifies that a sequence of frames is captured in the right order. 

TE compares the video mode (frame Width, Height, BPP and optionally Frame rate) to provided 

parameters. After that captures frames to find a frame with matching CRC (check sum) of their three 

color components to the first provided reference. After the first matching CRC is found it compares 

the CRC of the following frames until the Number of frames tested parameter is reached.  

The test is judged FAIL if video mode does not match, the first frame in the list is not found or the 

CRC of the following frames do not match the provided list. 

The test optionally captures the failed frames as bitmap images and stores them into the hard disc. 

Parameters in use 

• Test Timeout (default 10 000 ms) 

• Number of frames to be tested (default 20) 

• Reference width (default 1920) 

• Reference height (default 1080) 

• Reference BPP (default 24) 

• Expected frame rate (mHz, 1/1000 Hz) 

• Frame rate tolerance (mHz, 1/1000 Hz) 

• Reference CRCs (R, G, B) 

Note: Please note that in order for the TE to maintain the sequence, all CRCs in the reference frame list 

should be different. 

CRC Based Continuous Sequence of Reference Frames Test 

The test verifies that a sequence of frames is captured in the right order many times repeatedly. 

TE compares the video mode (frame Width, Height, BPP and optionally Frame rate and Color format) 

to provided parameters. After that captures frames to find a frame with matching CRC (check sum) 

of their three color components to the first provided reference. After the first matching CRC is found 

it compares the CRC of the following frames until the Number of frames tested parameter is reached. 

After that it resets the list and starts from the first CRC. The list is repeated until timeout or until the 

provided number of repetitions is reached. 

The test is judged FAIL if video mode does not match, the first frame in the list is not found or the 

CRC of the following frames do not match the provided list. 

The test optionally captures the failed frames as bitmap images and stores them into the hard disc. 

Parameters in use 

• Test Timeout (default 10 000 ms) 

• Number of frames to be tested (default 20) 

• Number of iterations 

• Reference width (default 1920) 

• Reference height (default 1080) 

• Reference BPP (default 24) 

• Expected frame rate (mHz, 1/1000 Hz) 

• Frame rate tolerance (mHz, 1/1000 Hz) 

• Expected color format 

• Reference CRCs (R, G, B) 

Note: Please note that in order for the TE to maintain the sequence, all CRCs in the reference frame list 

should be different. 
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Link Config Tests 

Link Training at All Supported Lane Counts and Link Rates 

Test requests link training on all supported lane counts and link rates. Each link training must be 

successfully completed in order to pass the test. 

In Configure, please define the parameters for the test. 

Parameters in use 

• Test Timeout (default 5 000 ms) 

• Max lane count supported by DUT (default 4) 

• Max lane rate supported by DUT. 

• Long HPD pulse duration (default 1 000 ms) 

• Link training start timeout (default 5 000 ms) 

• Delay between test cycles (default 3 000 ms) 
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Pixel Level Video Tests 

Compare Video Frame Sequence with a Single Reference 

The test compares captured frames to the provided reference image on pixel level by buffering the 

indicated number of captured frames first in the local UCD device frame buffer and after that 

downloads them to the PC for evaluation. 

The test compares the captured frames to a provided reference image on pixel level.  

• The color component values of each pixel in the captured frame is compared to the 

corresponding pixels in the reference image.  

• If the difference is larger than the provided tolerance, the pixel is considered failed. 

• If the number of failed pixels in a frame is larger than the provided tolerance, the frame is 

considered failed. 

• If the number of failed frames in the test is larger than the provided tolerance, the test is 

considered failed. 

• Failed frames can be stored for evaluation. 

Load image: Load the reference image 

Image resolution: Video resolution expected 

Image format: Image format expected 

Bits per component: Bits per component expected 

Data format: Video data format expected 

Frames count: Number of frames buffered for testing 

Maximum number of failed frames 

allowed per test: 

Number of failed frames allowed totally 

Maximum number of failed frames 

allowed per test: 

Number of failed pixels allowed per buffered frame 

Tolerance between pixel values: The allowed difference between a color component of 

pixel in the captured frame to the reference bitmap. 

Folder to save failed images: PC folder where failed frames are stored. 

Maximum number of exported frames: Maximum number of failed frames saved to PC 

Export format: Format of saved failed frames: Binary file, PPM image,  

BMP image 
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Presets: Store and recall settings 

 

Capturing Reference Image 

Users can use the received video as reference. Make sure you are receiving video first.  

1. In Settings dialog click the enable preview icon . 

2. When the preview has been enabled click the Capture reference icon  to store a frame and use 

it as reference. Before accepting the frame, the stability of the video is verified with a CRC stability 

check. Captured CRC can also be verified by the user. 
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APPENDIX F: VTP PATTERN LANGUAGE 

General 
The Vpattern definition language (in the following simply “VTP”) is a straightforward yet flexible way 

of describing test patterns for UCD Generators. This description provides an introduction and 

examples of the most usable instructions and parameters.  

The VTP language uses text command syntax. Each row represents one drawing instruction. The 

coordinate system can be either absolute or scaled. In the absolute mode the actual pixel position is 

referred while in the scaled mode the coordinates refer to the “Drawing resolution” used while 

drawing. For both absolute and scaling coordinates the origin is the upper left hand corner of the 

screen. 

Terminology 

The following terms are used in this document: 

Coordinate system: two numerical ranges of integer, positive numbers. E.g. {0,799},{0,599} or 

{0,10000},{0,10000}. 

Coordinates: a tuple of integer, positive numbers used to address a position on an image, e.g. 

(100,250). The first number is the horizontal position, the second one the vertical position. The actual 

position is always related to the coordinate system currently in use. 

Drawing resolution: the width and height of the space that can be used for drawing, expressed in 

pixels. E.g., 2560 by 1600. 

Drawing area: a 2-dimensional area spanning all of the drawing resolution, expressed in the current 

coordinate system notation. E.g., if the drawing resolution is 800 x 600 pixels, the drawing area 

includes all points (x,y) where x = 0 to 799 and y = 0 to 599 in ABSOLUTE mode or x = 0 to 10000 

and y = 0 to 10000 in SCALED mode. 

Notation 

The following notation is used in this document: 

• A token is enclosed by characters ‘<’ and ‘>’. For instance, <variable> represents a generic 

variable. 

• Different legal choices for a command parameter are separated by character ‘|’. For instance, 

<variable> | <number> means that either variable or number can be used as parameters. 

• Items that can be repeated 0, 1 or more times are preceded by ‘{‘ and followed by ‘}*’. For 

instance {<number>}* means zero, one or more occurrences of a number.  

Syntax rules 

The following general syntax rules apply to VTP language files: 

• VTP is a text-based, interpreted language. 

• Commands, variables, and constant names are not case-sensitive. 

• All text at the right of a semicolon (‘;’) is treated as comment. 

• All strings are delimited by quotation marks (“a string”). Quote and backslash characters must 

be prefixed by the backslash symbols (“ a quote \” and “ a backslash \\”). 

• Filenames cannot contain pathnames. 
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Commands 

Scaling commands 

All drawing commands using coordinates can refer either to absolute or scaled coordinates. The 

absolute coordinate system starts at 0 and its measurement unit is the pixel (vertically the line). It 

extends up to the maximum drawing resolution in use minus one, expressed in pixels too. 

Conversely, the scaled coordinate system ranges from 0 to 10000, independently from the drawing 

resolution. Its measurement unit is thus a flexible, virtual pixel. 

Absolute coordinates provide the fastest drawing speed, but they are resolution specific. Scaled 

coordinates are resolution independent while introducing a slight speed penalization. 

For both systems, the origin (0,0) refers to the upper left hand corner of the screen. 

ABSOLUTE 

Syntax: ABSOLUTE 

This command is normally used in the beginning of the VTP file. All drawing commands issued after 

ABSOLUTE will have absolute coordinate values, i.e., their coordinates will be interpreted as pixels 

and lines.  

The allowed coordinate values are from 0 to the maximum drawing resolution minus one. For 

instance, for a drawing resolution of 2560 x 1600 pixels, the allowed coordinate range (x,y) for x is 0 

to 2559 and for y 0 to 1599. 

Constants MAXX and MAXY can be used in place of the numeric values to achieve basic scaling 

capabilities.  

SCALED 

Syntax: SCALED 

All drawing commands issued after the SCALED command will have their coordinates interpreted as 

within a range from 0 to 10000 (10001 possible coordinate values), regardless of the current drawing 

resolution. Positioning can be calculated as percentages. If you wanted to address a point at 50% of 

the drawing resolution, then you would use the number 5000. If you wanted 75% you would simply 

use 7500. 
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Graphics Drawing Commands 

All of the following graphics drawing commands use the currently selected foreground color for shape 

perimeter and filling. 

LINE 

Syntax: LINE x1 y1 x2 y2 

Draws a line from point (x1,y1) to point (x2,y2). 

Example: 

You can draw a white diagonal cross using either ABSOLUTE or SCALED coordinate mode and get 

the same result. 

ABSOLUTE ; Set scaling mode to absolute. 

COLORDEPTH 8 ; 8 bits per color 

COLORRGB 255 255 255 ; white 

LINE 0 0 MAXX MAXY ; Draw a line from upper left to lower right corner. 

LINE 0 MAXY MAXX 0 ; Draw a line from lower left to upper right corner. 

Or if you want a fixed size for 640 x 480 resolution 

LINE 0 0 639 479 

LINE 0 479 639 0 

 

The pattern will look like this:  

Using SCALED instead of ABSOLUTE. 

SCALED 

COLORDEPTH 8 

COLORRGB 255 255 255 

LINE 0 0 10000 10000 

LINE 0 10000 10000 0 

BOX 

Syntax: BOX x1 y1 x2 y2 

Draws a filled rectangle with upper left corner (x1,y1) and lower right corner (x2,y2). 

Example: 

This code will create a full white screen with all resolutions. 

SCALED 

COLORDEPTH 8 

COLORRGB 255 255 255 

BOX 0 0 10000 10000 

  

(0,0) (MAXX,0) 

(MAXX,MAXY) (0,MAXY) 
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DOT 

Syntax: DOT x y 

Draws a single dot at location (x,y). 

FILL 

Syntax FILL x y 

Initiates a flood fill (or seed fill) with foreground color starting from position (x,y).  

CIRCLE 

Syntax: CIRCLE x y r 

Draws a circle with center point at (x,y) and radius r. Please, note that when using SCALED 

coordinates radius r is expressed using reference to vertical maximum. 

Example: 

SCALED 

COLORDEPTH 8 

COLORRGB 255 255 255 

CIRCLE 5000 5000 2500 

The pattern will look like this:  

FCIRCLE 

Syntax: FCIRCLE x y r 

Draws a circle with center point at (x,y) and radius r. Filled with foreground color. Please, note that 

when using SCALED coordinates radius r is expressed using reference to vertical maximum. 

The pattern will look like this: 
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ELLIPSE 

Syntax: ELLIPSE x y hr vr 

Draws an ellipse with center point at (x,y), horizontal radius hr and vertical radius vr. 

You can use ELLIPSE instead of CIRCLE for example for compensating the stretching in applications 

where the displayed pixel is not square. 

Example: 

SCALED 

COLORDEPTH 8 

COLORRGB 255 255 255 

ELLIPSE 5000 5000 3000 4000 

The pattern will look like this: 

Text Drawing Commands 

All of the following commands use the currently selected foreground color for the “foreground” pixels 

of the font and the currently selected background color for “background” pixels. 

TEXTPOS 

Syntax: TEXTPOS x y 

Sets the text drawing position to point (x,y).  

TEXT 

Syntax: TEXT <string> | <var> | <const> { <string> | <var> | <const> }* 

The command executes a CR and LF (carriage return and line feed) and then draws a text string 

<string>, a variable <var>, a constant <const> or a combination of them starting from the current text 

position.  

<string> parameter is a quoted sequence of characters. If the string contains a quote character (“) or 

a backslash character (\) then it must be preceded with a back slash character (\). 

<var> is a parameter variable (A – Z, MAXX, MAXY) defined by SET command. 

<const> one of the Timing Variables. Timing variables are defined by currently loaded timing 

parameters. Please refer to Chapter 3. 

 

Example: 

ABSOLUTE 

COLORDEPTH 8 

COLORRGB 255 255 255 

TEXTPOS 100 100  ; Text starting point 100 pixels from left edge and  

 ; 100 display lines down from top 

TEXT “HRES=” HR “ PIXELS” ; This will draw the text HRES then the value of variable HR  

; and PIXELS 

TEXT “Quote character \” and backslash \\” 
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Program Flow Commands 

REPEAT 

Syntax: REPEAT <variable> a b s 

All commands after between REPEAT and END command are repeated the number of times defined 

by <variable>. <variable> is set to value a before starting the first iteration loop. At the end of each 

iteration, variable is incremented by s (variable = variable + s). The REPEAT is terminated when 

variable reaches or exceeds value b, and the execution continues from the command following the 

END command. For example: 

SCALED 

COLORDEPTH 8 

COLORRGB 255 255 255 

REPEAT W 0 10000 200 

LINE W 0 W 10000 

END 

A maximum of 2 REPEAT loops can be nested (placed inside each other). 

END 

Syntax: END 

This command follows a REPEAT command and defines a group of instructions to be repeated. 
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Color Commands 

COLORDEPTH 

Syntax: COLORDEPTH n 

The command is used in True Color Mode (COLORMODE 2), to define the number of bits used for 

each color component (R, G and B) of the data to be displayed. Possible values for parameter “n” are 

6, 8, 10 and 12.  

If COLORDEPTH command is not used, 10 bits per color is used.  

Example: To display a bitmap that uses 8 bits for r, g and b (24-bit colors) you have to use 

COLORDEPTH 8.  

Command Nr of color bits Range of values for R, G and B 

COLORDEPTH 6 18 0 to 63 

COLORDEPTH 8 24 0 to 255 

COLORDEPTH 10 30 0 to 1023 

COLORDEPTH 12 36 0 to 4095 

 

COLORDEPTH can be used only once in a VTP file, and it has to be placed before all drawing 

instructions it is supposed to affect. 

COLORRGB 

Syntax: COLORRGB r g b 

The command defines the foreground color used for the following drawing commands. The command 

is used in True Color Mode only. 

The range of values for r, g and b depends on the bits per color used. If not changed with 

COLORDEPTH command, 10 bits per color is used. Please refer to COLORDEPTH command for 

range of values. 

Various Commands 

SET 

Syntax: SET <variable> n 

Assigns value n to programming variable called variable. n must be a positive number or zero. 
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Variables 

Timing Variables 

 

Timing Variable Value name 

HF  Drawing resolution horizontal size minus one 

HP  Drawing resolution vertical size minus one 

HR  Current timing horizontal frequency (MHz?) 

HA  Current timing horizontal period (pixels) 

HS  Current timing horizontal resolution (pixels) 

HBP  Current timing horizontal active time (pixels) 

HFP  Current timing horizontal sync length (pixels) 

VF  Current timing horizontal back porch length (pixels) 

VP  Current timing horizontal front porch length (pixels) 

VR  Current timing vertical frequency (MHz?) 

VA  Current timing vertical period (lines) 

VS  Current timing vertical resolution (lines) 

VBP  Current timing vertical active time (lines) 

VFP  Current timing vertical sync length (lines) 

PF  Current timing vertical back porch length (lines) 

HLB  Current timing vertical front porch length (lines) 

HRB  Pixel frequency (Mpps?) 

VTB Drawing resolution horizontal size minus one 

VBB  Drawing resolution vertical size minus one 

 

Expressions 

Any command numeric parameter can be replaced by an expression, according to the syntax below: 

<term> ::= <variable> | <constant> | <number> 

<expression> ::= <term> { ‘+’ | ‘-‘ | ‘*’ | ‘/’ | ‘%’ }  <term> 

<parameter> ::= <term> | <expression> 

Some example of legal parameter values: 

B 

MAXX 

342 

B + MAXX 

B / 2 

B * C 

Expressions always have positive integers or zero value. When an expression is evaluated to a 

negative value, it is set automatically to zero. Number values are also always positive integers or zero. 
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Assignments 

A variable can be assigned a numerical value by using the SET command. 

The second parameter of the SET command can be replaced by an expression thus allowing 

commands like those here below: 

SET C B+MAXX 

SET K K+1 

SET K A+B 

Default state at VTP execution startup 

 

Coordinate system: ABSOLUTE 

Foreground color: 1023 1023 1023 

Background color: 0 0 0 

Image: Output image is cleared (all black) 

Variables: All variables are initialized to zero 

Color depth: COLORDEPTH 10 
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APPENDIX G: FIRMWARE RECOVERY 
The chapter below describes a procedure for recovering Firmware of UCD-5XX unit in a case when 

e.g., the normal FW Update procedure failed because of a critical error.  

Note The firmware recovery procedure is only available for Windows operating system. 

Downloading Tools 
The Recovery patch is programmed to UCD Device with a separate tool called  

Intel® Quartus® Prime Pro Edition Programmer and Tools. The tool can be downloaded from 

Intel® FPGA website: 

https://www.intel.com/content/www/us/en/software-kit/746667/intel-quartus-prime-pro-edition-

design-software-version-22-3-for-windows.html 

1. On the download page, please select section “Additional Software”. Please download the 

software under “Intel® Quartus® Prime Pro Edition Programmer and Tools”. 

2. Please download and install the tool using default option in the PC. 
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Step 1 
1. Connect the UCD device to the power supply and switch on power.  

2. Connect the UCD device with a USB cable to the PC through USB connector (Please refer to 

chapter Product Description > Connections earlier in this document) 

3. Please locate the UCD-5xx_recovery.zip file. By default the file is stored in C:\Program 

Files\Unigraf\Unigraf UCD Tools\recovery 

4. Extract the content of the ZIP file in a folder in your PC, e.g., C:\Temp 

5. Open Windows Command Prompt application 

6. Change current directory to where the ZIP file was extracted (e.g. cd \Temp) 

7. Connect a micro-USB cable to JTAG connector in the UCD device (Please refer to chapter 

Product Description > Connections earlier in this document). 

8. In the directory where the ZIP file was extrected (e.g. c:\Temp) please edit file recovery.bat 

9. On line three (3) parameter “QUARTUS_DIR” is set to point to the folder where the Qartus 

Programmer was installed (by default C:\intelFPGA_pro\22.3). If needed, please edit line three 

to match. Please save the file. 

10. In Windows Command Prompt application please make sure that current directory is still the 

same (e.g. C:\temp) 

11. Launch batch recovery.bat 

12. Please wait until the batch file has been completed (may take up to several minutes). 

Step 2 
Perform FW update procedure as described in section Installation > Firmware Update Procedure 

earlier in this manual. 

After Recovery procedure has been completed, you can delete the files stored in e.g., C:\Temp. 
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APPENDIX H: PLAYLISTS AND SCENARIOS 
UCD Console’s Playback enables you to run scripts called playlists. Use playlists to stream video, 

audio and metadata. See the Unigraf UCD Console Playback Tutorial at 

www.unigraf.fi/resource/tutorial-run-edit-and-create-sdr-and-hdr-scenarios-with-unigrafs-playback-

tool/ 

Playlist 

A Playlist is a text script consisting of a [Device] block and [Scenario] block(s). A [Device] block lists 

the serial number of the device and connectortype (such as a displayport transmitter). [Scenarios] 

blocks have a caption (which are used to display sample content), a period (Scenario duration in 

milliseconds) and a relative path to a script text file (ex. Scenario_PSR1_Entry_N.txt). Scenarios are 

played in sequence.  

Scenario 

A scenario is a script text file to specify a sequence of video frames, metadata packets and audio to 

be transmitted. 

Frame Memory 

Before transmission content is loaded to frame memory buffer of the UCD device. Frame buffer 

memory limits content (number of frames) that can be played. UCD-5XX devices by default feature 

16 gigabytes of memory. This enables loading up to 320 4K or 80 8K video frames. Contact Unigraf 

for information for larger frame buffer sizes. 

Sample Content 

You can us sample content as a basis for creating custom test sequences: see UCD Console Playback 

tab. Sample content is stored by default (on Windows) at C:\Program Files\Unigraf\Unigraf UCD 

Tools\Resources\playback\content. See Sample Content in Playback Tab in this Appendix. 

 

https://unigraf.sharepoint.com/sites/Products/Jaetut%20asiakirjat/General/User%20Manuals%203.5/www.unigraf.fi/resource/tutorial-run-edit-and-create-sdr-and-hdr-scenarios-with-unigrafs-playback-tool
https://unigraf.sharepoint.com/sites/Products/Jaetut%20asiakirjat/General/User%20Manuals%203.5/www.unigraf.fi/resource/tutorial-run-edit-and-create-sdr-and-hdr-scenarios-with-unigrafs-playback-tool
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Playlists 

A playlist defines the UCD device to be used and the output destination for transmission. It lists 

scenarios the played (video and audio sequences including metadata) to be transmitted and their 

duration.  

Note: Playlists and Scenarios are technology dependent. Metadata (or packets) differ for HDMI and 

DisplayPort. 

Device block  

Device block describes the device and output connector type. 

Key  Description  Possible values  

[Device] Required. Start of the Device block.  

serialnumber  Required. Serial number of the UCD device.  

The ‘*’ wildcard can be used if only one UCD source 

device is connected to the PC.  

‘*’  

‘1722C333’  

connectortype  Required. Output connector type to be used. Playlists 

shall not contain scenarios for different connector 

types.  

‘HDMI Out’  

‘DisplayPort Out’  

‘USBC Out’  

reset  Only applies to UCD-323.  

Scenario block  

Scenario block describes a scenario and its playback parameters. Playlists run scenarios in the order 

they are listed. 

Key  Description  Possible values  

[Scenario] Required. Start of a Scenario block. Playlists can have 

multiple Scenario blocks. 

 

caption  

 

Optional. Title. Any character string accepted.  ‘Scenario 1’  

‘SDR - HDR’ 

path  Required. Specifies relative path to scenario file.  Any valid path  

period  Required. Duration of scenario transmission in 

milliseconds. The duration is ignored if close-after-

upload is set to ‘1’.  

‘60000’  

‘5000’  

close-after-upload Optional. When set to ‘1’, command line version of 

the Playback tool will exit after loading scenario 

content and starting playback.  

‘0’ or ‘1’  

Default ‘0’ 

execute-after-upload Optional. Executes provided command in cmd.exe or 

bash and waits for its completion. Calculation of 

‘period’ starts after the command is executed. 

‘script.bat && dir’  

‘rmdir 

/home/user/test/’ 
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Scenarios 

A Scenario is text file for specifying a specific sequence of video frames, events (packets) and audio 

to be played in order. Scenarios also set up the device state for transmission.  

Parameters 
Scenario parameters are defined below. 

Scenario item Description 

video Relative path of (first numbered or only) video frame file 

audio Relative path of audio file 

packets Relative path of (first numbered or only) metadata packet file 

porder  Play order. See Content Playing Order below. 

align12 Alignment of 12-bit binary pixel data. ‘1’ aligned to LSB; ‘0’ aligned to MSB. 

audioswap ‘1’ for Little Endian audio samples 

audiocompressed ‘1’ compressed audio; ‘0’ uncompressed audio 

audiosampling Audio sampling rate (e.g., 44100) 

audiochannels   Number of audio channels 

audiobits Audio bits per sample (usually 16 or 24) 

scrambler ‘1’ scrambling enabled; ‘0’ scrambling disabled 

audiosync Audio sync 

colorspace Video color space: RGB; YUV444; YUV422; YUV420 

bitspercolor Video color depth (bits per color) 

timing.hactive Timing: horizontal active 

timing.vactive Timing: vertical active 

timing.htotal Timing: horizontal total 

timing.vtotal Timing: vertical total 

timing.hstart Timing: horizontal start 

timing.vstart Timing: vertical start 

timing.hsync Timing: horizontal sync width 

timing.vsync Timing: vertical sync width 

timing.frate Timing: framerate in milliseconds 

hdcp HDCP version used (can be 1.4 2.3 or ‘none’) 

loadingRGB 
The R, G and B color components of uniform color pattern shown when content 

is being uploaded to the device before playback (e.g., 0,0,0) 

linkRate 

Default link rate.  

HDMI: 0 = TMDS; 1 – 5 = FRL with 3, 6, 8, 10 and 12 Gbps link rate. 

DP: Link rate = Value × 0.27 Gbps. (E.g., 20 = 5.4 Gbps/lane (HBR2)). 

linkRateMin Minimum link rate desired. Scenario will fail if not achieved 

DSC timing 

parameters 

 

Parameters are different for DP and HDMI. See below. 
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DSC Timing parameters for HDMI 

dscFrameRate DSC Timing: Frame rate [fps] × 1000 

dscHcactive DSC Timing: Horizontal active 

dscHcblank DSC Timing: Horizontal blank 

dscVtotal DSC Timing: Vertical total 

dscVsync DSC Timing: Vertical sync 

dscVstart DSC Timing: Vertical start 

dscVactive DSC Timing: Vertical active 

 

DSC Timing parameters for DP 

dscFrameRate DSC Timing: Frame rate [fps] × 1000 

dscVtotal DSC Timing: Vertical total 

dscVsync DSC Timing: Vertical sync 

dscVstart DSC Timing: Vertical start 

dscVactive DSC Timing: Vertical active 

dscHtota DSC Timing: Horizontal total 

dscHsyn DSC Timing: Horizontal sync 

dscHstart DSC Timing: Horizontal start 

dscHactive DSC Timing: Horizontal active 
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Content Play Order 

Play order is a sequence of steps. Steps are delimited with semicolons (;).  

Each step has:  

Range (possibly numbered e.g. allm_000.jpg, allm_001.jpg, …) of video frame(s)  

How many times the frame(s) are played 

Packet(s) (possibly numbered e.g. allm_0.bin, allm_1.bin, …) indices to be sent during the video 

frame(s) transmission  

Color format 

Optional frame rate when VRR/Adaptive-Sync is enabled 

Format  

Each scenario step is of the form:  

pV:R:E:FvXX; 

Parameters  

Сhar  Description  Possible 

values  

Examples  

:  Separator between step parameters.  ‘:’  See below  

;  Step delimiter.  ‘;’  See below  

p  Not used with UCD-5XX. ‘p’    

V  Required. Video frame indices (zero based). Parameters 

are applied to all frames in the step. Images (possibly 

numbered) are loaded from the video file path. 

‘1’  

‘1,2,5’ 

‘0-59’  

‘1:60:16:256;’ 

‘1,2,5:60:16:256;’ 

 ‘0-59:60:16:256;’  

R  Required. Repetitions of current step.  

For example, ‘1’ with 60 FPS frame rate means that 

current step will be played only for 1/60 of a second.  

‘30’  

‘1’  

‘1:30:16:256;’  

‘1:1:16:256;’  

E  Optional. Metadata packet indices (zero based): A single 

packet or a comma separated list of packets. 

The index may be of the form 3l15 (lower case ‘l’).   

At which vertical line do we want to put our packet in. 

3l15 means insert packet 3 at line 15. 

Packets are loaded from the packets path. 

‘0’  

‘4,1,29’  

none 

 3l15 

 

‘1:30:0:256;’  

‘1:30:4,1,29:256;’  

‘1:30::256;’  

0:10000:3l15:256; 

 

F  Required. Color format and color depth.  

See Color Format below.  

‘256’  

‘513’  

‘1:30:0:256;’ 

‘1:30:0:513;’  

vXX  Optional. Frame rate when VRR/Adaptive-Sync is 

enabled. The parameter is in the form ‘vXX’, where ‘XX’ 

is the frame rate.  

‘v60’  

‘v30’  

‘1:30:0:256v60;’  

‘1:30:0:256v30;’  
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Color Format  

Color format is a two-byte decimal value. The lower byte provides an index to used color space and 

the higher byte an index to the color depth. Please find the indexes in the table below. 

Index Color Depth  

(bits/color) 

Color Space 

0 6 RGB 

1 8 YCbCr 4:4:4 

2 10 YCbCr 4:2:2 

3 12 YCbCr 4:2:0 

4 16 – 

 

The parameter value is encoded as follows:  

[Color Depth] × 256 + [Color Space],  

where [Color Depth] and [Color Space] are indices from the table above. 

For example, parameter for YCbCr 4:4:4, 10 bits is ( 2 × 256 + 1 ) = 513.  

Pre-calculated values for available color formats are shown below: 

 6 BPC 8 BPC 10 BPC 12 BPC 16 BPC 

RGB  0 256 512 768 1024 

YCbCr 4:4:4  N/A 257 513 769 1025 

YCbCr 4:2:2  N/A 258 514 770 1026 

YCbCr 4:2:0  N/A 259 515 771 1027 
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Example 
Below is a playlist example: SDR-HDR-HLG – DP. 

Playlist file (Playlist SDR-HDR-HLG - DP.txt) 

Playlist item and example content Description 

[Device] Start of device section 

Serialnumber = * Only one UCD device present. 

Connectortype = DisplayPort Out DisplayPort output 

[Scenario] Start of Scenario 1 

caption = SDR Scenario title “SDR” 

period = 10000 Duration 10 sec 

path = Scenario_SDR_DP.txt Scenario file: Scenario_SDR_DP.txt in current folder 

[Scenario] Start of Scenario 2 

caption = HDR Scenario title “HDR” 

period = 10000 Duration 10 sec 

path = Scenario_HDR_DP.txt Scenario file: Scenario_HDR_DP.txt in current folder 

[Scenario] Start of Scenario 3 

caption = HLG Scenario title “HLG” 

period = 10000 Duration 10 sec 

path = Scenario_HLG_DP.txt Scenario file: Scenario_HLG_DP.txt in current folder 

[Scenario] Start of Scenario 4 

caption = SDR – HDR Scenario title “SDR – HDR” 

period = 10000 Duration 10 sec 

path = Scenario_SDR-HDR_DP.txt Scenario file: Scenario_SDR-HDR_DP.txt in current folder 

[Scenario] Start of Scenario 5 

caption = SDR – HLG Scenario title “SDR – HLG” 

period = 10000 Duration 10 sec 

path = Scenario_HDR_DP.txt Scenario file: Scenario_SDR-HLG_DP.txt in current folder 
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Scenario File (Scenario_SDR-HDR-DP.txt) 

Scenario item and example content Description 

video=goldenGate0.jpg Video files in current folder, file name format goldenGate0.jpg 

(0…) 

audio=<Audio not selected> Audio not selected 

packets=DP\Infoframes_0000.bin Packet files in folder DP\, file name format Infoframes_0000.bin 

(0…) 

porder=0:180:2:256;1:180:2,0:256; 180 frames of image index 0, Packet index 2, RGB 8 bpc 

180 frames of image index 1, Packet index 2 and 0, RGB 8 bpc 

align12=1 Pixel data is aligned to LSB 

audioswap=0 - 

audiocompressed=0 - 

audiosampling=0 - 

audiochannels=0 - 

audiobits=0 - 

scrambler=0 scrambling disabled 

colorspace=RGB444 Video color space: RGB 4:4:4 

bitspercolor=8 Video color depth: 8 (bpc) 

timing.hactive=1920 Timing: Horizontal active 

timing.vactive=1080 Timing: Vertical active 

timing.htotal=2200 Timing: Horizontal total 

timing.vtotal=1125 Timing: Vertical total 

timing.hstart=192 Timing: Horizontal start 

timing.vstart=41 Timing: Vertical start 

timing.hsync=44 Timing: Horizontal sync width 

timing.vsync=5 Timing: Vertical sync width 

timing.frate=60000 Timing: Frame rate 60 fps 

hdcp=none HDCP not enabled 

loadingRGB=52,127,150 Solid color pattern shown when content is being uploaded to the 

device before playback is R=52, G=127, B=150. 

linkRate=0  

linkRateMin= Not specified 

dscFrameRate=60 DSC Timing: Frame rate [fps] × 1000 

dscHcactive=7840 DSC Timing: Horizontal active 

dscHcblank=100 DSC Timing: Horizontal blank 

dscVtotal=2250 DSC Timing: Vertical total 

dscVsync=10 DSC Timing: Vertical sync 

dscVstart=82 DSC Timing: Vertical start 

dscVactive=2160 DSC Timing: Vertical active 
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Sample Content in Playback Tab 

Use UCD Console’s Playback examples to create custom test content. On Windows, examples can 

typically be found at C:\Program Files\Unigraf\Unigraf UCD Tools\Resources\playback\content. 

Provided examples include: 

Playlist Name Description Location 

Basic Video & Audio Example 

Example playlist for 

demonstrating the use of video 

and audio files. 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\Basic 

Frame Rate Example 

Playlist for demonstrating use 

of multiple frame rates with 

FHD and UHD resolution. 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\VRR 

Audio-Video Latency 

These scenarios can be used 

to estimate audio-video 

synchronization using external 

tools like Sync-One2 or similar. 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\AV 

Latency 

HDR & Metadata Example 

Example playlist that 

demonstrates the use of video 

files and metadata packets in 

testing a DUT monitor 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\HDR 

Golden Gate 

Grayscale 

The scenarios show smooth 

transition though shades of 

gray from black to white. 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\Grayscale 

HDR10+ SSTM Example 

Playlist demonstrates using 

HDR10+ SSTM VSIF for 

Source-Side Tone Mapping. 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\SBTM-

SSTM 

PSR1 

A set of static images 

transmitted with matching 

Dolby Vision metadata. 

C:\Program Files\Unigraf\Unigraf 

UCD Tools 

\data\playback\content\Panel 

Replay 
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Playlist: Basic Video & Audio Example 
The playlist transmits video and audio as described below. 

Video 

Frames used for Scenario 1 and Scenario 2 (Image1.jpg, Image 2.jpg) 

Frame used for Scenario 3 and Scenario 4 (Philips.svg) 

Description of Scenarios 

 Name Duration Repeated sequence 

1 
Flip-flop with LPCM 

Audio 
60 s 

CTA 1920×1080 60 Hz (VIC 16), RGB 8 BPC,  

60 frames Image1.jpg, 60 frames Image2.jpg,  

Audio: Rhythm.wav 

2 
Flip-flop with AC3 

Audio 
60 s 

CTA 1920×1080 60 Hz (VIC 16), RGB 8 BPC,  

60 frames Image1.jpg, 60 frames Image2.jpg,  

Audio: 

44100Hz_16bit_AC3_2channels_60sec_sine.iec61937.bin 

3 Flip-flop Silent 60 s 

CTA 1920×1080 60 Hz (VIC 16), RGB 8 BPC, 

60 frames Image1.jpg, 60 frames Image2.jpg,  

No Audio. 

4 
Philips 1920x1080p + 

1kHz 
60 s 

CTA 1920×1080 60 Hz (VIC 16), RGB 8 BPC, 

60 Frames Philips.svg, 

Audio: 1 kHz sine wave (1kHz.wav) 

5 
Philips 3840x2160p + 

1kHz 
60 s 

CTA 3840 x 2160 @ 60Hz (VIC 97), RGB 8 BPC 

60 Frames Philips.svg, 

Audio: 1 kHz sine wave (1kHz.wav) 
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Playlist: Frame Rate Example 
Playlist for demonstrating use of multiple frame rates with FHD and UHD resolution when using 

DisplayPort output.  

Video 

The image used for the test contains a combination of color bars, gray scales, and rotating items. The 

test uses a sequence of images creating a full rotation in 60 frames 

Executed Scenarios 

The test is using four scenarios (RGB 8 BPC, No audio) 

 Name Duration Repeated sequence 

1 Spinners FHD 59fps 60 s 
1920×1080 59.94/60 Hz video timing (VIC 16), 

60 frames ‘colorBarsSpinning-X.svg’ X= 0 to 59 

2 Spinners FHD 119fps 60 s 
1920×1080 119.88/120 Hz video timing (VIC 63),  

60 frames ‘colorBarsSpinning-X.svg’ X= 0 to 59 

3 Spinners UHD 59fps 60 s 
3840×2160 59.94/60 Hz video timing (VIC 97) 

60 frames ‘colorBarsSpinning-X.svg’ X= 0 to 59 

4 Spinners UHD 119fps 60 s 
3840×2160 119.88/120 Hz Hz video timing (VIC 120) 

60 frames ‘colorBarsSpinning-X.svg’ X= 0 to 59 
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Playlist: Audio-Video Latency 

Note: To measure video latency, ULT-01 test tool is needed. 

Description of Scenarios 

These scenarios can be used to estimate audio-video synchronization using external tools like Sync-

One2 or similar. Video latency measuring requires the Unigraf ULT-01 tool. 

The pattern with a white patch is shown for 15 frames, and then the black screen is shown for 45 

frames. The audio beep is transmitted during the first frame of a white patch pattern. 

 

Video 

Frames used for the scenario (frame1.vpattern frame0.vpattern) 

 

  

  

 Name Duration Repeated sequence 

1 vic16 60 s 

CTA 1920×1080 60 Hz (VIC 16), RGB 8 BPC,  

15 frames frame1.vpattern, 45 frame0.vpattern,  

Audio: beep.wav 

2 vic97 60 s 

CTA 3840×2160 60 Hz (VIC 97), RGB 8 BPC,  

45 frames frame1.vpattern, 15 frame0.vpattern,  

Audio: beep.wav 
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Playlist: HDR & Metadata Example 
Example demonstrates the use of metadata packets. 

Video: 

The Scenarios use four versions of the same image: GoldenGate0.jpg, GoldenGate1.jpg, 

GoldenGate2.jpg and GoldenGate3.jpg. 

All four images use the same dynamic range in pixel data but contain a text label indicating pixel 

dynamic range applied in the metadata. If DUT behaves correctly, applying different metadata 

changes the appearance of the image on DUT screen.  

Scenarios for DP Output 

Video mode in all steps: CTA 1920×1080 60 Hz (VIC 16), RGB 8 BPC, No audio. 

Name Duration Repeated sequence 

SDR 10 sec 180 frames GoldenGate0.jpg, Packet: Infoframes_0002; 

HDR 10 sec 
180 frames GoldenGate1.jpg, Packets: Infoframes_0002, 

Infoframes_0000 

HLG 10 sec 
180 frames GoldenGate2.jpg, Packets: Infoframes_0001, 

Infoframes_0002 

HDR10+ 10 sec 
180 frames GoldenGate3.jpg, Packets: Infoframes_0002, 

Infoframes_0003, Infoframes_0000 

SDR – HDR 10 sec 

180 frames GoldenGate0.jpg, Packets: Infoframes_0002; 

180 frames GoldenGate1.jpg, Packets: Infoframes_0002, 

Infoframes_0000 

SDR – HLG 10 sec 

180 frames GoldenGate0.jpg, Packet: – ; 

180 frames GoldenGate2.jpg, Packets: Packets: Infoframes_0001, 

Infoframes_0002 

SDR – HDR10+ 10 sec 

180 frames GoldenGate0.jpg, Packet: Infoframes_0002; 

180 frames GoldenGate3.jpg, Packets: Infoframes_0002, 

Infoframes_0003, Infoframes_0000 

 

  



  Appendix H: Playlists and Scenarios 

UCD-5XX User Manual • UCD Console 3.8 227 

Playlist: Grayscale 

Description of Scenarios 

The scenarios show smooth transition though shades of gray from black to white.  

 Name Duration Repeated sequence 

1 GrayFHD_60 60 s 

CTA 1920×1080 60 Hz (VIC 16), RGB 12 BPC,  

120 frames: gray0.vpattern - gray119.vpattern,  

Audio: No audio 

2 GrayUHD_119 60 s 

CTA 3840×2160 119,88 Hz, RGB 12 BPC,  

120 frames: gray0.vpattern - gray119.vpattern,   

Audio: No audio 

 

Video 

Below you can see three example frames from the video. 

Gray0.vpattern 

 

Gray60.vpattern 

 

Gray119.vpattern 
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Playlist: HDR10+ SSTM Example 
Playlist demonstrates using HDR10+ SSTM VSIF for Source-Side Tone Mapping. 

 Name Duration Repeated sequence 

1 HDR10+ SSTM 10 s 

3840×2160 30 Hz, RGB 10 BPC,  

Video: Channel0.jpg, repeated 180 times 

Packets: Infoframes_0000.bin, _0003.bin 

Audio: No audio 

2 SDR – HDR10+ SSTM 10 s 

3840×2160 30 Hz, RGB 10 BPC,  

Video:  

Step1: Channel0.jpg, repeated 150 times 

Packets: Infoframes_0000.bin, _0003.bin 

Step2: Channel1.jpg, repeated 150 times 

Packets: None 

 

Audio: No audio 

 

Video 

Channel0.jpg 

 

Channel1.jpg 
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Playlist: PSR1 
Playlist for demonstrating Panel Replay functionality.  

Video: 

The Scenarios use color_bars_0.jpg image. 

 

Scenarios 

Video mode in all steps: CTA 1920×1080 60 Hz (VIC 16), RGB 8 bpc, No audio. 

Name Duration Repeated sequence 

PSR1 Entry N 10 sec 

color_bars_0.jpg.jpg, Packets: DP/vscpacket_0000.bin on line 0; 

color_bars_0.jpg.jpg, Packets: DP/vscpacket_0001.bin on line 1; 

color_bars_0.jpg.jpg, Packets: DP/vscpacket_0003.bin on line 15; 

PSR1 Entry N p 1 10 sec color_bars_0.jpg.jpg, Packets: DP/vscpacket_0000.bin 

PSR1 Abort N p 1 10 sec color_bars_0.jpg.jpg, Packets: DP/vscpacket_0000.bin 

PSR1 Abort N p 2 10 sec color_bars_0.jpg.jpg, Packets: DP/vscpacket_0000.bin 
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